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Preface

PREFACE Welcome

Purpose of This Manual

This manual contains detailed information about how to configure and
deploy EtherNet/IP and PROFINET 1/0O-based applications using
AutoVISION, Visionscape, and Microscan smart cameras.

Manual Conventions

The following typographical conventions are used throughout this manual.
e Items emphasizing important information are bolded.

« Menu selections, menu items and entries in screen images are
indicated as: Run (triggered), Modify..., etc.

Important: Some examples in this manual may show the Vision HAWK Smart
Camera, but they are also applicable to the MicroHAWK Smart Camera.
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sraerers . ENAbling Industrial Protocols

This section describes how to enable EtherNet/IP for a Microscan smart
camera, and how to switch the camera’s protocol between EtherNet/IP and
PROFINET I/O.
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Chapter Il Enabling Industrial Protocols

Enabling Protocols

FrontRunner

Go to the File menu and select Configure Device. Go to the Industrial
Protocols tab. Select the industrial protocol you intend to use with the
camera.

TCP F'ortsl Auta Buttar  Industrial Protocals ]

[v Enable Etherhet/IP
[~ Enable Profinet 10

[ Mo lndustrial Protocol Enabled

Note: When enabling, changing, or disabling protocols, the camera must
be rebooted before the change will take effect. After clicking OK, you will
be given the option to reboot the camera now or at a later time.

If you choose No, the change will not take effect until you manually reboot
the camera.

Changes will take effect when the camera restarts; restart the camera now?

Yes Mo
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AutoVISION

Enabling Protocols

In the Connect view, and with a camera selected, click the button to the left of Details to
view camera settings. Click Modify to change camera settings. Select the desired
protocol from the Industrial Protocol dropdown menu, and then click Apply.

& VisionHawk & | VisionHawk |
) Stopped ) Stopped
License Options License Options
1 10.20.1.240 10.20.1.240
| Details | Details
Maodel Vision HAWK CSXGA Maodel Vision HAWK CSXGA
Category SmartCamera Category SmartCamera
Version 7016 Version 7016
Memory 256 MB Memory 256 MB
Flash 32 MB Flash 32 MB
IP Address 10.20.1.240 IP Address 10. 20, 1.240
MAC Address 00:0B:43:12:80:98 MAC Address 00:0B:43:12:20:98
Subnet Mask 255.235.253.0 Subnet Mask 255.255.255. 0
pAce Disabled DHCP [] DHCP Enable
Mumber of serial TCP ports 4 )
Starting serial TCP Port 49211 Numberof serial TCPports | 4 |
) Starting serial TCP Port 49211
Industrial Protocol <nones | - i
: ' ‘Industrial Protocal |
Serial Port R5232-1
Baud Rate 115200 (o
. Serial Port EtherMet/IP
Data Bits 8 Eaud Rate
Parity Mene PROFINET
Stop Bits 1 Data Bits [3 ,l
Flow Control Mene Parity [None - |
Auto Button True Stop Bits [1 'l
Send Trigger | Flow Control [None - |
2 Auto Button Enable Auto Button

Send Trigger

4 Apply |

AutoVISION and Visionscape Industrial Protocol User Manual
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Chapter

Il Enabling Industrial Protocols

You will see the Reboot Required dialog after clicking Apply.

Note: A change to Industrial Protocol requires a reboot of the camera
before the new setting can take effect.

Choose Yes and the camera will be rebooted for you. AutoVISION will be
disabled while the reboot is in process. If you choose No, the change will
not take effect until you manually reboot the camera.

Reboot Required il @

'.;g.' Smart Camera must be rebooted before this setting can take
~ effect.

Reboot Camera Now?

1-4

AutoVISION and Visionscape Industrial Protocol User Manual



N

a
]
[<B)
Z
o
Q
e
ra]
L
(@)
=
[%2)
-]

sraererz . UsINg EtherNet/IP

This section provides information necessary for using the MicroHAWK
and Vision HAWK in an EtherNet/IP environment.

Notes:

¢ The camera communications protocol must be enabled for
EtherNet/IP before it can be used in this environment. Refer to
Chapter 1, Enabling Industrial Protocols, for information about
enabling communications protocols for the camera, and information
about switching camera communications protocols.

* AutoVISION and FrontRunner jobs use Microscan Link functionality
to accommodate EtherNet/IP communications between the camera
and the PLC. For information about how to connect job parameters
and outputs to Microscan Link tags, refer to the Linking Datums to
Microscan Link Tags section of Chapter 2 in the Visionscape
FrontRunner User Manual.
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Chapter YAl Using EtherNet/IP

EtherNet/IP

Overview

The EtherNet/IP interface will be identified as Vendor Specific (100). The
interface is designed to support Class 1 Implicit I/O data exchange, and
Class 3 Explicit messages for serial commands not accessible with
Implicit messaging.

Necessary Tools

The following tools are helpful for configuring EtherNet/IP:
e AutoVISION and FrontRunner

» EtherNet/IP Messaging Tool — can be a PLC or Software Tool, must
be capable of sending explicit messages and establishing Class 1
connections. EIPScan from Pyramid Solutions is an example of such
a tool.

* Terminal emulation or serial communication tool that can connect to
serial uart and TCP socket, such as HyperTerminal or Pultty.

EtherNet/IP Terms of Use

EtherNet/IP Technology is governed by the Open DeviceNet Vendor
Association, Inc (ODVA). Any person or entity that makes and sells
products that implement EtherNet/IP Technology must agree to the Terms
of Usage Agreement issued by ODVA. See www.odva.org for details.
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Smart Camera EtherNet/IP

EtherNet/IP Object Model

Microscan smart cameras use Class 1 connected messaging to
communicate most of their data and services in a single connection.

EtherNet/IP Identity
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Device Type

Device type is 100, Vendor Specific, Machine Vision Smart Camera.
Vendor ID

Microscan’s ODVA Vendor ID is 1095.

Product Code

Vision HAWK: 6899

MicroHAWK: 6901

Interface Revision

Major.Minor = 1.1

Connection Properties: Class 1 Implicit Messaging
Input Assembly Instance (to PLC/client): 102
Output Assembly Instance (to camera): 114

Size: Fixed, 320 bytes in both directions

Input Trigger/Trigger Mode: Cyclic

RPI (Requested Packet Interval): Greater than 20 ms recommended. 10
ms to 3.2 s allowed.

Input Type/Connection Type:
e Point-to-Point (PLC OUT, O > T)
e Point-to-Point (PLC IN, T > O)

Connection Priority: Scheduled

AutoVISION and Visionscape Industrial Protocol User Manual 2-3



Chapter YAl Using EtherNet/IP

Assembly Layout

Input Assembly

The input assembly layout is described below.

Bytes Name Description

0..1 STATUS Status register of the camera, each bit of this register represents a different
state item. See Camera Status Reqgisterfor bit descriptions

2.3 ECHO This 16 bit word value reflects back to the PLC the value that the PLC wrote

tothe outputassembly ECHO register. The PLC can verify the output
assembly has been written to the camera when this value matchesthe
written value.

4.7 CmdCodeRslt  When Status.ExeCmdAck goes active in response to Control.ExeCmd,
CmdCodeRslt reflects the result of the command invoked by
Control.CmdCode. See CmdCodeRs!t for definitions.

8.11 CmdRet When Status.ExeCmdAck goes active in response to Control.ExeCmd,
CmdRet contains the data returned from the command invoked by
Control.CmdCode. See CmdRet for definitions.

12..13 reserved Reserved for future use.

14..15 State Device State register. Depending on the current state of the camera, certain
STATUS and CONTROLfeatures may or may not be operational. See State
for definitions.

16...17 VIO Each bit reflects the state of a virtual 10 point. The least significant bit
reflects vio point 145, the most significant bit vio point 160

18...19 reserved Reserved for future use.

20...27 booll-64 Each bit represents a boolvalue. The least significant bit of byte 20 reads
the value of booll. The most significant bit of byte 27 reads bool4.

28.47 int1-10 Each pair of sequential bytes represents al6 bit signed integer value. The

20 bytesrepresent10 integers. From bytes 28 & 29 for the value of intl
through bytes 46 & 67 for the value of intl10.

48...87 longl-10 Each group of 4 bytes representsa 32 bit signed integervalue. The 40 bytes
represent10 long integers. From bytes 48-51 for the value of longl through
bytes 84-87 for the value of longl0.

88..127  floatl-10 Each group of 4 bytes represents afloating point value. The 40 bytes
represent 10 floating point values. From bytes 88-91 for the value of
floatl throughbytes 124-127 for float10.

128..223 stringl These 96 bytes can store a string of up to 92, 8 bit characters, with the first
4 bytes containing the length value.
224..255 string2 Each of these 32 byte groups can store a string of up to 28, 8 bit characters,

with the first 4 bytes containing the length value.
256...287 string3
288..319 stringd
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Assembly Layout

o
>
The input assembly layout is shown here: [}
Z
Eyea Be Byte Byte Byte E
0 STATUS B4 . 128 192 258 c
: ECHO e . 130 194 258 =
4 |cmocopersit 68 132 196 260 w
longs
13 70 134 198 262 (@]
8 CMD RET 72 Mitgs 135 200 264 £
10 | e 138 202 266 0
12 reserved 76 ongt 140 204 268 .
1 STATE 78 142 206 stringl 70 e
16 VIO 80 long® 144 208 [cont) 272
— i) & | 146 210 274
20 | booll.16 &8s longlD 148 212 2176
22 | bool 86 150 214 278
8 =
5 88 floatl 152 16 280
2 0 Lo 154 218 282
2
2 - = = =
stringl
32 96 150 224 288
floats
# o8 | 162 226 290
36 100 e 164 228 292
=0 W2 R 166 230 294
.
i s fioats 168 32 29
42 ws | 170 234 238
% o (M it &
B 112 T 176 240 304
50 134 e 178 42 306
52 116 i 180 284 308
4 | ug | 181 246 310
8 long3 3= fioatd 184 248 312
58 il A 132 | 186 250 314
& 2
e longd =2 floatld e 52 316
62 126 190 254 318
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Chapter YAl Using EtherNet/IP

Status: Camera Status Register (16-bit)

Each bit of this register represents a different state of the camera’s operation. A high value
of 1 indicates that state is active (true).

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
DATA | INSP | INSP | TRIGGER | o RESEY | TRI | |
| vauD | sTAT |Busy | acx | MP |coun | ernor | "SR :5;: :::v ONHNE
ACK ACK
Inspection 1 - | All Inspections

Bit Name Description

0 ONLINE Inspections are running

1 EXP BUSY The camerais busy capturing an image. The camera should notbe
triggered orthe part under inspection moved during this time if
illuminated.

2 ACQBUSY The camerais busy acquiring an image. The camera cannot be triggered
while busy.

3 TRIGGER READY The camerais ready to be triggered. This is equivalentto ONLINE==1 and
ACQBUSY==0.

4 ERROR Anerror has occurred. Setthe RESET ERROR control bit high to clear.

5 RESET COUNTACK  This bit mirrors the RESET COUNT control bit. The PLC can be certain the
resetcommand was received by the camera when this goes high. The PLC
canthen bring the RESET COUNT control signal back low.

7 EXECMD ACK This bit mirrors the EXE CMD control bit.

8 TRIGGER ACK This bit mirrors the TRIGGER control bit.

9 INSP BUSY This bit is high when inspection1 is busy processing an image.

10 INSP STAT This bit represents the inspection 1 status result. It is 1 if the inspection
passes. Itis only valid when Datavalid goes high.

11 DATAVALID This bit goes high when inspection 1 is complete. The PLC should clear this
signal by setting RESET DV high once it has read results.

2-6 AutoVISION and Visionscape Industrial Protocol User Manual
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Assembly Layout

o
CmdCodeRslt (32-bit) E
The value of CmdCodeRsilt is only valid when ExeCmdAck is active (1), in response to E
ExeCmd being active. h
CmdCodeRsh value Meaning g
(base 16 hex) D
0x0000_ 0000 Success >
0x0100_0000 Fail.
Possible reasons:
CameraunderPCcontrol.
Job cannot be changed.
0x0200 0000 Fail: Mo Job in slot.
0x0300 0000 Fail: Unknown cmd.

CmdRet (32-bit)

The value of CmdRet is only valid when ExeCmdAck is active (1), in response to
ExeCmd being active, and CmdCodeRsilt is 0 (Success). The following table shows
which CmdCodes return data in the CmdRet register.

CmdRetvalue Associated CmdCode Meaning
(32 bit)
0 0x1000_0000 MNa

to

0x1300_0000
{Jlob Change type)
1-255 0x1800_0000 Active Job Slot #
(Query Active Job Slot)

AutoVISION and Visionscape Industrial Protocol User Manual 2-7



Chapter YAl Using EtherNet/IP

State (16-bit)

State reflects the following operational condition of the camera:

State Meaning Typical action required by the client (plc), or system operator
value
{16 bit)
0 Offline Perform job change or put camera online.
1 Online Mormal runtime operation: Monitor TriggerReady and Datavalid
signals. Trigger the camera.
2 Changing If camera is under pc control:
Vision lohb Wait until State changes to Offline or Online.

If plc is controlling the job change:
Use ExeCmd, CmdCode, ExeCmdack, and CmdCodeRslt to
complete the operation.

3 Booting™® Wait for camera to transition to Online or Offline.
4 Empty (no Load a new job from AutoVISION or Front Runner.
VisionJob)

*Booting (3) State: This will rarely be seen by the PLC.

2-8 AutoVISION and Visionscape Industrial Protocol User Manual



Assembly Layout

The value of State determines which Control and Status signals are available:

Control/Status Signal

State

Control.GO ONLINE
“.GOOFFLINE

“ .RESET ERROR

“ RESET COUNT

“ EXECMD

“ TRIGGER

“ RESET DATA VALID
Status.ONLINE

“ _ERROR

“ RESET COUNT ACK
“ . EXECMD ACK

“ EXP BUSY

“ ACQBUSY

“ TRIGGER READY

“ TRIGGERACK
“INSP BUSY

“ INSPSTAT
“.DATAVALID

1]
(Offline)
Y

-

1
(Online)

¥

< < < < =<

= < = < < < < =« =

2
(}ob Change)

3
(Booting)

i |
(Empty)

Where:

Y = Signal is valid for this State

Empty table cell = Signal is not valid for this State

AutoVISION and Visionscape Industrial Protocol User Manual
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Chapter YAl Using EtherNet/IP

VIO Register Bits

15 14 13 12 1 10 9 8 7 6 5 4 3 2 1 )
[visD i v159 i vi58 i vis7 | vi56 | viS5 | vis4 | vi1s3 ! visz i w1sl | vi1s0 | via9 | vi48 | via7 | via6 | vias

Output Assembly

The output assembly layout is described below and shown in the following diagram.

Bytes Name Description

0..1 CONTROL Control register of camera. Each bit of this registerrepresents a different
status item. See Camera Control Registerfor bit descriptions

2.3 ECHO This 16 bit value is reflected back to the PLC in the input assembly ECHO
register. The PLC can verify the output assembly has been written to the
camerawhenthe input assembly matches this written value.

1.7 CmdCode Specifies the process invoked in the camerawhen Control.ExeCmd goes
active. See CmdCode for definitions.

8...11 CmdArg Additional argument data for the CmdCode. See CmdArg for definition.

12..15 reserved Reserved for future use.

16...17 VIO Each bit reflects the state of a virtual 10 point. The least significant bit
reflects vio point 129, the most significant bit is vio point 144

18..19 Reserved Reserved for future use.

20..27 bool Each bit represents a boolvalue. The least significant bit of byte 20 writes
the value of booll01. The most significant bit of byte 27 writes booll64.

28..47 intl01-110 Each pair of sequential bytes represents al6 bit signed integervalue. The

20 bytesrepresent10 integers. From bytes 28 & 29 to write the value of
intl01 through bytes46 & 67 for the value of int110.

48...87 longl01-110 Each group of 4 bytes represents a32 bit signed integervalue. The 40 bytes
represent10long integers. From bytes48-51 for the value of longl01
through bytes 84-87 for the value of longl10.

88..127  float101-110 Each group of 4 bytes represents a floating point value. The 40 bytes
represent 10 floating point values. From bytes 88-31 for the value of
float101 through bytes 124-127 for the value of float110.

128...223  stringl0l These 96 bytes can store a string of up to 92 bytes, with the first 4 bytes
containing the length value.

224..255 stringl02 Each of these 32 byte groups can store a string of up to 28 bytes, with the

256...287  stringl03 first4 bytes containing the length value.

288..319 stringlD4
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Assembly Layout

o
=)
The output assembly layout is shown here: [}
=z
Byte Byte Byte Byte Byte [
0 CONTROL g4 fong10 128 192 256 Q
2 ECHO 65 130 19 258 E
4 CMD CODE 68 fengl06 132 196 250 L
& 70 134 198 262 o
] CMD ARG 72 1ong107 136 200 254 c
10 74 ) 138 02 266 D
1? resered 6 1ongi08 140 04 s 268 S
14 78 142 206 string 270 string103
16 Vg 80 134 208 feant) 72
Tong 109
18 resemved B2 146 210 274
20 |booll01_116 B4 . 148 212 276
- longll0
22 |booill7. 132 85 150 214 78
24 |booll3s les 82 Aeaziti 152 216 280
2% |boollag 154 ] 154 218 282
23 intl01 o2 float102 158 220 2
30 intl02 94 158 stringltl 222 286
2 intl03 95 r— 180 128 i
34 intl04 98 152 126 290
35 int105 100 floatins 164 X2 292
8 intl0é 102 | 166 30 294
4 inti0] 104 e 168 2 236
42 intl08 106 | 170 134 238
r‘ [ -nIlU‘IE-* 1.":'8 fioarl0s !I:E 136 300
i Lo 1:0 . : i f":B string102 m? string104
“ Ionglol s fIoat107 e 20 o
50 118 178 242 306
i ongll2 15 floati0s A5t ks e
54 118 182 246 310
2 long103 120 1 fiostis a5 it gk
58 122 185 250 3
50 onglod 124 T 183 252 316
62 126 190 254 318
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Chapter YAl Using EtherNet/IP

Control: Camera Control Register (16-bit)

Each bit of this register controls a function on the camera. Transitions from a low state of 0 to a
high state of 1, initiates the associate operation. The PLC should return the state of the control
bit back to 0 after it has acknowledged the camera has processed the control. Unused bits
should remain O.

15 14 13 12 11 10 9 8 7 & 5 4 3 2 1 0
e it B RESET | RESET 6o | 6o
VALID CMD COUNT| ERR _ OFFLINE | ONLINE
Inspection 1 . P All Inspections
Bit Name Description
0 GO ONLINE Startall inspections running
1 GO OFFLINE Stop all inspections
4 RESET ERROR  ResetERRORin the Status register
5 RESET COUNT Resetall inspection counts
7 EXECMD Execute the command specified by Control.CmdCode
8 TRIGGER Trigger Inspection 1. The inspection must be configured for a triggered
image acquisition.
11 RESET DATA Resetthe Data Valid signal of the Status register
VALID

CmdCode and CmdArg (32-bit)

Specifies the process invoked in the camera when Control.ExeCmd goes active.

List of available CmdCodes, and associated CmdArg:

CmdCode CmdArg Operations performed
value

0x1000_0000 Jobslot (1-255) Go Offline, Load job from specified slot

0x1100_0000 Jobslot (1-255) Go Offline, Load job from specified slot, Go Online

0x1200_0000 JobSlot (1-255) Go Offline, Load job from specified slot, Make it the boot job

0x1300_0000 JobSlot (1-255) Go Offline, Load job from specified slot, Make it the boot job, and Gao Online

Ox1800_0000 na Query active job slot. CmdRet will contain the active job slot number when the
operation is done.

2-12 AutoVISION and Visionscape Industrial Protocol User Manual



Assembly Layout

N

CmdCode and ExeCmd Operation

QOUT.Control.CmdCode,
CmdArg, ExeCmd

IN.Status ExeCmdAck

o
=
[<B)
Z
—
Q
e
Jr)
L
(@)
£
[%2)
)

.OUT.Control. GoOffline
.OUT.Control.GoOnline

.OUT.Control.ResetCount
.OUT.Control.Trigger
.OUT.Control. ResetDataValid

.IN.Status.DataValid

.IN.Status.Error

Event kay A. B. C. D. E. F
A. If DataValid or Error are present, clear them.
Set the following control signals idle, and keep them idle while the command is processed by the camera:
GoOffline, GoOnline, Trigger, ResetDataValid, ResetCount, ResetError,
If the command operation is a job change, populate the outpul tags required to configure the new job (bool, int, long, float, string).
B. Populate CmdCode and CmdArg, then activate ExeCmd.
C. Camera executes the command (may take up to a minute). While processing a Job Change command, State will be 2. Camera activates
ExeCmdAck when it is done processing the command.
D. When the PLC sees an active ExeCmdAck, verify CmdCodeRslt is 0, and Error is 0. Process CmdRet if needed, then clear ExeCmd.
E. Camera clears ExeCmdAck when ExeCmd goes inactive. When ExeCmdAck goes inactive, CmdCodeRslt and CmdRetl are no longer valid,
and it may take a few seconds for the camera State and Online signals to settle to a final value (typically Online or Offline).
F. Cameara can now be put online and triggered.

Notes:

st = PLC program scan lime

ct = Command processing time in the camera. May take up to a minute for some commands.

rpi = Requested Packet Interval. Configured in the pic's EIP module connection properties. Allowed rpiis 10 msto 3.2 s.
All signals represent the state of plc tags.

VIO Register Bits

15 14 13 12 11 10 9 8 7 & 5 4 3 2 1 0
[viaa 1vi1a3 [v1az 1 vimn [ w140 i w139 w138 1137 [ v136 (w135 | vi3a i w133 [vi3z | w131 vi30 | vizs

AutoVISION and Visionscape Industrial Protocol User Manual 2-13



Chapter YAl Using EtherNet/IP

Connection Properties: Class 3 Explicit Messaging

All Class 1 I/0O assembly data and additional data are accessible via Explicit message.
Input data (camera to PLC/Client) occupies attributes 1 to 100 of the classes. Output data
(PLC/Client to camera) occupies attributes 101 to 200.

Service:

« Get Attribute Single (OXE)

e Set Attribute Single (0x10)

Classes:

e bool = 104 (0x68)
e int= 105 (0x69)

e long =106 (Ox6A)
e float = 107 (0x6B)
e string =108 (0x6C)

» control/status (mixed data types) = 109 (0x6D)

Instance: 1

Attribute:
e 1to 100 =Into PLC/Client

e 101 to 200 = Out to Camera

2-14 AutoVISION and Visionscape Industrial Protocol User Manual
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Connection Properties: Class 3 Explicit Messaging

o
i =
Attribute Layout [}
<
When using explicit EtherNet/IP messaging, all global data objects can be read or written. g
Each data type is stored in its own class object and an instance of 1 to read the global T
data. For example, to read float2, the EtherNet/IP request would be for Service Code 14 o
(OXE), Class 107 (0x6B), Instance 1, Attribute 2. c
Class 104 Class 105 Chass 106 Clasa 107 Class 108 Class 109 8
Attre Attra Attrm Attrm Attra Atlrm
1 booli | v T 1 longl 1 floatl | 1 stringl 1 | CONTROL
2 boolz | 2 int2 2 long2 2 floatz | 2 string2 2 STATUS
3 bools | 3 int3 3 long3 3 float3 l 3 string3 3
4 bools | 4 intd 4 longs 4 figats | 4 stringd 4
5 bools | 5 ints 5 longs 5 floats | 5 strings 5
6 boois | 6 int6 & lengs 6 floats | 6 string & ECHO
7 boolT | 7 im7T T Iu;ng! 7 float? | T 5_tn|ngT 7 CMDQODE
B bools I a Int B longé B floats [ 8 stringh 8 CME_! ARG
3 bools 9 int% 9 longd 3 floats | 9 stringd 9 | CMDCODERSLT
10 boolld 10 [ipali] 1 longld 10 floatio - 10 stringl0 10 CMD RET
: = - l - 11 S'FJ!_LTE
159 | bool1%s ' 193 int1%3 199 | longids 153 | fioatlds 199 | stringl99 13‘9
200 bocl200 | 200 Int200 200 long00 200 float200 | 200 string200 200

The value received in response to Get Attribute Single depends on the type:
* Bool will return a 16-bit word with 0 for false or 1 for true

e Ints will return a 16-bit signed integer

e Longs will return a 32-bit signed integer

e Floats will return a 32-bit floating point number

e Strings will return a counted string. Total size of a string data item is 2048 bytes. This
includes a 4 byte “length” field followed by 2044 eight bit characters. When accessing
strings explicitly, they are not limited to the size in the 1/0 assemblies. For example,
string3 is limited to 28 bytes in the input assembly. If the actual string is longer than
28 bytes, it will be truncated when reading via the assembly, but not truncated when
reading the same string via an attribute explicitly.

AutoVISION and Visionscape Industrial Protocol User Manual 2-15



Chapter

YAl Using EtherNet/IP

Assembly Class 109 can be used to read and write special EtherNet/IP-specific

registers.
Attr# Name Description
1 CONTROL The control register (16 bit). See Camera Control Register for bit definitions.
2 STATUS The status register (16 bit). See Camera Status Registerfor bit definitions.
(7 ECHO The ECHO register (16 bit) (read only if implicit write is enabled)
7 CMD CODE The command code register (32 bit). See CmdCode.
8 CMD ARG The command argument register (32 bit). See CmdArg.
9 CMDCODERSLT  The command code result register (32 bit). See CmdCodeRslt.
10 CMDRET The command return value register (32 bit). See CmdRet.
11 STATE The device state register (16 bit). See State for definitions.
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EtherNet/IP Control/Status Signal Operation

N

A rpi—J L—
IN.Status TriggerReady/ | E
1AcqBusy (long exposure) |'
R 4—' Ll—

Soan_ MW _10_internal OUT.Control Trigoer [ . } =

|<—2 rpi —.H—st—-|4—2 P —DI i
IN, Status TriggerAck F f

InspBusy

(camera)

o

EtherNet/IP Control/Status Signal Operation g
o

Scan_MV_I0_user. OUT.Control. Trigger 1 | -lc—‘
LLl

sto] o

TriggerReady, AcqBusy 'I 1 | g’
(camera) o
)

—rpi —.|

IN.Status InspStatus | |

IN Status. DataValid I
I |-3.1 -I-z - —+st+—rpi _.|
QOUT.Control. ResetDataValid ) .

Eventkey: AB. CDE. F. G H. L

A On rising edge of system trigger, the user app activates Scan_MV_IO_user. OUT.Control. Trigger to trigger the demo coda.

B. Demo code detects rising edge of Scan_MV_10_user. OUT.Contral Trigger, and if the camera is ready, sends a trigger to the camera.
C. Camera acguisition begins (may be delayed by cne rpi).

D, If the camera's exposure time is shorter than the rpi, no change will be seen in TriggerReady and AcqBusy plo [N tags,

E. Camera firmware acks the trigger. The demo code may not see the ack until two rpi after the trigger was sent (event B).

F. Demo code detects TriggerAck and clears the Trigger

G. Demo code detact falling edge of TriggerAck and clears the user Trigger.

H. Camera internal signal DataValid will go high when InspBusy goes low

I. Plc legic must delay one rpi ime before re-asserting ResetDataValid

MNotes:

The chart shows the workings of the Trigger and ResetDataValid Control signals, and the TriggerAck and DataValid Status signals.

st = plc program scan time

rpi = Reguested Packet Interval, Configured in the plc's EIF module connection properties, Allowed rpiis 10 ms to 3.2 s,

- All signals represent the state of plc tags, except where noted as *[camera)”. The cam signals shown are visible in the EIP interface, but the
state of the plo tags and intemal firmware signals will be different for at least one or two requested packet intervals {rpi).

The ple is running the demo code distributed with the camera. The demo code and user app use the Scan_MY_IC_user tag set as tha
primary contral, status, and data interface for the user app. All signal operations are still true even if the plc demo code is not used,

. TriggerReady/\AcgBusy: Camera exposure times can range from less than 1 ms, up to 100 ms.

i

=]
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Chapter YAl Using EtherNet/IP

Data Type Descriptions and Equivalents in PLC and
EDS/CIP Environments

AV Description RSLogix Description EDS/EIP Description
equivalent equivalents
Bool 1 bit BOOL 1bit BOOL 1bit
WORD 16 B00Ls
LWORD 64 BO0Ls
Int 16 bit signed integer INT 16 bit signed integer INT 16 bit signedinteger
Long 32 bit signed integer DINT 32 bit signed integer DINT 32 bit signedinteger
Float 32 bit floating point REAL 32 bit floating point REAL 32 bit floating point
String 32 bit lengthfield followed  STRING 32 bit lengthfield followed  DINT+ USINT[] DINT (length) + USINT array
by & bit ASCIl characters by 8 bit ASCI| characters of characters.
LISINT =8 bit integer
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PLC Tags and Serial Command Names

2

o
. =
PLC Tags and Serial Command Names Q
5
PLC tags are separated into IN and OUT for data direction. Within the IN and OUT groups, <
the tags are sub-divided into fixed Status and Control fields, plus user-defined linked data L
fields. This table shows how PLC tag names correspond to serial commands. g
IN ouT D
PLC tag prefix | Serial cmd Tag name PLC tag prefix Serial cmd Tag name -
prefix prefix
IN.Status. eip.status. Online (1) OUT.Control. gip.control. | GoOnline’
IN.Status. eip.status. Online (0) OUT.Control. eip.control. | GoOffline ™
IN.Status. eip.status. Error OUT.Control. eip.control. | ResetError
IN.Status. eip.status. ResetCountAck | OUT.Control. eip.control. | ResetCount
IN.Status. eip.status. Triggerick OUT.Control. eip.control. | Trigger
IN.Status. eip.status. DataValid OUT.Control. eip.control. | ResetDataValid
IN.Status. eip.status. ExeCmdAck OUT.Control. eip.control. | ExeCmd
IN.Status. eip.status. TrigReady™ - - -
IN.5tatus. eip.status. AcqBusy - - -
IN.Status. eip.status. ExpBusy - - -
IN.5tatus. eip.status. InspBusy - - -
IN.Status. eip.status. InspStat - - -
IN.5tatus. eip. Echo OUT.Control. eip. Echo
IN.Status. eip. CmdCodeRslt OUT.Control eip. CmdCode
IN.5tatus eip. CmdRet OUT.Contral eip. CmdArg
IN.Status. eip. State - - -
IN.via. io. v[145-160] OUT.vio. io. v[129-144]
IN.bool. eip. bool[1-100] OUT.boaol. eip. bool[101-200]%
IN.int. eip. int[1-100] OUT.int. eip. int[101-200]"
IN.long. eip. long[1-100] OUT.long. eip. long[101-200]
IN.float. eip. float[1-100] OUT.float. eip. float[101-200]
IN.string. eip. string[1-100] OUT.string. eip. string[101-200]

"When GoOnline is changed from O to 1, Online goes to 1.

"When GoOffline is changed from 0 to 1, Online goes to 0.

" TrigReady, AcgBusy, ExpBusy, InspBusy, and InspStat are all IN-direction data only.

*booll-bool64 are mapped to PLCtags in the IN assembly. Bool101-bool164 are mapped to PLCtags in the OUT
aszembly. Bool members numbered 65-100and 165-200 are accessible via Explicit Message only.

“For int, long, float, and string data:

Data members numbered 1-10are mapped to PLC tags in the IN assembly.

Data members numbered 101-110 are mapped to PLC tags in the OUT assembly.

Data members numbered 11-100 and 111-200 are accessible via Explicit Message only.
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saerers . Allen-Bradley AOI (Add-On
Instructions) for EtherNet/IP
Operation

This section provides additional instructions helpful for using a smart
camera in an EtherNet/IP environment.

Notes:

¢ The camera communications protocol must be enabled for
EtherNet/IP before it can be used in this environment. Refer to
Chapter 1, Enabling Industrial Protocols, for information about
enabling communications protocols for the camera, and information
about switching camera communications protocols.

* AutoVISION and FrontRunner jobs use Microscan Link functionality
to accommodate EtherNet/IP communications between the camera
and the PLC. For information about how to connect job parameters
and outputs to Microscan Link tags, refer to the Linking Datums to
Microscan Link Tags section of Chapter 2 in the Visionscape
FrontRunner User Manual.

AutoVISION and Visionscape Industrial Protocol User Manual 3-1

w

—~~
= 2
O
<E'8
>
oy
5

7
Sc
0 -
[
5Q
3
<




Chapter KW Allen-Bradley AOI (Add-On Instructions) for EtherNet/IP Operation

Rockwell RSLogix 5000 AOI (Add-On Instructions) for
Microscan Devices

Important: Some examples in this section show the Vision HAWK Smart Camera, but are
also applicable to the MicroHAWK Smart Camera.

The AOI file has been created as basic instructions and as a main rung import. The AOI
instructions read and write data when called. The main rung import has global tags and
the AOI itself to demonstrate how the AOI is used for beginners with the RSLogix system.
The AOI can be used with the EDS file.

Note: Examples in this section have been created using RSLogix 5000 version 20.

Steps
e Install EDS File
e Import AOI File

« Test Communications and Review Data

Install EDS File

In RSLogix 5000, select the EDS Hardware Installation Tool under the main menu Tools.

Click the Next button. Make sure the Register an EDS Files(s) radio button is selected.

Options g
o Bl e —

(* Register an EDS filefs).
This option will add a device(s) to our database.

" Unregister a device.
This option will remove a device that has been registered by an EDS file from
our database.

The EDS Wizard allows you to.

- register EDS-based devices.

-unregister a device Lol Create an EDS file. 7
- change the graphic images associated with a device. This option creates a new EDS file that allows our software to recognize your

- create an EDS file from an unknown device R
upload EDS fil ored in a device E Lall]
This option up

= To continue click Next
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Rockwell RSLogix 5000 AQOI (Add-On Instructions) for Microscan Devices

_w

o5

Click the Browse button to locate the EDS file (C:\Microscan\Vscape\Firmware\eds\). < 8
Once the EDS file is located and selected, click the Next button. 5 )
The Vision HAWK'’s EDS file is: Vision HAWK (32-000009-01).eds ?% 17
The MicroHAWK's EDS file is: MicroHAWK (35-9000035-10).eds 53 £
= P [tocowct Auromanos s e % c5
M%D::jﬁfﬁ'ﬁh adcd to your sysem for use in Rockwel E] w}t%:gg?:ﬁm;rmrm EDS file. Thia best does net. m g ﬁ

' T

* Fegster o single fle = [ Installahon Test Resity ) ) < <
e o W] & ok oimonha (32-000005-01) eds ~

Hamed

E "Wk \EDS\MzionHAWK (3200000501} eds i Browee.

1) thern s ancon e (ico) wih h e flefa) egatenng
ey then this image wil be aesociated wih the device.

T praefiem an inatalation baat on the flefs), chck Med View fie

< Backe ey || Concel | < Back I et > |j |

Click the Next button for the image. Click the Next button for the summary.
Change Graphic Image Final Task Sumeary m

Yo can change the grache: mage thit & sssccied wih a device. This is & review of the Lask you want 1o compiete. ¥

Product Types o wandd i 1o regates the folneryg device
Change icon = —— Microscan Vision HAWK
t Meroscan Vison HAWK
«Back l Het » | <Back l Wt > || Corcd |

Click the Finish button to complete the EDS installation.

~ You have successiully completed the EDS Wizard.
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Chapter 3

Allen-Bradley AOI (Add-On Instructions) for EtherNet/IP Operation

Right-click the Ethernet node on the left pane and select New Module. Type in Microscan
in the filter box to list the device. Select the device from the newly added EDS file. Double-
click the device or select and click the Create button to add to the project.

Select Module Type

Catalog | Module Discovery | Favortes |

™ Close on Create

| [Microscan] I Clear Filters Hide Fiters &
F Module Type Category Fiters [ AT Module Type Vendor Fiters | -
O o
u] u]
ju] [m] =
u] u]
[m] Microscan Systems Inc
=] == =
Catalog Number | Description | Vendor | Category
T4 Tx2000030000 MicroHAWEK MY-40 Microscan Syste...  Unknown Device Type 100
FIS0870-hoxG QX-870 Microscan Syste... Generic Device(deprecated for new devices)
e devices)
GMV-6800- 100G Microscan Vision HAWK Microscan Syste...  Unknown Device Type 100
4 of 202 Module Types Found
Cresie Close Help |

Enter the name for your device and the IP address, then click OK.

Type: [GMY-BB00-1m00G Microscan Vision HAWE
Wendor: Microscan Systems Inc.
Parent: ENBT

General | Connection | Module Info | Intemet Protocol | Port Configuration |

HName: [ I!ie'mnmcmz ]

Dmm‘

~ Moduls Definition
Revision: 11

Electioric Keying  Compatible Module
Connections: 10320

£

Ethemet Address
© Piivate Network: 1521681 [ =)

&+ |P Address: 192 168 . 1 . 147

! |

" Host Name:

Status: Creating

Cancel | Hep |

If the camera has multiple assembly sizes, the Change button allows you to select the

other assembly formats.

3-4
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Rockwell RSLogix 5000 AQOI (Add-On Instructions) for Microscan Devices

Click the Close button on the module selection dialog to continue. Now the device has
been added to the project and will be visible in the tree view under the Ethernet node.
Controller 787 » 01X
=4 Conftroller StartProject
Q Controller Tags
(3 controller Fault Handler
(1 power-Up Handler
=55 Tasks
=-{@ MainTask
- B MainProgram
1 Unscheduled Programs [ Phases
=-£5 Motion Groups
(23 Ungrouped Axes
[ Add-On Instructions
=1-E5 Data Types
Ly, User-Defined
] C?&g Strings
(g Add-On-Defined
- L) Predefined
- Module Defined
3 Trends
=3 1fO Configuration
-3 1756 Backplane, 1756-A4
9 [0] 1756161 StartProject
=- 8 [3] 1756-ENBT/A ENBT
&5 Ethernet
& GMV-6300-1iooG VisionHawkC 142
B 17ss-ENBT/A ENBT

—~~
= 2
O
<E'8
>
oy
5

7
Sc
0 -
[
5Q
3
<
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Chapter KW Allen-Bradley AOI (Add-On Instructions) for EtherNet/IP Operation

Import AOI File

Right-click the Add-On Instructions node in the tree view in the left pane and select
Import Add-On Instruction. Locate the L5X file (C:\Microscan\Vscape\Firmware\aoi\)
and click the Import button.

T : Xl The Vision HAWK's AOI file name is:
R & =t Jerim Vision_HAWK_AOI_(32-000015-01).L5X.
Mame =~ | =] Date modfed | =] Type I
MSC210_ASSEMBLY.LSX TI013408PM  RSLog SO00 .. p 1 . . .
gQi_ﬂOl:N-LQ‘ SRDIIBUPM  RSLege MO0, »|  The MicroHAWK's AQI file name is:
ot i Yoo rammemr. &  MicroHAWK_MV_AOL.L5X.

729,

ol 1 =
Fie riame: [VisomHam_aoi 5 = et |
Files of lype: | ASoge: 5000 ML Fies 15X = Cancel |
Fiss contaning. 1] 4 On natnmtion = |
Ik [ A natnactions =l

A

The Import Configuration dialog will prompt you for information regarding the AOI file. Select
the Data Types to view the new tags and their attributes. Click OK when ready to continue.
B T

T ek mivety Ga TV
o Drdind ey data 30
=4 Tig v K e A 12
i e W i A 1

Pt s Lol Tay
.

o | e | wes |
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Rockwell RSLogix 5000 AQOI (Add-On Instructions) for Microscan Devices

Test Communications and Review Data

After the reader module has been installed, you can start with a basic ladder logic program
to test the data to and from the device. Two steps are involved to test the communication:
(1.) Download an autovision job; (2.) Add logic to the PLC ladder logic.

Start by opening up AutoVision and select the camera.
Connect A Image

=, (@ jkhawk
2 0 Stopped

License Options

10.10.5.38

~  Details

Select Load a Job.

? Load a Job

Navigate to Microscan > Vscape > Tutorials and Samples > MicroHAWK > EIP Demo
> SimpleTrigger_Job.avp.

x

| . = Microscan « Vscape - Tutorials And Samples ~ Mico Hawk ~ EIF Demo - l‘_ﬂ] I Search EIP Demo LO]

New folder = + 0 @

log MName - | Date modified | Type | Size |

top EIP demo.av) 8/4/2016 12:25 FM Visionscape Job File 590 KB
loads I || simpleTrigger_lob.avp I 8/5/2016 8:47 AM Visionscape Job File 131KE

nt Places
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Chapter KW Allen-Bradley AOI (Add-On Instructions) for EtherNet/IP Operation

This job has not tools loaded and is a simple job that allows the PLC to trigger the camera.
You can also set another Trigger action in the Trigger panel on the right side of the screen.

MICRUSLIV

Now download the job to the camera by selecting the Save Job to Camera icon and
selecting New Slot.

Fle Help 9 r B Ew

Connect Il

Fle Help | 9 ) BE

Select Yes to downloading the program to flash to the camera.
Flash a Job #

'.d.' Would you like to download the program to flash to the
= camera?

Mote: If you click 'No’ the job that is currently in the camera will be flashed to the
zelected =lot.

Mo | [ Cancel

¥ Go te Run view after flashing the job
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Rockwell RSLogix 5000 AQOI (Add-On Instructions) for Microscan Devices

w

Then add the logic to the PLC. Do this by opening the MainRoutine editor and create an
Add-On-Instructions.

—~~
= 2
O
<E'8
>
oy
5

7
Sc
0 -
[
5Q
3
<

Connection_Output

e VigionHAWKI20

e

£ VisionHAWK320 =l
e Aszszembhy_Input 7

] Azzembhy_Output 7

e Connection_Input 7

e 7

e

e

Right-click in the first element and create a New Tag.

x|
Mame: IVH_”
Dezcription: Carcel |
Help |
Llzage: |<n|:urmal>
T ppe: I Baze - I Lonnecton...

Aliaz For: |

Diata Type: I\-"iSiDnH.-'-‘-.WKBEEI

uuuli_u\_uu o

Scope: IE& M airFProgram
Ewtermal -
- IHeadMnte
Style: I

[ Constart

™| Dpen Configuration
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Chapter 3

Allen-Bradley AOI (Add-On Instructions) for EtherNet/IP Operation

Right-click the second element and create a new tag for the Assembly_Input. It will
default to the AOI INPUT320 data type. Right-click the third element and create a new tag
for the Assembly_Output. It will default to the AOI OUTPUT320 data type.

WewTag

Merne |Rrac['-ala

H
Usage:  [in 2
Type: Base - :
Bz Fou | =]
DataType  [INFUTEO _I
Soop ] R MarProgran E‘
m iRm-‘#lig :J
St [ 2
™ Constant
-

rf][MewTag =]
Create | | | Mame [WiteData M
Cancel Descepinn Cancel
_He | EhE|

|D"JTF'LIT32|:I

| R M arFrogran

[Readtwiee

i
v
I;lﬂuL_tLI;I; Lo

Double-click the fourth element and click the down arrow in the combo box to link the
Connection_Input to the reader input data. The link should be the [reader name]:l.Data.

ﬂ =-VHCamera:l

ﬂ I—VHCamera:l.ConnectionFaulted

_0447:GMV_6800_1
BOOL

8 [ VHCamera:lData

SINT[320]

ﬂ +]-VHCamera:0

_0447-:GMV_6800_1

Note: Do not connect to the ConnectionFault item.

Double-click the fifth element and click the down arrow in the combo box to link the
Connection_Output to the reader output data. The link should be the [reader

name]:O.Data.

ﬂ —=]-VHCamera:l

ﬂ L VHCamera:l.ConnectionFaulted

_0447:GMV_6800_1
BOOL

A  [&-VHCamera:lData

SINT[320]

ﬂ [+]-VHCamera:0

_0447-GMV_6800_1

3-10
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Rockwell RSLogix 5000 AQOI (Add-On Instructions) for Microscan Devices

=2

oxe

Add a new rung by right clicking and selecting Add Rung. >3
o2

TH

Cut Rung Cirl+X Cc

Copy Rung Cirl+C g 5

2 Paste Ctrl+ %g

<

Import Rungs...

Create an Examine On trigger tag.

H b | 1 | AR |4 |40 | 40| 40| ons | osr | osF |
t |\ _Favorites A Adg| Examine On Bit ,{_Tmerﬂ:nunter A _Input
> E: e

};5-;.' S E R ml

Py

m m ™ M

(End)
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Chapter KW Allen-Bradley AOI (Add-On Instructions) for EtherNet/IP Operation

Right-click and create a Boolean Trigger.

NewTag x|
Name: ]Trlgger Create |w
Description: Cancel I

‘ Help
Usage: | <nomal
Type: 'BGS@—E

Alias For: |

Data Type: IBOUL

Iﬂl;l<_|'_b_\_l'_l‘_ 1o

Scope: I—*MairPrngram
Extemal -
TR IFIeadMnte
Style: [Decimal

I~ Constant

I” | Open Corfiguration

Add an Output Energized Tag to the end of the rung.

Trigger ? |
1€ O
d 0L L

Assign the Output Energized tag to the WriteData. CONTROL.8 bit

Trigger

JE
1L
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Rockwell RSLogix 5000 AQOI (Add-On Instructions) for Microscan Devices

_w

o5

Now download the program to the PLC. Once the program has downloaded, set the PLC <>E\8
to Run Mode. o2
T B

Rem Run 7. = RunMode Sc
B Q-

No Forces Go Offiine 5Q
2

<

No Edits

- — Program Mode
2 ] == Control
[
:; g Cor
& =1 Cor Test Mode
— [ Pow
=4 Tasks
=& Mai
=243 Controller Properties
?h MainRoutine

Note: Be sure the path to the PLC has been set in the project so that communications to
the PLC can be established.

Path [AB_ETHIP-1\10.20.1.2¢7 =[]
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Chapter KW Allen-Bradley AOI (Add-On Instructions) for EtherNet/IP Operation

Toggle the bit Trigger by right-clicking and selecting Toggle Bit or by pressing Ctrl + T.

| Trigger

Force O
Go To... Cirl+G
Instruction Help F1

This action will set the Trigger tag high causing the trigger output bit to go high in the
Output Assembly. The camera will trigger on each rising edge (ie when the Trigger tag is
set to 1). This will confirm that communication is established between the PLC and the

camera.

3-14
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snaerera Allen-Bradley PLC Setup
via EDS for EtherNet/IP
Operation

This section describes how to use an EDS file to set up an Allen-Bradley
PLC for EtherNet/IP operation.

Notes:

e The camera communications protocol must be enabled for
EtherNet/IP before it can be used in this environment. Refer to
Chapter 1, Enabling Industrial Protocols, for information about
enabling communications protocols for the MicroHAWK and Vision
HAWK, and information about switching MicroHAWK and Vision
HAWK communications protocols.

¢ AutoVISION and FrontRunner jobs use Microscan Link functionality
to accommodate EtherNet/IP communications between the camera
and the PLC. For information about how to connect job parameters
and outputs to Microscan Link tags, refer to the Linking Datums to
Microscan Link Tags section of Chapter 2 in the Visionscape
FrontRunner User Manual.
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Chapter /8 Allen-Bradley PLC Setup via EDS

AB Rockwell RSLogix 5000 v20 PLC Integration with EDS

Important: Some examples in this section show the Vision HAWK Smart Camera, but are
also applicable to the MicroHAWK Smart Camera.

This section was created and run on the following Allen Bradley/Rockwell components:
e RSLogix 5000 Version 20.00.00 (CPR 9 SR 5)

e 756-L61 ControlLogix5561 Controller, firmware rev 20.11

« 1756-ENBT/A EtherNet/IP interface card, firmware rev 4.1

Run the Rockwell EDS Hardware Installation Tool.

Rockwell Software
= FactoryTalk Administration Console
BOOTP-DHCP Server
FactoryTalk Activation
FactoryTalk Tools
RSLinx
4 RSLinx Classic Backup Restore Uti
%t R5Linx Classic Launch Control Pan
%' RSLinx Classic Online Reference
R RSLinx Classic
Tools
& EDS Hardware Installation Toy
& ©PC Test Client
=T OPCTest Document
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AB Rockwell RSLogix 5000 v20 PLC Integration with EDS

Select Add.

9
n
C;o
S
5.8
c >
S
o
p=
Co
20
<

Launch e EDS Wirard and add selected hardwans descrption Ses and
assocsied components anly.

Lounch the EDS Wizard and remove selecied hardware description fles

and associakid cComponents onky

Ramove all prevdoushy mstalled hardwane descniption iles and
assocsled components from your compuber

Select Browse.

Registrabion
Electronic Data Sheet fle(s) will be added to your system for use n Rockwell Automaton
apphcatons

& Regesier a ginghe e
= Ragesier a gwaciory of EDS s

pamed

* Ethere s an scon Ble | ico) with the same name as the Be(s) you are regrsienng then thes
mage wil be associated with the device

To perharm an installabon test on the fle(s). chek MNexd

| hes>
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Chapter /8 Allen-Bradley PLC Setup via EDS

Navigate to the VisionHAWK EDS file, then Open it. The default install location is:
For Vision HAWK: C:\Microscan\Vscape\Firmware\eds\visionhawk
For MicroHAWK: C:\Microscan\Vscape\Firmware\eds\MicroHAWK MV40

x|
<_)v| . = Vscape - Firmware = eds ~ visionhawk v & I Search visionhawk ﬂ
Organize v  Mew folder = - M@

. Installinfo ;I Name *

| Date modified | Type

. Vscape
610_3
610_5
610_10
610_13
Assembly
DM
Document:
Drivers
Firmware

eds

. visionk

gsd
Jobs

_Tumria\s ALI 4|

. VisionHAW 0009-01).eds &/ 3 5:56P EDS File

| o

File name: |VisionHAWK (32-000009-01).eds ¥ | [EDS Files (".eds] |

Open | v| Cancel |

Keep clicking Next until the Finish button is displayed.

Rockwell Automation's EDS Wizard

Registration
Electronic Data Shest file(s) will be added to your system for use in Rockwell
Automation applications.

{* Register a single file
" Register a directory of EDS files
Mamed:

™| Look in subfolders

-anWscape\ Fimware eds wisionhawlk \Vision HAWE (32-000003-01).eds Browse... |

* I there is an icon file {ico) with the same name as the file(s) you are registering
then this image will be associated with the device.

To perform an installation test on the file(s), click Next

< Back Mext = Cancel

4-4
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Click Finish.

I Rockwell Automation's EDS Wizard

You have successfully completed the EDS Wizard

3
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g
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<

Open RSLogix 5000 v20 and create the 1/0 Configuration for the base system, including

BEE & B oo - AaG
Offline B, F RUN T Path
MoForces ). :OK

No Edits a - 5;7 ) 4 )
Redundanc %9 o <+ \Fa
Controller Organizer ~ 0 X

£
[# Controller Tags
[ Controller Fault Handler
[ Power-Up Handler
=3 Tasks
=@ MainTask
| % £3 MainProgram
3 Unscheduled Programs / Phases
=43 Motion Groups
3 Ungrouped Axes
&3 Add-On Instructions
€3 Data Types
[ User-Defined
4Gk Strings
Gt Add-On-Defined
4O Predefined
| G Module-Defined
3 Trends
3 I/O Configuration
=& 1756 Backplane, 1756-A4
89 [0] 1756-L61 Logix3561
=B [3] 1756-ENBT/A eip
#5 Ethernet

AutoVISION and Visionscape Industrial Protocol User Manual 4-5



Chapter /8 Allen-Bradley PLC Setup via EDS

Right-click Ethernet and select New Module.

=& IfO Configuration
&3 1756 Backplane, 1756-A4
B [0] 1756-L61 Logix5561
8 [3) 1756-ENBT/A eip
&
[ﬂ MNew Module...

{E-Jl‘il:'f'.l';{".' Modules...

The Select Module Type dialog will be displayed.

Select Module Type B

Catalog |Modu|e Discovery | Favorites

|Enter Search Text for Moduke Type... Clear Filters
Commumca:ﬂ;:u\e Type Category Filters = AHEH?B,&GI:’I;du\e Type Vendor Filters
Controller Endress+Hauser

Digital Metiler-Toledo
DPlto EtherNet/IP

Catalog Number Description Vendor Category
0005_007B_0030 SP600 Reliance Ele... DPlto EtherNet/IP
0005_007B_0038 SP600 ER 400V Reliance Ele..  DPlto EtherNet/IP
0005_007B_0039 SP600 ER 200V Reliance Ele..  DPIto EtherNet/IP
0005_007B_003A SP600 ER 600V Reliance Ele..  DPIto EtherNet/IP
0005_007B_0060 Liquiflo 2.0 Reliance Ele... DPlto EtherMNet/IP
0005_007F_0027 MDE0 Reliance Ele..  MDIto EtherNet/IP
0005_007F_0028 MDE5 Reliance Ele..  MDlto EtherNet/IP
1305-ACDrive-EN1 AC Drive via 1203-EN1 Allen-Bradley  Drive
1336E-IMPACTDriv... AC Drive via 1203-EN1 Allen-Bradley  Drive
1336F-PLUSIIDrive-.. AC Drive via 1203-EN1 Allen-Bradley  Drive
1336R-REGENBrak... Brake via 1203-EN1 Allen-Bradley  Drive
13368-PLUSDrivel... 007-600 HP Code AC Drive via 1203-EN1 Allen-Bradley  Drive
13365-PLUSDriveS.. F05-F100 HP Code AC Drive via 1203-EN1 Allen-Bradley  Drive

200 of 200 Module Types Found Add to Favorites

Close on Create eate Help
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Clear the Module Type Vendor Filters.

Catalog | Module Discovery | Favorites|

Select Module Typ:

Enter Search Text for Moduke Type...

Hide Filters ES

Module Type Category Filters
o
Communication
Controller
Digital
DPlto EtherNetIP

Clear Filters
Module Type Vendor Filters

B Allen-Bradley
["] Endress+Hauser
D Mettler-Toledo

«  Catalog Number Description

Vendor Category

0 of 200 Module Types Found

Add to Favorites

Close on Create

e
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Scroll down the Module Type Vendor Filters until Microscan comes into view, then select

Microscan.

Catalog | Module Discovery | Favorites |

Enter Search Text for Module Type...

HideFilters

‘ Module Type Category Filters
Communication

Controller

Digital

DPIto EtherNet/IP

& Module Type Vendor Filters
Metiler-Toledo

Microscan Systems Inc.

["] Parker Hannifin Corporation

- |[[] Real Time Automation

v Catalog Number
GMV-6800-100G

Description
Vision HAWK

Vendor
Microscan S

Category
Unknown Device Type 100

1 of 200 Medule Types Found

Add to Favorites

Close on Create

Select Module Typ

AutoVISION and Visionscape Industrial Protocol User Manual
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Click the required camera and click Create.

| Select Module |

| Catalog | Modube Dscovery | Favortes

Ennter Search Tex for Moduke Type. | Grons Fiters | HideFiters &
e Modue Type Category Fillers - Mosule Type Vender Filters -
| B ormmumicason 5| ™ ppomerTolodo
| ¥ Canmalier ¥ Micrasean Systems Inc =
| [¥ migital Parkes Hanaifin Carparatian
| ¥ 0P1 Etheieye i Real Time Autsmation o

log Number  Descnphon Vendar Calngary

GMV-GE00- ToaG Vigion FANWK Microscan 5. Unknown Davice Type 100

1 of 200 Module Types Found [ AddtoFaventes |

) Close an Creste Create | | Ciose | [ Hep |

The New Module dialog is displayed. Type a unique name for this camera and its IP address.
B

General* |Connectinn| Modulalnfol Internet Plotncoll Part Configulationl

Tppe: GMY-BE00-1xx4G Microscan Yision HAWE,
“Wendor icroscan Systems Inc.
Parent: ENBT
MName: Scan_My Ethemet Address
Blesaiilias = " Private Metwork: 1921681, I_E
i+ |P Address 192 0188 . 1 .00

" Host Mame: I

i~ Module Definition
Revision: 11
Electronic Keying:  Compatible Module
Connections: 10320
Change |
Statug: Creating aK Cancel Help
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Click OK, verify the camera was added to the Ethernet network, then open the controller
tags to verify that :1 and :O tag sets were created.

Lolts il = * % Scope: MiLogixssel ~ Show AlTegs
+-1= Controller Logix5561
=3 Tasks
- MainTask
8 MainProgram
[# Program Tags
Eh MainRoutine
=1 Unscheduled Programs / Phases
#-53 Motion Groups
53 Add-On Instructions
3 Data Types
# User-Defined
-4k Strings
G Add-On-Defined
+-L4 Predefined
-t Module-Defined
= Trends
= /O Configuration
&3 1756 Backplane, 1756-A4
i [0] 1756-L61 Logix5561
3-8 [3] 1756-ENBT/A eip
=& Ethernet
9 1756-ENBT/A eip
® GMV-6800-1:00¢G Scan_MV

Mame e |
+ Scan_lMV:l |
+ Scan_MV:0

3
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Open the Main Routine.

Controller Organizer R ] @3 . w| s

£ Controller Logix3561
== Tasks
=@ MainTask
-1 MainProgram
3 Program Tags {End)
E MainRoutine -
Unscheduled Programs / Phases
+-5 Motion Groups
&1 Add-On Instructions
=3 Data Types
“® User-Defined
#1598 Strings
(i Add-On-Defined
-0 Predefined
#-L4 Module-Defined
3 Trends
-3 /O Configuration
—-83 1756 Backplane, 1756-A4
fa (0] 1756-L51 Logix5561
8 [3] 1756-ENBT/A eip
—|-#5 Ethernet
8 1756-ENBT/A eip
* GMV-6800-LooG Scan_MV
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Right-click rung 0, and select Import Rungs.

(End)

& CutRung

B CopyRung

i Paste

Delete Rung

Add Rung

Edit Rung

Edit Rung Comment

Ctri+X
Ctri+C

Ctrl+V

Del
Ctri+R
Enter
Ctri+D

Import Rungs... ﬂ
Export Rungs...

Vision HAWK: Navigate to the Vision HAWK 32-000003-2.L5X file and select Import. The
default install directory is C:\Microscan\Vscape\Tutorials and Samples\Vision
Hawk\EIP Demo.

MicroHAWK: Navigate to the MicroHAWK MV_Example.L5X file and select Import. The
default install directory is: C:\Microscan\Vscape\Tutorials and
Samples\MicroHAWK\EIP Demo.

Leckjn

iz
Recent Places

Desktop

-
Libraries

A

Computer
MNetwork

i

Filaz

Name

[ B B o b

Date modified

] 32- 3000000 VisionHAWK.LSX

4/25/2012 55 PM

=
File pame. 32eoee e VisicnHAWK
Files ol type:

Files corteining = Ry

Inig; Kitmmie

Overwite Seleced Rungs

- Import..

Cancel

4-10
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The Import Configuration dialog will be displayed.

Find
Find Within: Final Mame

Import Content:
SN MainRoutine (Rungs)]
43 A Tags
- ) Data Types
[3) Other Components
& ErmorsfWarmings

- 85

Find/Replace...

Configure Rung Properties

Imported
Rungs:
Operation:

42
:C{eate v after Rung 0

i) References will be imported as

configured inthe References folders

Routine Properties

Mame MainRoutineg
Description: T
Type Bl Ladder Diagram

In Program: 5% MainProgram

Select Tags.

[E Import Configuration

z| :;| Find; |

Find Wwithir: Final M ame

j EI%' Findf"FHepIace...l

|mport Content;
% bdainT ask
Eﬂ b4 ainProgram
_T_j Eij M ainR outine [Rungs)
LB References
g™ : Tags
s Data Types
by B Other Components

@ Errorz/ W armings

Configure Tag References

Import Mame Operation _T_] Final Mame o

it E Camera:l Undefined |1 |Cameral

v E Camera:0 Undsfined |1 |Camera:0
Scan_kY_Cm... |Create I |Sean_ Y _Cradar..
Scan_MW_Crm... [Create  [Scan My _CmdCo...
Scan_t¥_Cm... [Create | Scan_bY_CmdCa...
Scan_kY_Cm... |Create I |Sean_ Y _CrdR...
Scan_MV_can... [Create  |Scan MY _const_...
Scan_tV_con... [Create | Scan_ by _const_..
Scan_MV_can... [Create  |Scan MY _const_...
Scan_tY_con... [Create | Sean_ by _const_..
Scan_MY_con... [Create | Sean MY _const_..

AutoVISION and Visionscape Industrial Protocol User Manual
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Chapter /8 Allen-Bradley PLC Setup via EDS

In the Final Name column, click Camera:l, then click the down arrow that appears on the right.

O import Configuration x|
& !’,l Finck I j ﬁhldgl Find/Replace... |
Find */ithir: Final Name
Import Content:
% MainT ask Configure Tag References
y a %?Ir;‘l‘:‘ro_gr;m tine (R ) Import Mame Operation _l_] Final Hame &I"ff‘l Alias For |Data Type IDescnption =
I ainAoutine (Rungs; = :
3 ©- &5 Foferences 9 A cameal Undefined | |Soan_Mv:l j| | | |
Tags g E Camera0 Undefined | IY j ShDV\‘iIAIITags -
_l_J Data Types Scan_MY_Cm... |Create B
v Other Components Scan_ MY _Cm... |Create L] | LEE =zl | Data Type =]
- ErrarsAw armings Scan MY _Cm... |Create 0 ﬂ [#]-Scan_Mv:l _D447:V5- 0630
Sean MY Cm. | Credls 0 ﬂ [F-Scan_MV:0 _D447:3- 062020
== Mame: Scan_MV:I
poarcMieor Y Create L Data Type: _0447:V5- 06302 V'S 06_2FSCEFED:I:0
Scan_MY_con... |Create L Description:
Scan MY _con... |Create L]
Scan_MVY_con... |Create Ll
Scan_MY_con... |Create B
Scan_MY_con... |Create L] -
Scan_MY_con... |Create L] Controller
Scan_MY_con... |Create B
Tl' Program

Double-click the camera name input tag assigned earlier.

I . j Shiow: I.-'l‘-.ll Tags j
| Mame ==| | Data Type -
ﬂ [H-Scan_MVl _ 0447 V5-06-%-xx
ﬂ [-Scan_Wv:0 D447 VE-06-2-0
Mame: Scan_My:I
Data Type: _0947:W5-06-x-xx W5-06_2F9CEFED:I:0
Description:
b
I Controller
I Program
4-12 AutoVISION and Visionscape Industrial Protocol User Manual
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A4

Find Withir: Final Marne

Impart Content:
@ MainT ask,
@ td ainProgram
i3 Exj MainR outine [Rungs)
25 References
Tags

Data Types
Qther Components
- Errors/\W arnings

J U)
In the Final Name column, click Camera:O, then click the down arrow that appears on the right.  [Raa
>
x| (] -
J 2z | TS
J @ ﬂi. Find/Replace... E >
Q.
@ 3
IConfigure Tag References % Q
Import Mame Operation _‘J Final Mame & f]“ Aliaz For Data Type | Description ] —_— U)
! E Cameral Use Existing | 3| Scan_MY:l || <
5 Camera 0 Undsfined | |Scan_My:0 j
Scan_MY_Cm.. | Create B ;
LMY _ . | Show |l Tags -
Scan_MY_Cm.. |Create L] I J I J
Scan_MY_Cm... |Create B | SR = | Data Type 1=
Sean MY Cm. | Create B ﬂ [F-Scan_Mv:| _0447:VS- 0533
Scan_MVY_con... |Create L [l S OIT NS08 ot
MName: Scan_MV:0
B UBL; Ao Create B Data Type: _0447:V/5-08-x-xx V'S-06_AGEESFC3:0:0
Scan_MVY_con... |Create L] Description:
Scan_MY_con... |Create B
Scan_MY_con... |Create Ll
Scan_MY_con... |Create L] _
Scan_MY_con... |Create B -
_l_ Scan_MY_con. . |Create L] Cantraller
4

Program

Double-click the camera name output tag assigned earlier.

|~.r,

x| Show fan Tags

[

| MName

==| | Data Type

[FH]-Scan_kw

_ 0447 5-06 200

A [F-Scan_MV:0

0447 VE-D6 0

Y

AutoVISION and Visionscape Industrial Protocol User Manual
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Click the Other Components icon in the tree view to select the Component References.
Select the camera in the Final Name column. Click OK to complete the import.

[N Import Configuration

x|
L8| Find I vI B(& | Find/Replace... |
Find \Withir: Final Marme
Impart Cantent:
48 MainTask Configure Component References
x 'Ea MainProgram |Impo|l Name |Dperalion Final Name alCIass Mame |
=] b Exj MainRoutine [Rungs) - -
@ Referencas ¥ | Camera ‘Llndefmed [5can_hiy] j|Mndula |
.:J ags 1/0 Conliguration
_:J f Data Twpes 3 1756 Backplane, 1756-44
. ther Components ﬁl [0] T756-LET StartProject
8 Enorsw/armings - [311756-ENBT /A ENBT
= f}s Ethemet
LI
ok I Cancel Help
Module 'Camera’ is not defined in impart file or in project. Y
Click OK and the Main Routine and User-Defined tags will be populated.
i I
- it
ﬂ!l_.l Q iﬂ'.ﬂ ol 3 a6l 5 nE s |
e e e
e .
[ 1 5 o Hlel] i
3 ofs[TTwwmp aston (T L TeeTe ) et 1 Tewes ] Towatien [ Veovloper [ oo [ Tk 1 Tonow 7, TamtPoms 7, Frges Toww f Toorms

b Bl | sl S ale 4 ]
i #
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©)
=0
Delete any empty rungs (check rung 0). D>-\Q
b 2 L(g
O -
| S2
! o
& Cut Rung Ctrl+X @ 2
Co
@ Copy Rung Ctri+C b 20
=gl : code <
and
Delete Rung Del 4
& = & = ] - s -

Download the project to the PLC.

Offline 1. B RUN
Mo Forces Go Online
Mo Edits Upload..

funda Download l
Controller Organi : = 1} |

Note: Be sure the path to the PLC has been set in the project so that communications to
the PLC can be established.

Path [AB_ETHIP-1110.20.1.247 |

Put the PLC in Run Mode.

Rem FRun M ® Fun Mode
Mo Forces Go Offline
Mo Edits

=] || Controller Organi
3 = Controller |

[A cControll Eun Mode
1 Controll Test Made ﬁ

ey

Program Mode I
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Open the Program Tags window and select Monitor Tags.

& Program Tags - MainProgram

Scope: IE&MainF‘mgram j S ko i.ﬁ.IITags

M ame =] ) T A2
[F-5Scan_MY_const_State_JobChange z
[+-Scan_MY_const_StateOffine a
[F-5can_ MY _const_State Online 1
[+-Scan_tY_demo_blob }
[F-Szan_MY_demo_decode 1
[F-5Scan_ MY _demo_lnspStat 1
[+-Scan_MY_demo_meazure 1
[F-5can_MY_demo_mode 1
[F-Scan_ MY _dv_em_count [oual
}
I
]
il
u]
]
I
}

[+-Scan_MY_dv_Fall_count [eun
[F-Scan MY dv rize_count I...
Scan_tY_ExeCmd_fall
Scan_MY_Exelmd_rize

Scan_mtY_ExeCrnddck_fall

Scan_mY_ExeCmdbck_rize
[F-5Scan_ MY 10_internal I...
[+-Scan_kY_|10_user [eun
[F-Scan_MY_matchoode '"LAREL CHECK"
[F-5Scan_MY_ons_internal -2080374528
[+-Scan_MY_status_erm_count [.-.
[F-Scan_MY_trigger_count ...
[F-Scan_ MY _trigger_delay_timer [ou
[+-Scan_MY_trigger_er_count [.-.
[F-Scan MY uzer_events

4[]\ Monitor Tags A Edit Tags / N

[EE (PSSP (P P
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AN

Expand Scan_MV_10_user so that the Echo in the .IN.Status and .OUT.Control
structures is visible.
Hame -z|o | Value €
—Scan_ by _|0_uzer|M.Statuz reserved] B ]
[F-Scan_ MY 10 userIM.Status.Echo ]
[F-Scan_MY_10_user M. Status. CrndCodeR=lt 16#0000_0000
[F-Scan_tY_I0_uzerIM.Status. CrndP et
[F-Scan_MY_10_user M. Status. reservedds_103
[F-Scan_MY_10_user M. Status.reserved] 04_111
[F-Szan_MY_I0_user M. Skatus. State
[F-Scan_MY_10_user M. Status reserved! 20_127 1]
[H-Szan MY 10 _userINVIO f
[+-Scan_MY_10_uzer. N boal {
[F-5 can MY_I0_uzer IM.int i
[+-Scan_MY_10_user. M. long f
[+-Scan_MY_10_user. [N float {...1}
& i

{

i

0
a
L
8
>
Q.
=)
o
QO
wn

O
1
o
>
Q
o)
G
S
o
c
2
<

|l e T e e

H-Scan_MY_I0_user. [N shing
Scan_Y_I0_vser OUIT

I_i_|-5 can_MY_[0_user OUT. Cantral
—Scan_MY_10_uzer. QUT.Control GoOrline ]
—Scan_MY_I0_uzer. OUT .Contral. GaOffline
—Scan_MY_|10_uzer. OUT.Control. reserved2
—Scan_kMy_I10_uzer OUT Contral rezerved3
—Scan_MV_|0_user.OUT.Control ResetE ror
—Scan_kv_I10_uzer. OUT Contral ResetCount
—Scan_ My 10_uzer. OUT .Contral. resereds
—Scan_ My _|10_uzer. OUT.Control ExeCrind
—Scan_Mv_|0_uzer. OUT.Contral. Trigger
—Scan_MY_|10_uzer. OUT.Control. reservedd
—Scan_MY_I0_uzer OUT Contral rezerved? 0
—Scan_MY_|0_uzer.OUT.Control ResetD ata alid
—Scan_Mv_10_uzer OUT Contral rezerved] 2
—Scan MY _10_uzer. OUT Contral reserved] 3
—Scan_MY_10_uzer. QUT.Contral. rezervedl 4
—Scan_MY_10_uzer. OUT .Contral.reservedl 5
H-Szan_ MY _I0_user OUT . Contral Echa
H-Scan_ty_I0_uszer.0UT.Control. CmdCode 1640000_0000
[F-Scan_MY_10_user.OUT.Contral. Cradég ]

=

[l e T e . e e e e . e R R e . e

(|

(m|
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Change .OUT.Control.Echo to non-zero.

—Scan_MWY_I0_uzer. OUT Control reserved]5 a
[F-5ean_ MY 10_user. OUT.Contral. Echo - 4321
[+-Scan_MY_10_user OUT.Contral. CrdCode 1640000 0000

Verify that Scan_MV_IO_user.I0.IN.Status.Echo is the same value as the
.OUT.Control.Echo.

—Scan_MY_10_user M Status reserved] 5 0
[F-Scan_tY_|10_uszerIM.Statuz. Echa 4321
[F-Scan_tY_|0_user.IN.Statuz. CrmdCodeR sk 1640000 0000

This confirms that the PLC and camera have successful two-way communication.

The demo code expects a demo vision job to be loaded on the camera, which populates
the following input tags (camera to PLC) with vision tool results:

* .IN.bool.bool1, bool2, and bool3
¢ .IN.long.longl

* .IN.float.floatl

e .IN.string.string1l

The demo code will operate the Control and Status signals of the camera regardless of
the vision job that is loaded. For a more detailed overview of the demo code and vision
job, see Allen-Bradley PLC Setup via Generic Ethernet Module for EtherNet/IP
Operation.

To send a trigger to the camera, scroll to Scan_MV_IO_user.Control.Trigger.

—Scan_MY_[0_uzer OUT.Control ExeCrnd ]
—Scan_ MY _I0_uzer. OUT.Control. Trigger
—Scan_MY_|0_uzer OUT.Control.reservedd
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p

Set the Trigger to 1. This causes the demo code to trigger the camera, process the new e

inspection data, record the results in the Scan_MV_demo_xxxx tags, and clear the 3'—“

DataValid status signal. 5.8

c >

The Trigger control changes to 0 when the camera is triggered. All processing is done C? %

when the counter Scan_MV_dv_fall_count increments, along with the pass/fail counters % ©

in the Scan_MV_demo_xxxx tags. =0

M ame =z|a | Walue + <

[=I-Scan_MY_demao_blob {ounl
[FH-5can_MY_demo_blob pass_count e
[F-5ean_MY_demo_blab. fail_count !
[F-5Scan_MY_demo_blob.fail_count. PRE a
[F-Scan_ MY demo blob.fail_countACC 30
—Scan_ MY _demo_blob.fail_count. CLI ]
—Scan_MY_demo_blob.fail_count. CD ]
—Scan_MY_demo_blob.fail_count. DR 1
—Scan_MY_demo_blob Fail_caount 0% ]
—Scan_MY_demo_blob.fail_count. M ]
—Scan_ MY _demo_blob. bool ]
[H-5ean_MY dermo_blob. lang g
[+-Szan_tY_dema_blob.long_max g
[F-Szan_MY_demao_blob. lang_ir 4
—Scan_MY_demo_blob. float .0
—5Scan_bY_demo_blob. float_rmin 0
—Scan_bY_demo_blob. float_max 0
[+-Scan_YY_dema_blob. sting e
[F-Szan_MY_demo_decode {aund
[F-5Scan_ MY _dema_lnspStat !
[+-Scan_MY_demao_measure i —
[F-5can_ MY demo_mode 1
[+-Scan_tY_dv_er_count {ou.}
[=-5Scan_MY_dv_fall_count e
[F-5ean_MY_dv_fall_count PRE 0
+-Scan_My_dv_fall_countACC = 5]
—Scan_d4Y_dv_fall_count.CLI ]
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snaerers Allen-Bradley PLC Setup via
Generic Ethernet Module for
EtherNet/IP Operation

This section describes how to use the Generic Ethernet Module to set up
an Allen-Bradley PLC for EtherNet/IP operation.

Notes:

e The camera communications protocol must be enabled for
EtherNet/IP before it can be used in this environment. Refer to
Chapter 1, Enabling Industrial Protocols, for information about
enabling communications protocols for the camera, and information
about switching camera communications protocols.

* AutoVISION and FrontRunner jobs use Microscan Link functionality
to accommodate EtherNet/IP communications between the camera
and the PLC. For information about how to connect job parameters
and outputs to Microscan Link tags, refer to the Linking Datums to
Microscan Link Tags section of Chapter 2 in the Visionscape
FrontRunner User Manual.
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Chapter Sl Allen-Bradley PLC Setup via Generic Ethernet Module

Integrating the Camera into a PLC Environment

Important: The examples in this section show the Vision HAWK Smart Camera, but are
also applicable to the MicroHAWK Smart Camera.

This section assumes you are using an Allen Bradley PLC with Rockwell RSLogix 5000 v16
or newer. RSLogix v19 and v20 may look slightly different than the screen shots shown, but
the integration process is similar.

Create the I/O Configuration for the base system, including the system’s Ethernet interface.

5 RSLogix 5000 - Controllogix5561 in Logix5561_MV.ACD [1756-L61]

File Edit Wiew Search Logic Communications Tools ‘Window Help

@‘@|u| él “ | ‘ | user_events = ﬁ‘&l%‘ ,E ‘@7| ‘ |
Offline 0. I RUN [ ] Fath [AB_ETHIP-1\10.10.5.243\Backplans) =] &
Mo Farces 5 ’[ Ok 4}
Mo Edits 2‘ ] ﬁ”;‘r ﬂ 4| 4|_| ﬂ
i R ¢ X X % X X A £
» 3
== intm\ler ControlLogixsse1 # | Controller Tags - Controllogix5561 (controller)
2 [# contraller Tags
ki (23 Controller Fault Handler Scope: | fi ControlLoginGs6 ~ M Shaow Al
e [T:a's::we"up Handler | |[Name o[ ale | Fo* [ Sule [Dat
= @ MainTask.

= C& MainProgram
Program Tags
MainRoutine
[Z3 Unscheduled Programs | Phases
=I5 Motion Groups
(23 Ungrouped Axes
[ Add-on Instructions
= 5 Daka Types
L User-Defined
) L Strings
L Add-On-Defined
i+ L Predefined
£ Module-Defined
[ Trends
=51 110 Configuration
= 1756 Backplane, 1756-Ad
ﬁl [0] 1756-L61 CantrolLagix5561
= ] [3] 1756-ENBT}A sip
£x Ethernet

Add the camera by right-clicking the Ethernet interface and selecting New Module.

=5 1} Configuration
- 1756 Backplane, 1756-44
ﬂ{l [0] 1756-L61 Controllogixss61
- 8] [3]1756-ENET/4 eip

i Ethermer

EJ Mew Module, .,
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Integrating the Camera into a PLC Environment

5

Oo
a2
Select ETHERNET-MODULE — Generic Ethernet Module, and click OK. aoes
; 200
M Select Module E| = 0=
c.C8
T [y q)
kadule Dezcription om > c
1794-AENTIA 1794 104100 Mbps Ethernet Adapter, Twisted-Pair Media A 1 O B
1794-AENT/B 1794 104100 Mbps Ethernet Adapter, Twisted-Pair Media % E c
2364F RiglJ-EM1 2364F Regen Bus Supply via 1203-EM1 - QO m

<"

Drivelogixs730 Ethernat... 10/100 Mbps Ethernat Port on DrivelogixS730
Generic Ethertet/IP CIP Bridge

EtherMet/IP SoftLogixSs00 Ethertet/ TP

PowerFlex 4-E PowerFlex 4 Drive via 22-COMM-E

PaowerFlex 40-E PowerFlex 40 Drive via 22-COMM-E

PowerFlex 40P-E PowerFlex 40P Drive via 22-COMM-E

PaowerFlex 70 EC-E PowerFlex 70 EC Drive via 20-COMM-E

PowerFlex 70-E PowerFlex 70 Drive via 20-COMM-E ™
[«] | +

Find.. | fdd Favolite|

By Category Eyendor Favarites
0K | Cancel | Help |
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Chapter Sl Allen-Bradley PLC Setup via Generic Ethernet Module

Configure the following fields:

Name: A useful name to rememberfor the camera. The example here is Scan_MV.
IP Address: The IP Address of the camera

Comm Format: “Data — DINT”

Input, Assembly Instance: 102

Input, Size: 80

Output, Assembly Instance: 114

Output, Size: 80

Configuration, Assembly Instance: 1

Configuration, Size: 0 (none)

Click OK when done.

Example:
x
Type: ETHERMET-MODIILE Generic Ethernet Module
Wendor: Allen-Bradley
Parent: EMET
NlEmTEs — Connection Parameters
ame: Scan_ MY
Azsembly ;
Dezcription: ;I Instance: Size:
Inpu: 102 30 = 32
P T [0 = (azbi
C F E|Data- DINT = Z .
o e I &4 J Configuration: I'l IEI j [E-bit]
Address / Host Mame
% |P address: I . : . Status |hput: I I
~ Host Narne: I Shatus Dutput:l
¥ | Open todule Propertiss oK | Cancel | Help
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Integrating the Camera into a PLC Environment
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Configure the Required Packet Interval (RPI) and click OK.

10 ms is the minimum allowed by the camera. 20 ms or higher is recommended.

B Module Properties: eip (ETHERNET-MODULE 1.1)

General  Connection” ] Module Info]

(ONS)
a4c2
183
200
5(.')2
©.© =
L'SQ)
m C
|Q_B
c

SE5
<ntd

Bequested Packet Interval [RPI): 2D.DE|: mz  [1.0-3200.0 ms)
™ Irhibit Module

™ Major Fault Orn Contraller I Connection Fails \while in Bun Mode

todule Fault

Status: Offline oK | Cancel Apply Help

Open the Main Routine.

-5 Controller ContralLogixS561
i Controller Tags

23 Contraoller Faulk Handler

[T power-Up Handler
—1-455] Tasks

- % MainTask

- Dﬂ; MainProgram

K_" Pragram Tags

E:lj MainR.outine
[T Unscheduled Pru:ugre| Open
=15 Motion Groups
[T Ungrouped Axes j’.'; Cuk Chrl+
[£3 add-on Instructions Copy Chl+C

=5 Data Twpes
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Chapter 5

Right-click the top rung and select Import Rung.

]
& CutRung Chrl-+3
Copy Rung ChrlHiZ
End) | @ paste Chel+y
Delete Rung Dl
Add Rung ChelHHR
Edit Rung Enter
Edit Rung Comment Chel+D
| Impott Fung... |
Export Rung...

Navigate to the 32-000003-2.L5X file and click Import.

Allen-Bradley PLC Setup via Generic Ethernet Module

. Import Rungs x|
Lookin: [ . EIF Demo [ s e
Flecen.t Places l I
32-000003-2.L5%
iy
Computer
A
-
Network
File name: |32-000003-2.L5x | impot.._ |
File of type: | RSLogix 5000 XML Files " L5X) =] Cancel |
Files containing: ||—| Furgs j Help |
Intax IEij b ginF outing [t ainProgram) j
[~ Ovenwrite Selected Rungs
v
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Integrating the Camera into a PLC Environment

At the Import Configuration window, find the Module Name that was assigned to the

Generic Module. Here the module name is Camera.

L|g| Fne | ~| B8] FindReplace. |
Find Withir: Final Name:
[mpart Content:
TS Mook
—:J """ %ﬂg‘glﬁ;ﬂ:rﬂnutine (Rungs) Impart Mame I:Ipera.tiu:un _:'_J Final Mame [
-2 Beferences ut E' Carmera:l Urdefined | | Cameral
v i Tags s El Carnera: 0 Urdsfined | J | Camera:0
_:J Data Types Scan_MY_Crn.. |[Create  |Sean_tMy_Crdér...
v Other Components Scan_k_Cm.. |Create  |Scan_My_CrdCo...
(8 Eworsrwarings Scan_ MY _Cm... |Create  |Scan_My_CrmdCo...
Scan_kW_Cm.. [Create  |Scan_ty_CrmdR...
Scan_ MY _can.. [Create 1 |Scan MY _const_..
Scan_bY_con... [Create 1 |Scan_My_const_...
Scan_MY_can... [Create | Scan_MY_const_...
Scan_MY_con... [Create  |Scan_My_const_...
Scan_MY_con... [Create | Scan_MY_const_...

Click Camera:l and click the down arrow, then double-click the Scan_MV:I that appears

below it.

|

8 impor compguration
,:| Y| Find: | =l ﬁﬂ|93| Find/Replace...
Find *ithin: Final Mame
Import Content:
@ b ainT azk [Configure Tag Refeiences
by Emg--églﬁ:ifl:::uline (Rungs) Impart Mame Operation || Final Name Alff‘l Aliaz Far IData Type IDescription =
i 729 Beferences ] E Camera:| Undefined | |Sean Myl j| | |
' Tags ¥ |8 CamerD Undefined |1 IY' j ShOWZIAIITags j
by} Data Types Scan_MV¥_Cm... |Create L]
\d Dther Componerts Scan_MV_Cm... | Create » [Hame == [Data Type =
-[& Erorsfwamings Soan_MY_Cm.. | Create 0 f] G -Scan_Mvil _ 0447 VWS- 06500
Gean MY Cm.. |Croate 0 ﬂ [H-Scan_WMV:0 _D44T:VS- 0823
= = Mame: Scan_MV:I
Sean MV_con... | Create B Data Type: _0447:V5-06-3-3x WS-06_2FSCEFED:1:0
Scan_MV_con... |Create L] Description:
Scan_MV_con... Create L]
Scan_MV_con... Create L]
Scan MY _con.. | Create L]
Scan_MVY_con... |Create L] -
Scan_MV_con... Create L] I Contioller
Scan MY _con... | Create L]
TI' I Pragram
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Chapter 5

Allen-Bradley PLC Setup via Generic Ethernet Module

Click Camera:O and click the down-arrow, then double-click the Scan_MV:O that appears

below it.
zl
,’zl 5| Find | -] & 9&| Find/Replace... |
Find *ithir: Final Name
Import Content:
@ b ainT ask Configure Tag Heferences
9 @ E;u:fro_gr;m tine (R ) Import Marme: Operation ‘:_J Final Mame [ ﬁ} Alias For Data Type | Description 1=
4 ainRoutine [Rungs - :
. T3 Refererces . E Camera:| Use Existing | || Scan_ MV =
Tags v 8| Cameran Undefined | [Scan w0 =]
@ Data Types Scan_MY_Cm... |Create B I T j Shaw: IA" Tags j
Ad Other Componernts Scan_MY_Crn... |Create B
-- Errorz AW arnings Soan MV _Cm.. |Create 0 |Name ::||Data Type - |
Soan MY Crm. | Croate 0 ﬂ [F-Scan_lv:l _0447:VS-06-x-xx
Scan_MY_con... | Create ] [l SN 00
Mame: Scan_MV:O
B (oot L Data Type: _047:VS-06-X3x VS-06_ABGESFC3:0:0
Secan_MV_con... |Create B Description:
Scan MY _con... | Create L]
Scan_MV_can... |Create L]
Scan_MV_con... |Create L]
Scan_MV_con... | Create L] -
_I_ Scan_MV_con... |Create L] I Controler
4
I Program

Click the Other Components icon in the tree view. Click OK.

Delete any empty rungs (rung 0 may be empty).

Cuk Rung Chrl+3
Copy Rung ZhrlC
Delete Rung Del

Add Fung Chrl+R,

The tags and main program are now configured sufficiently to test communication with the

camera.
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Integrating the Camera into a PLC Environment

Select the control button next to Offline and then select Download.

RSLogix 5000 - StartProject [1756-L61 20.11]* - [MainProgram - MainRoutine™]

B Fle Edit View Search Logic Communications Tools Window Help

B|=S|HE| & &|8[@] | [voveespaayscan v n -] B8 |G [ M &)

Offline 0. I RUN

Mo Forces _go Online

Mo Edits Upload. ..

FHedundatey | Download |

[—]B Motion
L2 Ung

2-£5 pata T Controller Properties

a

l_q}? Fath iﬁB_ETHIPJ \192.168.2.111\Backplane\0" v

A B mofees| 4r]4t]<r]wr] ]

<| )[\ Favorites 4 Add-On A Alarms A Bit A& Timer/Counter

E’Eﬂ User-Defined
----- | Scan_MV_demo_record
----- | Scan_MV_EIP_IN
----- | Scan_Mv_EIP_IN_bool
----- | Scan_MV_EIP_IN_float
----- | Scan_MV_EIP_IN_int
----- | Scan_MV_EIP_IN_long
----- f| Scan_Mv_EIP_IN_Status
----- | Scan_MV_EIP_IN_string
----- B scan_Mv_ETP_IN_VIO
-89 Sean_MV_EIP_IO
~[¥) Scan_Mv_ETP_oUT
Scan_MV_EIP_OUT _bool
Scan_MV_EIP_OUT_Control
Scan_MV_EIP_OUT_float
----- Sean_MV_EIP_OUT int
----- [ Scan_MV_ETP_OUT long
----- B Scan_MV_EIP_OUT _string
----- B Scan_Mv_EIP_OUT_VIO
B3, Strings
----- B Scan_Mv_str2044
----- B Scan_MV_str28
----- B Scan_Mv_stroz
----- ) STRING
Cﬂ, Add-On-Defined
- Predefined

Pty

i ;

BEEY] ) ool 2o o o

one shot demo init
Scan_MV_ons_internal.31
0 =/ [
1

Scan

Note: Be sure the path to the PLC has been set in the project so that communications to

the PLC can be established.

Path: [4B_ETHIP-1110.20.1.247

~| &
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Chapter 5

Allen-Bradley PLC Setup via Generic Ethernet Module

Once the program has downloaded, make sure the PLC is in Run Mode.
R5Logix 5000 - Controllogix5561

Rem Run
Mo Forces
Mo Editz

=15 Contralles

Program Mode

C3 Conk

C3 Powe
-5 Tasks

Test Mode

|ﬁ File Edit “iew Search Logic Communications  Tools

al=dl & @
i | ! Fun Mode
Gn Offline

| user_everts
I_Q_l

F

To open the Program Tags, double-click Program Tags, then select the Monitor Tags tab

at the bottom of the tag window.

Controller Organizer -0 X

B+ Tasks
=48 MainTask
i E--a MainProgram

-- Program Tags

E MainRoutine
--(2 Unscheduled Programs / Phases
Motion Groups
--(2 Ungrouped Axes
Add-On Instructions
- Data Types
=-E5 User-Defined
can_My_demo_record
Sean_MV_EIP_IN
can_Mv_EIP_IN_bool
can_MV_EIP_IN_fioat
can_MV_EIP_IN_int
can_Mv_EIP_IN_long
can_Mv_EIP_IN_Status
can_Mv_EIP_IN_string
can_MV_EIP_IN_VIO

can_Mv_EIP_OUT_baol
can_Mv_EIP_OUT_Control
can_Mv_EIP_OUT_float
can_Mv_EIP_OUT _int
can_MV_EIP_OUT _long
can_Mv_EIP_OUT _string
can_MV_EIP_OUT_VIO

- Eﬂ Add-On-Defined
- Predefined
-7 Module-Defined
-3 Trends

-5 110 Confinuration

Scope: IaMamProglam j Show IA\ITags

=+

Marne =3l | Value € | Farce Mask €| Shle

[+-5can_MY_CmdRet_last -1 Decimal
Scan_MY_const_CmdCode_Getbctivelb 402653184 Decimal
Scan_Mv_const_CmdCode_JbChg 268435456 Decimal
Scan_MV_const_CmdCode_JbCha_MkBE 301989688 Decimal
Scan_Mv_const_CmdCode_JbChg_MKBE_Online 318767104 Decimal
Scan_MY_const CmdCode_JbChg_Orline 285212672 Decimal
Scan_MV_const_CmdCodeRlst_Fai_MNo_Jab 33554432 Decimal
Scan_MY_const_CmdCodeRlst_Fail LIl 16777216 Decimal
Scan_Mv_const_CmdCodeRlst_Fail_Unk_Crod 50331648 Decimal
Scan_MY_const_CmdCodeRlst_Success 1] Decimal
Scan_MY_const_State_Boating 3 Decimal
Scan_MV_const_State_Empty 4 Decimal
Scan_MY_const_State_Eror 255 Decimal
Scan_MV_const_State_JobChange 2 Decimal
Scan_MY_const_State_Offline 1] Decimal
Scan_My_const_State_Online 1 Decimal
Scan_MV_dema_blob [anel) {uuel}
Scan_MY_demo_decode [oooll fooch
Scan_MV_demo_lnspStat f---1 flocch
Scan_MV_demo_measure [...} {...}

S can_MY_demo_mods 1 Decimal
Soan_MY_dv_er_count {-..1 {on}
Scan_My_dw_fal_count [...} {...}

[+ Scan_MY_dv_rise_count [---1 {---1
Scan_My_ExeCmd_fal 1] Decimal
Scan_My_ExeCmd_rize 1] Decimal
Scan_My_ExeCrddck_Fall a Decimal
Scan_My_ExeCmdAck_rise 1] Decimal

[+-Scan_MV_ID_intemal f---1 floccd

[#-Sean_MY_I0_user [ {uunl
LGran MU matchoad 111BET rHECE o

4 [ |\, Monitor Tags 4 EdtTags J K

5-10
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Integrating the Camera into a PLC Environment

ol

Expand Scan_MV_IO_user so that the .IN.Status and .OUT.Control structures are
visible. Then scroll the window so Scan_MV_10_user.OUT.Control.Echo is visible.

MHame —2|& | Walue €
—Scan by |10_usger|M.Statuz rezerved] b 0
[+-Scan MY 10 user.MN.Status.Echo ]
[+-Sczan_MY_10_uzer M. Status. CradCodeR =l 16#0000_0000
[F-Scan_My_10_user M. Statuz. CrndPet
[H-Szan_MY_10_user M. Status. reservedds_103
[+-Scan_MY_10_user | Status. reserved104_111
[F-Szan_MY_I0_user /M. Statuz. State
[+-Scan_MY_10_uzer IN.Status. reserved 20_127
[H-Szan MY 10 user.IN.WIO
[+-Scan_My_10_uzer.IM.boal

[F-5 can_MyY_I0_user |M.int
[F-5zan_My_10_user.IM.long

&

&

Q
=)
°
o
=
+—
o
c
S
[}
°
+—
LLl

(ONS)
s
ag
>0
%(D
©.©
S

>
ia
29
<"

H-Scan_td_|0_user.IM.float
H-Scan_MY_|10_user.[M.sting
[=-Scan_MY_10_userOUT

|_I:_|-S can_ MY _[0_wzer.OUT.Control

—Scan MY _10_uger. QUT.Control GoOnline
—Scan MY 10 _user. OUT.Contral. GaOfline
—Scan by |10_uger. OUT.Control. resenved2
—Scan_ My _|0_uszer. OUT.Contral. reserved3
—Scan MY 10_user. OUT.Control ResetErmar
—Scan_ky_|0_uszer. OUT.Control. ResetCount
—Scan My 10_usger. OUT.Control. reserveds
—Scan_ kY _|0_uszer T Contral ExeCmd
—5Scan MY I0_user. OUT.Control Trigger

—Scan by 10_uger. OUT.Control. rezervedd
—Scan MY 10 _user. OUT.Contral. reserved10
—Scan MY 10_uger. OUT.Control ResetD ata alid
—Scan_ MY _10_user. OUT.Contral. reserved] 2
—Scan MY _|0_uger. QUT.Control reserved] 3
—Scan_ MY _|0_uszer OUT Contral reserved] 4
—Scan MY _10_user. QUT.Control reserved]s

el el el el el el el ]
= . = = = = . =
= . = = = = . =
- -

[ T e T e T e T T T e T T T i T T T e TR e T e T e T R R R i i S e T Y S i T Y e T s |

[+-5can_MY_10_uzer. OUT.Caontral Echo
[+-Scan MY [0 user.OUT. Control. CrdCode 164#0000_0000
[+-Szan_MY_10_uzer. OUT.Caontral Cradéng ]

AutoVISION and Visionscape Industrial Protocol User Manual 5-11



Chapter Sl Allen-Bradley PLC Setup via Generic Ethernet Module

Change .OUT.Control.Echo to non-zero.

M ame =] ) T *
[F-Scan_ MY _10_user M. Status. reserved104_ 111
[+]-Scan_MY_10_user.IM.Statuz. State
[F-5can_ MY 10 _uzerN.Status reservedl 20127

[F-Scan_MY_10_user N0 | -
[FH-Secan_ MY _I0_user M bool I...
[F-Sean_ MY 10_userIM.int I
[F-Scan_MY_10_user.IM.lang |
[FH-Sean MY 10 _user M. float I
[F-Scan_MY_10_user.IM.zsting | -
[=-Sean_MY_I0_uzer.OUT I...

EI-S can_MY_10_user DUT. Control |
—Scan_MY_I0_uzer OUT .Contral. Golnline
—Scan_ MY _[0_uzer. OUT.Control. GoQffline
—Scan_MY_I0_uzer. OUT.Control rezerved?
—Scan_MY_[0_uzer OUT .Control.reserved3
—Scan_MY_I0_user OUT . Control. ReszetE mar
—Scan_MY_I0_uzer. OUT .Control. ResetCount
—Scan_MY_[0_uzer OUT.Control.reserveds
—Scan_ MY _I0_user. OUT.Control. ExeCrnd
—Scan_ MY _[0_uzer OUT . Control. Trigger
—Scan_MY_I0_uzer. OUT.Control rezervedd
—Scan_MY_I0_uzer OUT .Contral.rezervedl 0
—Scan_MY_[0_uzer. OUT.Control. R ezetD atal/alid
—Scan_MY_I0_uger OUT .Control rezerved] 2
—Scan MY _[0_uzer OUT .Control.reserved] 3
—Scan_MY_I0_uzer OUT .Control rezerved] 4
—Scan_MY_I0_uzer OUT .Contral rezervedl] &

L T . . e v . I . T I e s R e R = R = B e et e e e e e e O e e |

[F-5can_ MY 10_uzer.OUT.Contral. Echa j[
[+]-Szan_MY_I0_user. OUT.Contral. CrndCode 1640000 0000
[F-5can_ MY 10 _uzer. OUT. Contral Cradérg ]

[z R 0 iegr CIT Cepmbrol reegrugd9E 127 N
4 [ |\ Monitor Tags A Edit Tags f
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Integrating the Camera into a PLC Environment

Scroll the window so Scan_MV_IO_user.IO.IN.Status.Echo is visible, and verify that it is
the same value as .OUT.Control.Echo.

+*

M amne —2| & | Walue
Scan_MY_EweCmdbck_rize

Lo
Le3
200
5 =
©c20
225
C

o5
< LIJ

@)
=
Q
c
Q
o
3
>
o
=)
o
[<B)
)]

[F-Scan_MY_10_intemal -
[=Sean_MY_I0_user S
E-S can_ky_I0_uszer M [un.
EI-S car_ bW _10_user (M. Status f---

—Scan_Y_|0_uzerM.Statuz. Dnline
—Scan_MY_I10_uger|M. Status E=pBusy
—Scan_Y_|0_uzerIM.StatuzdcgBusy
—Scan_MY_10_uzer M. Statuz. TriggerReady
—Secan_MY_10_userM.Status Error
—Scan_MY_|0_uzerM.Statuz BezetCountdck
—Scan_ MY _10_user M. Status reserseds
—Scan_MY [0 _uzer M. Status ExeCmdick
—Scan_ MY _I0_uszer M. Status. Trigoerdck
—Secan_MY_I10_user M. Status InzpBusy
—Scan_MY_I0_user M. Status |nspStat
—Scan_ MY _I0_uger M. Statug.Datafalid
—Scan_Y_|0_uzer M. Status.rezerved] 2
—Scan_ MY _I0_uzerlM Statuz rezerved] 3
—Scan_MY_|0_uzer M. Status.rezerved] 4
—Scan_MY_I0_uszer M Statuz reservedl s

L - e T e e . I I e e e B e R = R S =R =R S e e =

[+-Scan_MY_10_uszerIM.Statuz. Echo j[ 3 ]
[FH-Scan MY 10 _user|M Status. CrdCodeR it 16400000000
[F-Scan_MY_10_uszer|M.5tatus. CmdR et a
[FH-Scan_MY_I0_user|M Status reservedds_103 a
[F-Sean_ MY 10 _userlM.Status reserved104_111 ]
[F-Scan_MY_10_uszer|M.Statusz. State 1
[F-Scan MY 10 _user|M.Status reserved120 127 ]
[F-Scan_MY_10_user. M40 [eual
[FH-Sean_ MY 10_uzer M. bool [...1

[F-Cram bl 1T icar K] mb L 1
4 [ v |\ monitor Tags £ Edit Tags

This confirms that the PLC and camera have successful two-way communication.
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Chapter Sl Allen-Bradley PLC Setup via Generic Ethernet Module

To send a trigger to the camera, scroll to Scan_MV_IO_user.Control.Trigger.

ET =] ) €
[F-Scan MY 10 _uzerM.int
[+]-Scan_kY_10_user.IM.long
[F-Szan_MY_10_user. M foat

[F-Scan_ MY 10 _userIM. sting
[=I-Scan_MY_10_userOUT

E-S can_MY_I0_uzer. OUT. Control
—Scan_bY_I0_uzer. OUT . Control. GoOnline
—Scan_MY_I0_uzer OUT .Cantral. GoOFfline
—Scan_ bV _[0_uzer.OUT . Control. reserveds2
—Scan_bY_I0_uzer. OUT . Control reserved3
—Scan_MY_|0_uzer. OUT.Control. RezetE mor
—Szan_bY_I0_uzer. OUT . Control. B esetCount
—Scan_bY_I0_uger. OUT . Control rezerveds
—Scan_ bMWY 10 _uzer. OUT .Control ExeCrmd
—Scan_bY_I0_uszer. OUT . Control. Trigger
—Scan_MY_I0_uzer. OUT .Control rezervedd

[ I i e e e - s T e . e I R B L e e
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Set the Trigger to 1. This causes the demo code to trigger the camera, process the new
inspection data, record the results in the Scan_MV_demo_xxxx tags, and clear the
DataValid status signal. The Trigger control changes to 0 when the camera is triggered.
The Scan_MV_dv_fall_count and pass/fail counters in the Scan_MV_demo_xxxx tags
increment when all processing is done. For example:

MHame =] ) T €
[=-5can_tY_demo_blob {...1
E-S can_ My _demo_blob.pass count f---1
[+-5can_MY_demo_blob.pass_count PRE
[+-Sezan_MY_demo_blob.pass_count ACC -
—Scan_ MY _demo blob.pasz count.CU
—Scan_MY_demo_blob.pass_count.CD
—5can_MY_demo_blob.pasz count. DM
—Scan_MY_demo_blob.pasz_count. 04
—Scan_MY_demo_blob.pass count. UM
[+-5can_MY_demao_blob. fail_count
—Scan_ MY demo_blob. bool
[+-5can_MY_demao_blob.long
[+-Scan_ MY dema_blob.long mas

Lo
Le3
200
5 =
©c20
225
C

o5
< LIJ

@)
=
Q
c
Q
o
3
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[+-Szan_MY_dermao_blob. lang_min
—Scan_ My dema_blab. float
—Scan_ MY _demo_blob.float_min
—Scan_MY_demo_blab float_max
[+-5zan_MY_demao_blob. string
[+-Scan_MY_demo_decode f---1
[H-5can_MY_demo_lnspStat {o.a}
[+H-5can_tY_demo_measure f---1
[H-5can_MY_demo_mode 1
[H-Scan_MY_dv_ern_count {...1
[=-Scan MY dv fall_count oo
[+-5can_MY_dv_fall_count.PRE 1]
[+-Scan_ MY dv fall countACC
—Scan_ MY _dv_fall_count.CLI
—Scan MY _dv_fall_count.CD
—Scan_ MY _dv_fall_count.DM
—Scan_ MY _dv_fall_count. 0%

—Scan_ MY _dv_fall_count. UM

[H]-Cram bl A rica_coulb I
4 [ # [ Monitor Tags A Edit Tags

[ e e |

B =T - T e " OO = O = I e T e T e e T e T )

i = =T I T = T )
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Chapter Sl Allen-Bradley PLC Setup via Generic Ethernet Module

Parameterize the Camera

Open the Scan_MV_I0O_user.OUT.long, float, and string tags and verify that they are
configured as shown below.

Mame -zl [Value €| € Swle | DataTyp
[=l-Scan_My_I0_user {..-1[ Scan_...
-Scan_M\-"_ID_user.IN {---1[ Scan_...
E-Scan_M\f_ID_user.DUT {---1( Scan_..
[#-Scan_MY_I0_user. OUT.Control {-.-1I Scan ..
[H-Scan_ MY_I0_user. OUT VIO {...H[ Scar_...
[H-Scan MY_10_uzer OUT baol {---H[ Sear_...
[H-Scan_MY_I0_user. OUT int {...H[ Scar_...
[=-Sean_ MY_I0_uzer, OUT.long | P I Scan_...
[+-Sean_tW_I0_uzer OUT long longl 01 4| |Decimal |DINT
[+H-Scan_tY_I0_user.OUT longlongl 02 4| |Decimal [DINT
[+-Sean_MW_I0_uzer OUT long long103 0| |Decimal |DINT
[#H-Scan_tdy_I0_user.OUT longlongl04 0| |Decimal [DINT
[#-Scan_ty_I0_uger.OUT longlongl 05 0| |Decimal |DINT
[+H-Scan_tdy_I0_uzer.OUT longlongl 06 0| |Decimal [DINT
[FH-Sean_MY_10_uzer OUT long longl 07 0| |Decimal DINT
[+-Scan_tdy_I0_uzer.OUT longlongl 08 0| |Decimal [DINT
[H-Scan_ty_I0_uzer.OUT longlong109 0| |Decimal [DINT
[+-Sean_tW_I0_uzer OUT longlongl 10 0| |Decimal |DINT
[=-Sean_MY_I0_user. OUT Aoat | P I Scan_..
—Scan_Mv_I0_uszer OUT float float] 0l 100.0| |Float REAL
—Scan_Y_I0_user OUT float float102 200.0| [Float REAL
—Scan_My_10_uzer OUT float floatl 03 0.0/ |Float REAL
—Scan_tY_I0_uzer OUT float float104 0.0/ |Float REAL
—Scan_Mv_I0_uzer.OUT float float]l 05 0.0/ |Float REAL
—Scan_tYv_10_uszer OUT float floati 06 0.0/ |Float REAL
—Scan_Mv_I0_uzer.OUT float floatl07 0.0/ |Float REAL
—Scan_bY_10_uszer. OUT float float108 0.0| |Float REAL
—Scan_Mv_I0_user OUT float float109 0.0/ |Float REAL
—Scan_v_|I0_uzer.OUT float.floatl 10 0.0/ |Float REAL
[=-5can_MyY_I0_user. OUT shing | ) Scan_..
[H-Scan_tY_10_uzer OUT sting.sting1 01 "LABEL CHECK'|[ Scar_...
[#H-Scan_ty_I0_uzer. OUT sting. sting102 v Scan_..
[H-Scan_ty_I0_uzer.OUT. sting.sting103 v Scan_...
[#-Scan_by_I0_uzer.OUT sting. sting 04 T Scan_..
[#-Scan_MY_matchcode '"LREEL CHECK' [ Scan_...
[+-5zan_MY_ons_internal -2080374528 | |Decimal |DINT
[#-5can_MY_status_erm_count | P I COUM...

This configures the Measure (float101 and float102), Decode (string101) and Count
Blob (long101 and long102) tools in the same way they were configured in AutoVISION
during Try Out.

Note the Description column. It offers a hint for what each linked tag does in the vision job.
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Integrating the Camera into a PLC Environment

Trigger the Camera

To send a trigger to the camera, scroll to Scan_MV_IO_user.Control.Trigger.

M ame cz| | Yalue 3
[=-Scan MY 10_uzer [...1
[F-Scan_MY_10_userIM [...}
[=-Szan_MY_10_userOUT ooel)
El-Sl:an_h*l"-.J'_IEI_user.ElLlT.El:nntr-:ul eaa!

—Scan_bY_I0_uger OUT.Control. GoOnline 0
—Scan_MY_I0_uzer OUT.Control. GolQffline
—Scan_bY_I0_uzer. OUT.Control resermved?
—Scan_bY_I0_uger. OUT.Control rezermved3
—Scan_ MY _|0_uzer OUT.Control ReszetEmor
—Scan_bY_I0_uzer. OUT.Control B esetCount
—Scan_MY_I0_uszer OUT .Cantrol rezemeds
—Scan_bMY_[0_uzer. OUT.Control. ExeCmd
—Scan_bY_I0_uzer. OUT . Control. Trigger
—Scan_MWY_I0_uzer. OUT .Control. reservedd
—Scan_bY_I0_uszer OUT .Control reserved] 0
—Scan_bY_I0_uger. OUT.Control. B esetD atab alid
—Scan_bY 10 _uzer OUT .Control reserved] 2

L T o e (o T e e v e Y -

Set the Trigger to 1. When the Trigger returns to a value of O, the camera may be re-triggered.

If you connect to the camera with AutoVISION, it will display a new inspection result each
time the camera is triggered. Recall that the vision job was created with predefined
images to produce predictable Passed and Failed results. The camera’s illumination
lights will not flash when triggered.

The inspection results can be seen in the PLCs’s IN tags, as well as in AutoVISION. Open
the RSLogix tag window so Scan_MV_10_user.IN.Status and bool are visible.
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Chapter Sl Allen-Bradley PLC Setup via Generic Ethernet Module

This example shows a Passed inspection, where the following tags are all 1:

¢ IN.Status.InspStat

¢ IN.bool.booll (Measure status)

¢ IN.bool.bool2 (decode+matchcode status)

¢ IN.bool.bool3 (count blob status)

Mame -=| & | Walue | % Style Drata Typ| Description
[=l-Sean_MV_I10_user [oaa] Scan_... |user's device tags when M
LI:_l-S can by _I0_user M [...] Szan .. |uzer's device tagz when b
Lt_|-8c:an_M\-"_ID_user.IN.Status {...} Scan .. |uzers device tags when M
—Scan W 10_user [N Status. Online 1| |Decimal |[BOOL  |uzer's device tags when b
—Scan_ Y _I0_user M Statuz ExpBusy 0| |Decimal |BOOL  |user's device tags when b
—Sean_MW_I0_user M. Statuz.dogBusy 0| |Decimal |BOOL  |user's device tags when b
—Scan_MY_I0_user |M.Statuz. TriggerReady 1| |Decimal |BOOL  |uzers device tags when b
—Scan_ Y _I0_user M. Statuz Error 0| |Decimal |BOOL  |user's device tags when b
—Secan_MY_I0_userIM. Statuz ResetCountdck 0| |Decimal |BOOL  |user's device tags when b
—Scan_MY_I0_user M. Statuz.rezenvedb 0| |Decimal |BOOL  |uzers device tags when b
—Scan_ MW 10_user IM.Status ExeCrmdAck 0| |Decimal |[BOOL  |uzer's device tags when b
—Scan kY _I0_user M. Statuz. Triggerdck 0| |Decimal |BOOL  |uzer's device tags when b
—Secan_MW_I0_user M. Statuz lnepBusy 0| |Decimal |BOOL  |uzers device tags when b
—Scan_ MW 10_uszer [N Statuz InspStat 1| |Decimal |[BOOL  |uzer's device tags when b
—Scan_hY_I0_user M. Statuz D atah alid 0| |Decimal |BOOL  |uzer's device tags when b
—Sean_MW_I0_user M. Statuz.rezened] 2 0| |Decimal |BOOL  |user's device tags when b
—Scan_MY_I0_user M. Statuz.rezerned] 3 0| |Decimal |BOOL  |uzers device tags when b
—Sean kY _I0_user M Statuz reserved] 4 0| |Decimal |BOOL  |user's device tags when b
—Sean_MY_I0_user M. Statuz.rezernedlb 0| |Decimal |BOOL  |user's device tags when b
[F-Sean_y_I0_userIN.Status.Echo 0| |Decimal [IMT uzer's device tags when b
[H-Scan_MyV_10_user M Status CrdCodeRslt 1640000_0000| [Hex DIMT uzer's device tags when b
[FH-Scan_My_10_user. N Status. CrndRet 0| |Decimal |DINT uzer's device tags when b
[FH-Scan_My_I0_user IN.Status rezerveddB_103 0| |Decimal [SIMT uzer's device tags when b
[H-Scan_MV_10_user M Status reserved104_111 0| |Decimal [SIMT uzer's device tags when b
[H-Scan Y 10_user M. Status. State 1| |Decimal |SINT uzer's device tags when b
[FH-Scan_My_I0_user IN.Status. reserved1 20127 0| |Decimal [SIMT uzer's device tags when b
[FH-Sean_My_I0_user.IN.VIO0 {eaal Scan .. |uzers device tags when M
[=-Szan_ MY _I0_uzer.IM.bool {...] Szan .. |uzer's device tagz when b
—Secan_MY_I0_user M. bool booll 1| |Decimal |BOOL  |measzure statuz

—Scan_MY_I0_user M. bool bool2 1| |Decimal |BOOL | decode+matchoode statu

—Scan_tY_I0_user N baal boal3 1| |Decimal |BOOL | blab count status
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Integrating the Camera into a PLC Environment

Sfe
If you scroll down to the IN.long, float, and string values, you will see the literal results of Qo 8 g
the vision tools. 3 L O
— =0=
Mame =] ) £ 14 Stule Data Tyg| Dezcription _% © =
[FH-Scan_MY_10_userIMN IO [---1[ Scan_... |user's device tag CE S 8
[#-Secan_MY_I0_uzerIN boal {---1[I Scan_... |user's device tag é % B
[FH-Scan My 10_uzer|M.int [---11 Sgan ... |user's device tag <@ o E
[=-5can_MY_10_userIM.lang I I Scan_... |uzer's device tag <_( 0 L
[F-Scan_MY_I0_user N lang long] 4| |Decimal |DINT Blob cont
[+-5zan_MyY_10_user.IN.long lang2 0f |Decimal |DINT uzer's device tag
[F-5can My 10 _uszerIM.long long3 0| |Decimal [DINT uzer's device tag
[+-5can_MY_I0_uzer.IM.long langd 0| |Decimal |DINT uzer's device tag
[F-Scan_My_I0_uzer M. long. langS 0| |Decimal [DINT uzer's device tag
[+-Szan_MyY_10_user.IN.lang langs 0f |Decimal |DINT uzer's device tag
[F-5can My 10 _uzerIM.long long? 0| |Decimal [DINT uzer's device tag
[+-5can_MY_I0_uzer.IM.long langd 0| |Decimal |DINT uzer's device tag
[F-Scan_My_I0_uzer M. long. langd 0| |Decimal [DINT uzer's device tag
[+-5 can_MY_I0_uzer. M. long long10 0f |Decimal |DINT uzer's device tag
[—=-Scan MY 10 userIM. float [..-1[I Scan_... |user's device tag
—Scan_My_10_uszer IM float. loat 173.0306| |Float REAL  |Meazure value
—Scan_MY_I0_userIM float lloat2 0.0/ |Float REAL uzer's device tag
—Scan_MY_I0_userIM.float. float3 0.0/ [Float REAL uzer's device tag
—Scan_ MY _10_userIM.float floatd 0.0/ [Float REAL uzer's device tag
—Scan_My_10_user IM. float floath 0.0 |Float REAL  |uszer's device tag
—Scan_MY_I0_user M float loath 0.0/ |Float REAL uzer's device tag
—Scan_MY_I0_userIM.float. float? 0.0/ [Float REAL uzer's device tag
—Scan_ MY [0 _userIM.float floatd 0.0/ [Float REAL uzer's device tag
—Scan_My_10_user IM. float floatd 0.0 |Float REAL  |uszer's device tag
—Scan_MY_I0_user M. float Hoat10 0.0/ |Float REAL uzer's device tag
[=|-Scan_MY_I0_uzerIN. sting {---1[I Scan_... |user's device tag
-Scan_MV_ID_user.IN.string.string'l '"LAEEL CHECK" |[ Scan_... |Decode text
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This is equivalent to the AutoVISION inspection result.

This example shows a Failed inspection, where every tool reports a fail.

Allen-Bradley PLC Setup via Generic Ethernet Module

Mame —g| o | Walue A Style Data Tye| Description
E-Scan_MV_lD_user.lN Vocoh Scan_... |user's device tags
E-Scan_MV_lD_user.lN.Status oo Scan_... |uzer's device tags
—Scan_MV_I0_user M. Status. Online 1| |Decimal [BOOL uzer's device tags
—Scan_MY_I0_uzer M. Status.ExpBusy 0| |Decimal [BOOL user's device tags
—Secan_bMV_I0_uzer M Status AcqBusy 0| |Decirmal [BOOL uzer's device tags
—Scan_MV_I0_user M. Status. TriggerReady 1| |Decimal [BOOL uzer's device tags
—Scan_MY_I0_user. M. Status.Emor 0| |Decimal [BOOL user's device tags
—Sean_MV_I0_uzer M. Statuz ResetCountick, 0| |Decirmal [BOOL uzer's device tags
—Scan_MV_I0_user M Status.reserveds 0| |Decimal [BOOL uzer's device tags
—Scan_MY_I0_user. M. Status. ExelCmdack 0| |Decimal [BOOL user's device tags
—Sean_MV_I0_uzer M. Status. Triggerdick 0| |Decirmal [BOOL uzer's device tags
—Scan_MV_I0_user M. Status InspBusy 0| |Decimal [BOOL uzer's device tags
—Scan_MY_I0_uzer. M. Status.InspStat 0| |Decimal [BOOL user's device tags
—Secan_MV_I0_uzer M. Status. D atahr alid 0| |Decirmal [BOOL uzer's device tags
—Scan_MV_I0_user M. Status.reserved] 2 0| |Decimal [BOOL uzer's device tags
—Scan_MY_I0_user M. Status.reserved] 3 0| |Decimal [BOOL user's device tags
—Sean_bMV_I0_uzer M. Status.rezervedld 0| |Decirmal [BOOL uzer's device tags
—Scan_MV_I0_user M Status.reserved] s 0| |Decimal [BOOL uzer's device tags
[H-Scan_MWV_I0_user.IM.Status.Echa 0| |Decimal |[INT user's device tags
[+]-Scan_MY_|0_uzer |M Status. CrmdCaodeR slt 1640000_0000| [Hex DIMT uger's device tags
[H-Scan_MWV_I0_uszer IM Status. CrndP et 0| |Decimal [DIMT uzer's device tags
[H-Scan_MWV_I0_user.|M.Status.reservedds_103 0| |Decimal [SINT user's device tags
[+-Scan_MV_I0_uzer.IN Status.rezerved104_111 0| |Decimal [SINT uger's device tags
[H-Scan_MWV_I0_user |M Status. State 1| |Decimal [SINT uzer's device tags
[+]-Scan_MY_|0_user M. Status.reserved]20_127 0| |Decimal [SINT usger's device tags
[+-Scan_Myv_|0_user IN.YIO oo Sean_... |user's device tags
[=-Scan_Mv_|0_user.|M.bool fomal Scan_... |uzer's device tags
—Secan_MY_10_uzer. M. bool booll 0| |Decimal [BOOL measure stabus

—Scan_bV_I0_uger N bool bool2 0| |Decimal [EOOL decode+matchoog
—Scan_MV_|0_user M bool bool3 0| |Decimal [BOOL blob count status
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9go
This is the Failed inspection’s literal data. aoes
MName -a|a | Value |9 Style Drata Typ| Description 38 o
FJ-Scan_MV_ID_user.IN.Iong {---H[[ Scan_... |uszer's device tagg g S %
[F-Scan_MY_|0_uzerIM.long.longl Decimal |DIMT Blob count P S Qo
[+-Scan_MY_I0_userIM. long.long2 Decimal |DINT uzer's device tags CIQ o E
[+H-Scan_My_I0_uzer.IM.long.long3 Decimal |DINT uzer's device tagg % 3 g
[F-Scan_MY_|0_userIM.long.longd Decimal |DIMT uzer's device tagy = m
[+-Scan_My_I0_user N long.longS Decimal |DINT uzer's device tags < n
[F-Scan_Mv_I0_user M. long.longs Decimal [DINT uzer's device tags

[FH-Scar_My_I0_userIM.long.long? Decimal |DINT uzer's device tagy
[+-Scan_My_I0_user N long.longd Decimal |DINT uzer's device tags
[F-Scan_Mv_I0_user M. long.longd Decimal [DINT uzer's device tags
[FH-Scar_My_I0_userIM.long.longl0 Decimal |DINT uzer's device tagy

[0
Ll

-Scan_MY_I0_uzer M float
—Scan MY _I0_uzer M. float. floatl 59.40699
—Scan_MV_|I0_uzerIM. float.loat2
—Scan_bY_I0_uzer M float. float3
—Scan_bY_|I0_uzer M float. floatd
—Scan_MV_|I0_uzerIM. float. Aoath
—Scan_bY_I0_uzer M float. floats
—Scan_bY_|I0_uzer M float. float?
—Scan_MV_|0_uzerIM. float. Aoatd
—Scan_bY_I0_uzer M float. floatd
—Scan_bV_I0_uzer M float. float1l
[=l-Scan_ Wy _10_uzerIN.shing

E|—S cat_bY_I0_uzer IM. string. string

Scan ... uzer's device tags
Float RE&L Measure value
Float REAL  [uzer's device tags

Flaat REAL  [uzer's device tags

Float REAL  [|uzer's device tags

Float REAL  [uzer's device tags

Flaat REAL  [uzer's device tags

Float REAL  [|uzer's device tags

Float REAL  [uzer's device tags

Flaat REAL  [uzer's device tags

[ e T T s s e e e

Float REAL  [|uzer's device tags

—
.
.

[ Scan_... [uzer's device tags

=
.
.
P "

Rl e = e e e e e e e e T e e e T e e e e Y e I e B = I

[ Scan_... |Decode test

This is equivalent to the AutoVISION inspection report.
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Parameterize the Camera Again

The Measure and Count Blob tools can be parameterized by the PLC so they always
pass. The Decode Tool can be parameterized so it always fails, either due to no decode,
or a Match Strings mismatch. Scroll the tag window so OUT.long, float, and string are
visible, then change them as shown below.

Mame —z|e [ vale | % Stle Data Tog| Description Congtant
[+-Scan_My_I0_user, OUT VIO focalf Scan_... |user's device tags when MY_demo_mode iz 1 o 2.
[+-Scan_ty_|0_user. OUT bool focalf Scan_... |user's device tags when MY_demo_mode iz 1 o 2.
[+-Scan_ty_|0_user, OUT int focalf Scan_... |user's device tags when MY_demo_mode iz 1 o 2.
[=-Scan_M¥_10_user.OUT long [ Scan_... |user's device tags when MY_demo_mode iz 1 o 2.
[H-Scan_My¥_10_user.0UT long.longl Ol 4| |Decimal [DINT Blob count must be equal to or higher than this to pass
[H-Scan_MY_10_user.OUT long.longl 02 &| |Decimal [DINT Blob count rust be equal ta or lawer than this to pass
[H-Scan_MY_10_user.OUT long.longl 03 0| |Decimal [DINT uzer's device tags when MY _demo_mode iz 1 or 2.
[H-Scan_MY_10_user.OUT long.longl D4 0| |Decimal [DINT uzer's device tags when MY _demo_mode iz 1 or 2.
[H-Scan_MY_10_user.OUT longlongl 05 0| |Decimal [DINT uzer's device tags when MY _demo_mode iz 1 or 2.
[+ -Scan_My_I0_user.0UT long longl 06 0| |Decimal |DINT uzer's device tags when MY_dema_mode is 1 ar 2.
[+ -Scan_My_10_user.0UT long longl 07 0| |Decimal |DINT uzer's device tags when MY_dema_mode is 1 ar 2.
[#-Scan_My_I0_user.0UT long longl 02 0| |Decimal |DINT uzer's device tags when MY_dema_mode is 1 ar 2.
[#-Scan_My_10_user.0UT longlongl 09 0| |Decimal |DINT uzer's device tags when MY_dema_mode is 1 ar 2.
[+-Scan_My_10_user. OUT long.langl 10 0| |Decimal |DINT uzer's device tags when MY_dema_mode is 1 ar 2.
[=-Sean_MY_|0_user, OUT foat {..-1[ Scan ... |user's device tags when MY_demo_mode is 1 or 2.
—Scan_MY_10_user. JUT float.float] ol 50.0| |Float REAL  |Measure value must be higher than this to pass
—Scan_MY_10_user. JUT float float]02 200.0| |Float REAL | Measure value must be lower than this to pass
—Scan_MY_10_user. JUT float float]03 0.0 |Float REAL  |user's device tags when MY_demo_mode is 1 or 2.
—Scan_MY_10_user. JUT float float] 04 0.0 |Float REAL  |user's device tags when MY_demo_mode is 1 or 2.
—Scan_MY_10_user OUT foat. foat] 05 0.0| |Float REAL x|
—Scan_MY_10_user OUT foat.float] 08 0.0/ |Float REAL
—Scan_My_|0_user, OUT float flaatl 07 0.0| |Float |REAL [wRoNG coDE =] |
—Scan_MV_10_uger.OUT foat. foat] 02 0.0/ |Float REAL E
—Scan_MV_10_uger.OUT foat.float] 09 0.0/ |Float REAL sL
—Scan_MV_10_uger.OUT foat.foat] 10 0.0/ |Float REAL N
[=-Sean_MW_|0_user. OUT sting [ Scan =
[+-Sean_My_|0_user. OUT sting. string 0 '"LABEL CHECK' ([ Scan
[F-Scan_MY_I0_user OUT sting. sting 02 'SEE005005. .. |[ Scan S
[+-Scan_Mv_10_user OUT string. stingl 03 LA} Scan j il
[H-Sean_MY_I0_user OUT sting shingl 04 tr Scan oK Cancel | Bpply | Help |
[+I-Scan_MY_matchcode 'LEBEL CHECK" [ Scan
[+]-Scan_tV_ons_internal -2080374528| |Decimal |DINT “" % 0Emor(s) ’T 1= 10I i ﬂ”
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Trigger the Camera Again
Trigger the camera twice and you will see the Status results stay the same for all triggers:
bool2 (decode+matchcode status) = 0

Why: Decode + Matchcode status always fails because the matchcode has been changed
to wrong code, or there is no decode.
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booll (Measure status) and bool3 (count blob status) =1
Why: The inspected values are now within tolerance.
InspStat =0

Why: The Decode tool fails, so the overall Inspection result is a Fail.

PLC tags:
Mame ==& | Walue | 9 Style Data Tyg| Description
LI:_|-Scan_MV_I O_uzerIM {auall Scan ... |user's device tags
E-Scan_M\.-"_ID_user.lN.Status ey Scan_... [uzer's device tags
—Scan_MY_|0_uzerIN.Status. Online 1| |Decimal |[BOOL | user's device tags
—Scan_MV_|0_userIM.Status. ExpBusy 0| |Decimal |[BOOL  |uzer's device tags
—Scan_MY_|0_uzer M. Status. AcqBusy 0| |Decimal |[BOOL  |uzer's device tags
—Scan_MY_|0_user.IM.Statuz. TriggerReady 1| |Decimal |[BOOL | user's device tags
—Scan_MY_|0_uzer IM.Status. Emor 0| |Decimal |[BOOL  |uzer's device tags
—Scan_ MY _|0_uzer M. Status. ResetCountdck 0| |Decimal |[BOOL | uzer's device tags
—Scan_MV_|0_uzer IM.Status. reserveds 0| |Decimal |[BOOL  |uzer's device tags
—Scan_MV_|0_uszerIM.Status ExeCmdack 0| |Decimal |[BOOL  |uzer's device tags
—Scan_MY_|0_uzer IM.Status. Triggerdck 0| |Decimal |[BOOL  |uzer's device tags
—Scan_MV_|0_user M. Statuz. InspBusy 0| |Decimal |[BOOL  |uzer's device tags
—Scan_ MY _|0_uzer M. Statuz. InspStat 0| |Decimal |[BOOL | user's device tags
—Scan_MV_|0_user IM.Status. D atavalid 0| |Decimal |[BOOL  |uzer's device tags
—Scan_MY_|0_uzer M. Status.reserved] 2 0| |Decimal |[BOOL | user's device tags
—Scan_MV_I0_user M. Status. reserved]3 0| |Decimal |[BOOL  |uzer's device tags
—Scan_MV_|0_uszer M. Status. reserved]d 0| |Decimal |[BOOL  |uzer's device tags
—Scan_MY_|0_uzer M. Status. reserved]s 0| |Decimal |[BOOL | user's device tags
[+-Scan_MY_|0_user IN.Status. Echa 0| |Decimal |[INT uzer's device tags
[+-Scan_MY_I0_user IN.Status CrdCodeR sl 1640000_0000| |Hex DIMNT uzer's device tags
[+-Scan_MY_|0_user IN.5tatus. CmdRet 0| |Decimal |DINT uzer's device tags
[#-Scan_Mv_I0_user IN.Status reserved35_103 0| |Decimal |SINT uzer's device tags
[#-Scan_MY_I0_user IN.Status.reserved]04_111 0| |Decimal |SINT uger's device tags
[#-Scan_MY_|0_user IN.Status State 1| |Decimal |SINT uzer's device tags
[+-Scan_My_I0_user IN.Status.reserved] 20_127 0| |Decimal |SINT uger's device tags
[+-Scan_Myv_I0_userIN. VIO ey Scan_... [uzer's device tags
[=1-Scan_My_I0_user M. baol ey Scan_... [uzer's device tags
—Scan_MV_|0_uzerIMN.bool booli 1| |Decimal |[BOOL  |measure status
—Scan_MV_|0_userIMN.bool bool2 0| |Decimal |BOOL | decode+matchcode
—Scan_ MY _[0_ugerIN.bool bool3 1| |Decimal |[BOOL | blob count status

This concludes the EtherNet/IP demo.
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CHAPTER 6 Demo EtherNet/IP PLC Code

This section describes how to use Microscan demo PLC code with a
vision job and camera target.

Important: The examples in this section show the Vision HAWK Smart
Camera, but are also applicable to the MicroHAWK Smart Camera.

The EtherNet/IP demo files can be found where AutoVISION is installed,
in the folder C:\Microscan\Vscape\Tutorials and Samples\Vision
Hawk\EIP demo. Open the EIP_demo.avp with AutoVISION and
download it to the camera.

During PLC integration, import the 32-000003-2.L5X file to create the
camera’s demo tags and ladder logic.

Notes:

e The camera communications protocol must be enabled for
EtherNet/IP before it can be used in this environment. Refer to
Chapter 1, Enabling Industrial Protocols, for information about
enabling communications protocols for the camera, and information
about switching camera communications protocols.

e AutoVISION and FrontRunner jobs use Microscan Link functionality
to accommodate EtherNet/IP communications between the camera
and the PLC. For information about how to connect job parameters
and outputs to Microscan Link tags, refer to the Linking Datums to
Microscan Link Tags section of Chapter 2 in the Visionscape
FrontRunner User Manual.

AutoVISION and Visionscape Industrial Protocol User Manual 6-1

®)
-l
o
o
e
[<H)
Z
S
Q
L
e}
1]
o
S
QO
()]



Chapter Demo EtherNet/IP PLC Code

Glossary of Terms

The following terms are used in the description of Microscan’s demo PLC
program.

Camera

The Microscan Smart Camera used in this application, which has an
EtherNet/IP communication interface.

User App

The PLC logic code written by the end user or system integrator.

Demo Code
The PLC logic code distributed by Microscan that can be imported into the

PLC’s ladder logic area. It encapsulates most of the device Control and
Status management.

The demo code expects a demo vision job loaded on the camera.
However, the demo code will operate whether or not the demo vision job
is loaded on the camera.

Activate / Set High
Writing a 1 value to a single Control bit, or any other bool bit.
Active
A Control, Status, bool, or PLC logic “contact” in a 1 state.
Clear
A Control, Status, bool, or PLC logic “contact” in a O state.
One Shot
A PLC tag write operation that is performed once, typically in reaction to

an event. After a one shot operation, the PLC logic does not write to the
same tag again unless another event occurs.
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Demo Setup

Demo Setup

Vision Job Setup

The EtherNet/IP demo files can be found where AutoVISION is installed,
where the default folder is C:\Microscan\Vscape\Tutorials and
Samples\Vision Hawk\EIP demo.
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1. Open EIP_demo.avp with AutoVISION.

2. To use pre-defined images, select the icon shown here.

Select a directory for images |

3. Browse to the EIP demo folder, select it, and click OK.

Sedact the preferred Folder contaning the mages

= % Local Disk (C:) L
# ) 1e7a063e7he9fs2ccaddazo0dbsls
# () Doouments and Settings
= | Microscan
® I AutoVision
# ) Installlnfo
= 1) Wscape
£ 1) 600_16
® ) Assembly
) DM
) Dacument stion
) Drivers
) Firmmears
= Jobs
) Tukoriats And Samples
# ) GigE Systems
H ) Samphe Jobs
= I Wision Hawlk
() Advanced Example Lising Mukiple Tools
W EIF demo
) Simple: Blob Tool
3 Sienphe Data Matrix Tool
(3 Simple Fast Edge
3 Simple Flaw Toal
H () Veshon Mirs w

i & B E

Make Neve Folder [ ok J[ conces |
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After the EIP demo folder has been enabled for image load, the
camera icon will change to a folder.

While in Edit mode, Try Out can be used to get an understanding of
what to expect after the job is sent to the camera.

Before Try Out can be effective, the Measure, Decode, and Count
Tool parameters must be specified. After job download, the tool
parameters will be supplied by the PLC.

Measure Tolerance:

Lower Tolerance Upper Tolerance
[ 100 | @ [ 200 | @@
L

Decode Matchstring:

LABEL CHECK az

Count Tolerance:

6-4
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With these tool parameter configured as shown, Try Out will show the
following Pass/Fail results:

Fail:
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Pass:

5. Download the job to the camera.

6. Add the camera and demo code to the PLC environment (see the
next section).

PLC Demo Code Setup

During PLC integration, import the 32-000003-2.L5X file found in the EIP
demo folder to create the camera’s demo tags and ladder logic (refer to
the Allen-Bradley PLC Setup chapters).
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Description of PLC Tags

Scan_MV_demo_mode

Purpose

This tag is intended for demonstration purposes only. It modifies the
operation of the demo code and allows the first-time user to control the
device directly with no assistance from the demo code. It also allows the
demo code to manage the Control and Status signals fully.

The demo mode tag takes three different values, putting the demo code
into one of three modes of operation:

e Exchange I/O data only

« Actively operate device controls, status, and demo data

< Automatically trigger the device after one second of idle time
User App Method

User app can set the demo mode with one of three values to define the
demo code’s mode of operation.

0 = Exchange I/O data only

In this mode, the user directly accesses the Scan_MV_|O_internal tag
set. The demo code only exchanges data with the camera, doing nothing
to control the device or respond to events from it.

1 = Operate device controls and respond to device events

This is the default mode of the demo code. In this mode, the user app
accesses the Scan_MV_I0O_user tag to control and monitor the camera.
The user app must not access the Scan_MV_IO_internal tag set.

In this mode, the user activates the controls in
Scan_MV_I0_user.OUT.Control (Trigger, ResetCount, GoOnline,
GoOffline, ResetError, ExeCmd), and the demo code handles the rest.

2 = Auto-trigger

6-6
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In this mode, the demo code fully manages the Control and Status
signals, the same as when the mode is set to 1. It also activates the
camera’s trigger after one second of idle time. The timer used to drive the
trigger is Scan_MV_trigger_delay_timer.

Demo Code Usage

Depending on the mode, the demo code will run the appropriate level of code.
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« In mode 0, only the I/O exchange rungs are executed. All others are
bypassed.

« In mode 1, the auto-trigger rungs are bypassed. This is the default
mode of the demo code.

¢ Inmode 2, all rungs are executed.

Scan_MV_10 _user

Purpose

User-accessible 1/0 data for the camera. The user app reads and writes
these 1/O tags, and the demo code handles the actual on-the-wire control
of the camera.

User App Method
Activate a Control by setting its value to 1.

The user app can determine that the Control is done when the Control is
clear (demo code changes the Control to a bit/bool value of 0). Do not
attempt to activate a Control unless it is clear.

The user app should activate the Controls using one shot writes. The use
app should not continuously hold a Control in an active state. Holding a
Control in an active state will prevent the demo code from notifying the
user app that the Control operation is complete by clearing the Control.

Usually, when a Control is clear (0), the camera is ready for the Control to
be activated again. Please see the Specific Control Guidelines and
Specific Status Guidelines below for qualifications.
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Demo Code Usage

The demo code waits for the user app to activate a Control. When the
user app activates a Control, the demo code handles all handshaking and
confirmation that the Control operation is performed by the camera. When
the operation is complete, the demo code clears the Control back to 0.

Specific Control Guidelines

GoOnline and GoOffline

In order to take the camera Online and Offline, only one of these Controls
can go active (change from 0 to 1), and be active, at any given time.

ResetCount

After the user app activates ResetCount, the demo code will clear
ResetCount when the operation is complete. The next Inspection output
will be 1 (as can be seen if AutoVISION is connected to the camera in
run mode).

Trigger

Do not trigger the camera unless the TriggerReady Status is active. If
the Trigger goes active when TriggerReady is not active, the demo code
increments the counter Scan_MV_trigger_err_count, and immediately
clears the Trigger Control without attempting to trigger the camera.

After the user app activates the Trigger, the demo code will clear the
Trigger when the camera indicates it has accepted the Trigger.

Do not re-trigger the camera until DataValid in the Status register goes
active, all Inspection data has been processed, and DataValid is cleared
using the ResetDataValid Control.

ResetDataValid

When the user app sees DataValid go active, it should process the
Inspection data, then clear DataValid by activating ResetDataValid.

See Data Valid for more details.

6-8

AutoVISION and Visionscape Industrial Protocol User Manual



Description of PLC Tags
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ResetError o
=
To clear the Error Status, activate ResetError. %
—
ExeCmd, CmdCode, CmdArg g
L
These Controls can be used to perform a job change, and query the )
active job slot. The demo code includes tags with pre-defined CmdCode £
and CmdCodeRsilt definitions: 8
Tag Meaning
Scan_MV_const CmdCode GetActivelb Query the active job slot number (returned in CmdRet)
Scan_MV_const_CmdCode_JbChg Go Offline, Load job specified by LSB
Scan_MV_const_CmdCode_JbChg MkBt Go Offline, Load Job specified by LSB, Make it the boot job
Scan_MV_const_CmdCode_JbChg_MkBt_Online Go Offline, Load Job specified by LSB, Make it the boot job, Go Online
Scan_MV_const_CmdCode_JbChg_Online Go Offline, Load Job specified by LSB, Go Online
Scan_MV_const_CmdCodeRIst_Fail_No_Job Job Change failed: No job in slot
Scan_MV_const_CmdCodeRIst_Fail_UlI PC Ul is controlling the camera,
Scan_MV_const_CmdCodeRIst_Fail_Unk_Cmd Job Change failed: Unknown CmdCode
Scan_MV_const_CmdCodeRIst_Success Completed operation OK.

The ExeCmd, CmdCode, and CmdArg controls are used in combination
with these Status signals:

Control signal Status signal

ExeCmd ExeCmdAck
CmdCode CmdCodeRslt
CmdArg CmdBet

The demo code records the final result of the command operation by
copying CmdCode, CmdArg, CmdCodeRslIt and CmdRet to the
following tags:

Source Control/Status tag Final result tag
Scan_MV_IO_user.OUT.Control.ExeCmd Scan_MV_CmdCode_last
Scan_MV_10_user.OUT.Control.CmdArg Scan_MV_CmdArg_last
Scan_MV_10_internal.IN.Status.CmdCodeRslt Scan_MV_CmdCodeRslt_last
Scan_MV_I0_internal.IN.Status.CmdRet Scan_MV_CmdRet_last
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Chapter Demo EtherNet/IP PLC Code

The demo code will automate the command process when
Scan_MV_demo_mode is 1, which is the default value at program
startup, similar to how it assists the Triggering and DataValid Controls.
The PLC integrator can initiate command operation by accessing the
demo code’s Scan_MV_10_user tag set for Control and Status signals.
While a command operation is active, the demo code forces all Control
signals to an inactive state, except for the Echo. No Controls can be
activated until the command operation is completed. To verify the camera
is still “alive” during command execution, Control.Echo can be
incremented, and the Status.Echo will update accordingly.

When the demo code automates the command process, the PLC
integrator is responsible for the following steps:

1. Deactivate all Controls and clear DataValid and Error status signals.
This is a best-practice measure to ensure that the PLC has
transitioned from a state of triggering and processing inspections to
issuing a command.

2. If ajob change command is to be issued, populate the output tags
required to configure the new job (bool, int, long, float, string).

3. Write the required CmdCode (see Scan_MV_const_CmdCode_Xxxxx
tags) and CmdArg, then activate ExeCmd.

4. Wait for ExeCmd to go inactive (per typical demo mode 1 operation).
Note that job changes can take up to a minute. While a job change
command is being executed, the Status.State tag will be 2.

5. When ExeCmd goes inactive, verify the following:
Scan_MV_CmdCodeRslt_last is 0 (Success)

Scan_MV_CmdRest_last contains the returned data from the
command (if any)

Status.State has changed to 0 (Offline) or 1 (Online)
ExeCmdAck is inactive (0)
Status.Error is inactive (0)

6. Put the camera online (if necessary), and continue with normal
runtime operation.
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Specific Status Guidelines
Online

The camera cannot be Triggered or generate Inspection data unless
Online is active. See the GoOnline Control.

TriggerReady
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Do not attempt to trigger the camera unless TriggerReady is active.
See the description of the Trigger for more details.

TriggerAck and ResetCountAck

Used by the demo code to complete the respective operations.
DataValid

When DataValid goes active, the user app should process the Inspection
data, then clear DataValid using the ResetDataValid control. This is
handled, by the demo code in mode 1 and 2, as a demonstration for the
user app.

If the camera’s DataValid goes active, but the user app has not cleared a
previous DataValid event, the demo code does not overwrite
Scan_MV_I0_user with new Inspection data. Instead, the demo code
increments the counter Scan_MV_dv_err_count. The new Inspection
data remains stranded in the Scan_MV _internal tag set, and is
effectively lost.

Scan_MV_trigger_count

Incremented by the demo code when a new trigger is issued to the
camera over the EtherNet/IP interface (Trigger Control activated).

Scan_MV_trigger_err_count

Incremented by the demo code if the user app attempts to trigger the
camera when TriggerReady is not active.
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Scan_MV_dv_err_count

Incremented by the demo code when new Inspection data is received
from the camera, but the user app has not cleared the previous DataValid.

Scan_MV_status_err_count

Incremented by the demo code whenever the Error Status goes active.

Scan_MV_demo_blob, Scan_MV_demo_decode,
Scan_MV_demo_InspStat, Scan_MV_demo_measure

Purpose

These tags record counts and min and max values of several EIP IN data
members.

The demo code expects a demo vision job to be loaded on the camera,
and a demo target to be in the camera’s field of view. The demo PLC code
will operate without the demo vision job being loaded on the camera.
However, the data records will not be valid.

The demo vision job has the following data members linked to certain job
tools:

IN

Booll = Measure status (pass/fail)

Bool2 = Decode+Matchcode status (pass/fail)
Bool3 = Blob count status (pass fail)

Long1l = Blob count

Floatl = Measure value

Stringl = Decode text

ouT

Long101 = Blob count minimum count tolerance

Long102 = Blob count maximum count tolerance

6-12
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Float101 = Measure lower tolerance
Float102 = Measure upper tolerance
String101 = Matchcode

Each tag set records the following data for each vision job tool result received in the
Inspection report:
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Tool Result Record tag EIP IN tag
Measurement Status Scan_MV_demo_measure. Scan_MV_user_IN.bool.booll

bool = last status(pass/fail)
pass_count = count of passes
fail_count = count of fails

Measurement Scan_MV_demo_measure. Scan_MV_user_IN.float.floatl
float = last value

float_max = max value recorded
float_min = minimum value recorded
Decode Text Status Scan_MV_demo_decode Scan_MV_user_IN.bool.bool2
(matchcode) bool = last status(pass/fail)

pass_count = count of passes
fail_count = count of fails

Decode Text Scan_MV_demo_decode Scan_ MV _user |0.string.stringl
string = text of the last barcode
decode attempt (null if noread)
Blob Status Scan_MV_demo_blob Scan_MV_user_IN.bool.bool3
bool = last status(pass/fail)

pass_count = count of passes
fail_count = count of fails

Blob Count Scan_MV_demo_blob Scan_MV_user_IN.long.longl
long = last value
long_max = max value recorded

long_min = minimum value recorded
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User App Method

The user app can follow the demo code’s usage of these tags for further application logic
development.

During runtime, the user app can change the OUT data members, and observe the
change in tool status after a new trigger.

Specifically, the PLC integrator would typically modify the logic beginning at the following rungs:

Scan_MV_all_rungs_below_are_user_logic
a1 {LeL ] { noP 11—

users device tags
when
Scan_MV_demo_mods
istor2
- top-level status osr storage
Scan_MV_demo_user_dv_begin  Scan_MV_IO_userIN Status. DataValid
4z {LBL } 7 E One Shot Rising
Storage Bit Scan_MV_user_events30 £ SB)—
Output Bit  Scan_MV_user_svents 31 [ OB—

Demo Target

The demo vision job uses predefined images. It is unnecessary to have the camera aimed
at any specific target. If preferred, the job can be changed to enable the camera’s image
sensor. In this case, the demo targets should be printed approximately 2.5 inches (63
mm) wide by 1.6 inches (40 mm) tall, centered on white paper larger than the camera’s
field of view, and presented to the camera with the Data Matrix symbol on the right:

“Pass” Image
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“Fail” Image
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Demo Code Usage

The user app example of the demo code watches for Data Valid. When it goes active, the
user app example processes the user I/O data, updates each demo record with the
results, then uses ResetDataValid to clear DataValid.

Scan_MV_IO_internal, Scan_MV_ons_internal
Purpose

Used by the demo code to manage the camera.

User App Method

None. The user app must not attempt to read or write to this tag set.

Demo Code Usage

The demo code uses this tag set to abstract the on-the-wire control of the camera from the
user app.

AutoVISION and Visionscape Industrial Protocol User Manual 6-15



Chapter Demo EtherNet/IP PLC Code

Run the Camera: Runtime Operation of EtherNet/IP Demo

At this point in the evaluation, it is assumed that you have downloaded the demo vision job
to the camera and that your PLC is running the EtherNet/IP demo code and exchanging
data with the camera. The PLC can now parameterize, trigger and monitor the camera
over EtherNet/IP.
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EtherNet/IP Operation

This section describes how to set up an Omron PLC for EtherNet/IP
operation using a Microscan smart camera and CX-One software.

Important: The examples in this section show the Vision HAWK Smart
Camera, but are also applicable to the MicroHAWK Smart Camera.

Notes:

e The camera communications protocol must be enabled for
EtherNet/IP before it can be used in this environment. Refer to
Chapter 1, Enabling Industrial Protocols, for information about
enabling communications protocols for the camera, and information
about switching camera communications protocols.

¢ AutoVISION and FrontRunner jobs use Microscan Link functionality
to accommodate EtherNet/IP communications between the camera
and the PLC. For information about how to connect job parameters
and outputs to Microscan Link tags, refer to the Linking Datums to
Microscan Link Tags section of Chapter 2 in the Visionscape
FrontRunner User Manual.
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Chapter I8l Omron PLC Setup for EtherNet/IP Operation

Setting Up an Omron PLC

This section was created using the following Omron software and hardware:
e CX-Programmer version 9.43

« Network Configuration version 3.55

« PLCCJ2M CPU31

Start the CX-Programmer application and select menu item File > New. Enter the desired
Device Name. Select the Device Type and then click Settings to the right of the Device
Type menu.

x
Device Name
’]]1 Test
— Device Type
[cim (=) setings... ||
— Metwork Type
IToolbus j Settings... |
— Comment
=l
El
QK | Cancel | Help |

In the Device Type Settings dialog, select the correct CPU Type and click OK.
x|

General |

CPU Type
CPUT1 'I
CPUT1
TicPu12
e I Feadonty
CPU15
ggﬁ%ﬁ I~ Read Only
CPU34
FlCPU35
’7 None 'I I™ | Read Orly
Timer / Clock
( I [stalled ‘
Make Defaultl

oK | camcel | Hep
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Select USB from the Network Type menu and click OK.

Change PL x|
— Device Mame
|HewPLC
— Device Type
IDJ2M ﬂ Settings... I
— Metwark Type N
Juss jJ Settings._|
" Show 4l
r— Comment
=
a
QK. | Cancel | Help |

Setting Up an Omron PLC
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Connect to the PLC via USB connection. Select the menu item PLC > Work Online or
click the online icon in the tool bar. When prompted, click Yes to complete the connection.

BERICY

[Hwork Online (Ctrl+W)

Once successfully connected, the background of the right pane will turn gray and the
online icons in the ribbon will remain clicked.

To complete the next steps the PLC must be in Program Mode. Right-click the PLC node
in the tree view in the left pane and select Operating Mode > Program.

EI% NewProject

C B
™™ Data Type Change...
-5 Symbols Inzert Program L4
-~ 10 Table ¢
-[5] Settings || /% Work Orline
[ Memory ¢ BB 5t atior
{8 Error log ﬁ S
PLC Clack -
4 Memory | EBPLE Error Simulator
EI% Programs
B e =Py |
! o Monitoring 61D Debug
H £ Monitor
Memory Allocation 3 % R_
. = Run
—JF Function £ 2

@ validate Symbols(ALL)

Transfer
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Chapter I8l Omron PLC Setup for EtherNet/IP Operation

To register the I/O table, double-click IO Table and Unit Setup.

E% MewProject
EIﬁ MewPLC 1[CJ2M] Stop/Program Mode

Memory card

Error log

Select Options > Create.

T | PLC IO Table - NewPLC1
File Edit WView | Options Help

Transfer to PLC
EI @l&l—- Transfer from the PLC
bl -

Compare with FLC

[+l dag, [0000] R

Hiok: Stwap
Online Add Unit k
Rack/Slot Start Addresses

Click Yes at the 1/O table creation prompt. Click Yes at the Initialize CPU bus settings
prompt. Click Transfer at the transfer prompt. Click OK at the results prompt. The 10 table
will now be updated with the current PLC hardware settings.

JRI=TE

File Edit View Options Help
LI Sl3alw| ble]e| S|7| Elb ek ] s

ii Built-in Porthnner Board

- ﬂ [1525] CI2M-EIP21{Built In EtherNet/IP Port for C12M) {Unit ; 1)
- ﬂ [1900]Inner Board unmounted

=8 jj [0000] Main Rack

i~ 4l 00 [0000] CI1W-ID211(DC Input Unit)

i3] 01 [0001] C1IW-OC201(Relay Output Unit)

i 7] 02 [0002] Empty Slot

-4 03 [0002] Empty Slot

7] 04 [0002] Empty Slot

i 4] 05 [0002] Empty Slat

5l 05 [0002] Empty Slot

i 4] 07 [0002] Empty Slot

-5 08 [0002] Empty Slot

S 4] 08 [0002] Empty Slat

[ 4y [0002] Rack 01

-, [0002] Rack 02

[+ 4y [0002] Rack 03

|caam-cPuzL  [Program 4
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To edit the EtherNet/IP items and mapping, double-click the EtherNet/IP node.

E| 4 Built-in Port/Inner Board
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- ?' [1525] CI2M-EIPZ21(Built In EtherMet/IP Port for CI2M) (Unit : 1)
-# [1300]Inner Board unmounted
=-4&j [0000] Main Rack
L 00 [0000] CJIW-ID211(DC Input Unit)
Input the desired IP settings and then click Transfer [PC to Unit].
TCP/IP | Bthemet | FINS/UDP | FINS/TCP | FTP | Auto Adust Time | Status Area | SNMF | SNMP Trap |
- IP Address & Mt uss DNS
& Use the fallowing address " Use DNS
[Pt 182188 2 .18 Primary DNS Server D 0 0 0
Subnet Mask 285 . 260 . 285 . O iy NS S l—
DefautGateway | 0 . 0 . 0 . O Pt |
1 Get IP address from the BOOTF server
i BOOTP sefting s valid only fornexd unt | _|p Router Table
start (pawerreslmatit_m). :
?Aélfng?gsdiﬁgg;‘ﬂ”n,ie s IF Address | Gateway Address | Insert
aved as system setting in the unit.
Delete
[~ Broadcast
& Ml 1(4385D)
" A10(4.2850)
TransteriUnitto PC] || TransferPCto Urit] || compare Restart
Set Defautts oK Cancel

When prompted to transfer, click Yes. After the transfer prompt click Close. When
prompted to restart the unit click Yes. Once the unit resets, click OK at the prompt. Close
the 10 edit dialog.

Physically power down the unit and adjust the rotary switches to match the last octet of the
new IP address from above. Then power the unit back on.
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Set the CX-Programmer application to offline by selecting PLC > Work Offline or the
online icon in the ribbon.

In the CX-Programmer application, double-click the PLC node. In the Network Type menu,
select EtherNet/IP. Click Settings to the right of Network Type and enter the PLC’s new IP
address. Click the OK buttons to close the dialogs.

Cllalge x|
Device Man
’VINEWF'LEJ |
Device Typs
’V|E‘JZM x| Settings ‘
Metwork Type
IVIElherNal/\P x| Seftings.. ‘
Network Settings [EtherNet/IP] x|
Network |
Target PLC
& IP Address: 152 . 168 . 2

"Rsspunss Timeout {g) ‘

o
SYSMAC CSICJICPINS)

Set the CX-Programmer back to online. You will be prompted with a connection via
EtherNet/IP. Click Yes to complete the connection.

Double-click the 10 Table and Unit Setup node. Expand the Built-In Port/Inner Board
node. Right-click and select Start Special Application > Start with Settings Inherited.

Change Unit No
Unit Comment

Unit Setup
Save Parameters
Load Parameters

Start Special Application Start with Settings Inherited
Start Only

Unit Manufacturing information
Unit Error Log ]
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Setting Up an Omron PLC

- C
28
. . . . Q@
Select Network Configurator and click OK. Select port TCP:2 and click OK. Then click 20
OK for EtherNet/IP_1 connection. % 8
To install the EDS file, select EDS File > Install. Navigate to the EDS folder 8 o
- . . . . . ~
C:\Microscan\Vscape\Firmware\eds\VisionHAWK. Select the correct file and click a9
Open to load the file. All other EDS files can be downloaded from www.microscan.com. g z
x| ‘é g
Lookin: | ), EDS e T o
Mame = |v| Date modified |v| Type ;I
L | MarkHAWK eds 6/21/2013 2:52PM  EDS File
|| M5-Connect 210 (32-000012-01).eds 8/28/2013 4:12PM  EDS File
|| VisionHAWEK (32-000009-01).eds 8/23/2013 408 PM  EDS File
| | » -
File name: | Open J
Files of type: IEIec,trnnic: Data Sheet(”eds) j Cancel
Device Information
“endor: Microscan Systems Inc.
Device Twpe: Generic Device
4

Expand the left tree view to open the OMRON Corporation files. Locate CJ2M-EIP21 for
this example and drag it to the line in the right pane.

& untitled - Network Configurator

File Edit View MNetwork Device EDSFile Tools Option Help

|IDEH| 258|528y ¢S 4

* | () EtherNet/IP_1

@ Metwork. Canfiguratar

| v

EI@ EtherNet/IP Hardware
E|-- Yendor
[-{@} Grid Cornect a—
= Microzcan Systems Inc. S e
=& OMRON Carporation

Eﬁ Communications Adapte ﬂ—l—
- [&] CITw-EIP21

Rew 1 —
Rew 2

| CITwW-EIP21(CI2)

| CITwW/-EIP21(NJ)

| CIZB-EIP
2M-EIP21
| CS1w-EIP21
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Chapter I8l Omron PLC Setup for EtherNet/IP Operation

Expand the Vendor Collection node for the camera connected to the PLC and drag it to
the line in the right pane.

Right-click near the newly-added icons and select Change IP Address. Enter the IP
address for the PLC and the camera or reader attached and click OK.

@ Etherhiet/P_1 |

8 €

192.168.250.1 192.168.250.2
CI2M-EIP21 Microzcan Yisi..
o
Change IP Address =l

NewIPAddress:I 192 168 . 2 .16

[ o |

Carcel |

Double-click the PLC icon to edit the device parameters. This is where you will be linking
and mapping the EtherNet/IP assembly data to the internal memory of the PLC. Select the
Tag Sets tab. Select the In - Consume tab at the top. Click Edit Tags below. Then click
New to edit/create a new tag. In this example we are naming this tag 300 for the
peripheral memory linked to the input data. Select the size (320 bytes) for the entire input
assembly. Click Regist then Close to continue.

cditTagsets T
Tag Sets
| Edit Tags i |
b1 Consane | Ini - Cansume |
N
— Name [Over.| Se=| Bt
5,
Narme : I
Size | 2= e
I” Use Bit Dats
Bit Size : U_:| Bit
Wyerlload
’V £ Disablz % Enatle |
New.. | i [ New.. || Eat. | [ peme | i | | cotspse o
Usage Count : 0/32 oK. Eored] |
Total Size : 0/1280
OK Cancel
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Setting Up an Omron PLC

5 c
£
. ) o m
Select the Out - Produce tab and then click New. For the output assembly you are going 20
to map to peripheral memory address 500 with 320 bytes. Click Regist and then Close. % o
Click OK on the Edit Tags dialog. When prompted to register new tags click Yes. ) o
i Device Parameters- 192165 E a2
Connections 120 Sets | o+
5| -2
A |O“t" [ Tia- Camemie Dul—F’ruduce' O %
e e [ [over.| siel Bl ‘ég
.
Oow
(it Tag =
Name : 500
Size 3202 pye
™ UseBit Data
Bit Size U_,;‘ ait
Over Load
[ " Disabla ¥ Enable |
Clase
New | | Ecil| | Wew. | [Edi. | [Deke | b || Colepse i
BaTegr. [ = Uswelon 12 ok | o || TofomFie |
0K Cancel

Click the Connections tab on the Edit Device Parameters dialog. Click the download
button in the middle to register the device.
=

Connections |-rEig Sets |

- Unregister Device List
H [ Product Name |

Connections : 0/32(0:0.T:0) ILI

~ Register Device List
Product Name 192.168.2.16 CJ2M-EIP21 Variable Target Variable

Mew.. | | Edv. | peler || EdeaL Change Target Node ID... | Toffrom Fie |

0K Cancel
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Chapter I8l Omron PLC Setup for EtherNet/IP Operation

In the lower pane, double-click the PLC in the registered device list. This will open the
linking dialog. If there are multiple connection types, they can be selected from the
Connection I/0 Type menu. In the Originator Device section, select the Input Tag then
the Output Tag. Adjust the RPI if needed. When done, click Regist and then Close.

192.168.2.77 Microscan Vision HAWK Edit Connection x|

1t will add a connection canfiguration to criginator device.
Please configure the Tag Set each of aiiginator device and taiget device.

Connection /0 Type: |10320 |
-~ Originator Device - Target Device
Node address: 192168218 Mode dddiess 192168 277
Comment:  CJ2M-EIP21 Comment : Microscan Vision HEWK
Input Tag Set: g gy Tog ats Output Tag Set
0300 - [320Byte] ~ #> Input_102 - [320Byte] -

e T —

DU Ta0 S8l i T og Sets Input Tag Set
0500 - [320Bte] - ‘* Outpud_114 - [320Bste] -
c°””.?°“°'? Pairt to Point connection -
ype:

Hide Detail

[~ Detail Parameter

Packet Interval (FFT) 00 s (100 - 32000 ms)

>] Connection Name l—
Timeout Yalue : |Packet Interval (RP1 « 4 [Possible to omil

1~ Caninection Structur
# 192.168.2.16 CI2M-EIP21 =

The registered device will now display the tags that are linked. Click OK to continue.
=

Connections |-rEg Sets |

- Unregister Device List
3 | Product Name [

Connections : 2/32(0:2,T:0) | -

- Register Device List

Product Name 192 168 2.16 CJZW-EIP21 Vaioble___| Target Varzbis
defaut_007 npu] 0300 nput_101
defauk 001 [Dutput] 0500 Ouipt_198
New.. || Edt. || Delt || EaAL Change Target Nod ID... | To/frem Fle |

([ ok ]| cancel
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Setting Up an Omron PLC

Download the new tags and links to the PLC by selecting Device > Parameter > Download
or by clicking the download icon in the ribbon. Click Yes when prompted to download.

£ untitled - Network Configurator

File Edit View MNetwork (Device JEDSFile Tools Option Help

=10

D H| 28 & % tew < 8 Lala X[

ERETIEEIE OF

When the List of Devices That Are Executing dialog appears, select the PLC and click
Download after Changed to Program Mode. When prompted to return the state, click

Yes to continue.

List of Device that are executing x|

The following devices are not in program mode.

Froduct M ame Comment

Cl2M-EIP21

#
Fil152.168.2.16

( Diownload after changed to Program mode " Dovanload with Current mode | Cancel I

Select Network > Check Connection in the Network Configurator to ensure that there

are no connection problems.

AutoVISION and Visionscape Industrial Protocol User Manual
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Chapter I8l Omron PLC Setup for EtherNet/IP Operation
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srarrers . Using PROFINET 1/0

This section provides information necessary for using a Microscan smart
camera in a PROFINET I/O environment.

Notes:

¢ The camera communications protocol must be enabled for
PROFINET /O before it can be used in this environment. Refer to
Chapter 1, Enabling Industrial Protocols, for information about
enabling communications protocols for the camera, and information
about switching camera communications protocols.

* AutoVISION and FrontRunner jobs use Microscan Link functionality
to accommodate PROFINET I/O communications between the
camera and the PLC. For information about how to connect job
parameters and outputs to Microscan Link tags, refer to the Linking
Datums to Microscan Link Tags section of Chapter 2 in the
Visionscape FrontRunner User Manual.

Important: PROFINET I/O allows the IP address and subnet mask of
the camera to be assigned automatically by the PLC. In order to allow
this, the camera may not have an assigned IP address on reboot until
the PLC is set to Run mode. During this time, the camera will not be
visible on the network for AutoVISION or Visionscape FrontRunner.
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Chapter Using PROFINET I/O

PROFINET 1/O

PROFINET I/O Identity

Vendor ID

Microscan’s Vendor ID is 0x0257.

Device ID

Depends on the camera (MicroHAWK, for example).

Connection Properties: RT Cyclic Messaging

Odd slot numbers are input to the PLC, even slot numbers are output from the PLC.

Maximum data size in either direction is 518 bytes. The data size can be reduced by
removing slots that are not used.

Cycle update time: 16ms

Slot/Subslot Layout Descriptions
Slot | Dir | Bytes | Name Description

1 In 2 STATUS Status register of the camera, each bit of this register
represents adifferent state item. See Camera Status
Register for bit descriptions

3 In 2 ECHO This 16 bit word value reflects backto the PLC the
value thatthe PLC wrote to the output assembly ECHO
register. The PLC can verify the output assembly has
beenwritten to the camera when this value matches
the written value.

5 In 4 CmdCodeRslt | When Status.ExeCmdAck goes active in response to
Control.ExeCmd, CmdCodeRsht reflects the result of
the command invoked by Control.CmdCode. See
CmdCodeRsit for definitions.

7 In 4 CmdRet When Status.ExeCmdAck goes active in response to
Control.ExeCmd, CmdRet contains the datareturned
from the command invoked by Control.CmdCode. See
CmdRet for definitions.

9 In 2 State Device State register. Depending on the current state
of the camera, certain STATUS and CONTROLfeatures
may or may not be operational. See Statefor
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PROFINET 1/O

definitions.

Out

CONTROL

Control register of camera. Each bit of this register
represents adifferent status item. See Camera Contro!
Register for bit descriptions

Out

ECHO

This 16 bit value is reflected back to the PLC in the
input assembly ECHO register. The PLC can verify the
output assembly has beenwritten to the camera when
the input assembly matches this written value.

Out

CmdCode

Specifies the processinvokedinthe camerawhen
Control.ExeCmd goes active. See CmdCode for
definitions.

Out

CmdArg

Additional argument data for the CmdCode. See
CmdArg for definition.

11

VIO

Each bit reflects the state of a virtual 10 point. The
least significant bit reflects vio point 143, the most
significant bit vio point 160

10

QOut

VIO

Each bit reflects the state of a virtual 10 point. The
least significant bit reflects vio point 129, the most
significant bit is vio point 144

13

booll-64

Each bit represents a boolvalue. The least significant
bit of byte 0 reads the value of booll. The most
significant bit of byte 7 reads boolg4.

12

Out

Booll01-164

Each bit represents aboolvalue. The least significant
bit of byte 0 writes the value of booll01. The most
significant bit of byte 7 writes boollg4.

15

20

intl-10

Each pair of sequential bytes represents al6 bit signed
integervalue. The 20 bytesrepresent10integers.
From bytes 0-1 for the value of intl through bytes 18-
19 for the value of int10.

AutoVISION and Visionscape Industrial Protocol User Manual
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Chapter Using PROFINET I/O

14 | Out 20 int101-110 Each pair of sequential bytes represents al6 bit signed
integervalue. The 20 bytes represent10integers.
From bytes 0-1 to write the value of int101 through
bytes18-19 for the value of intl110.

17 In g4 | longl-16 Each group of 4 bytesrepresentsa 32 bit signed
integervalue. The 64 bytesrepresent16long integers.
From bytes 0-3 for the value of longl through bytes
60-63 forthe value of longl6.

16 | Out 64 | longlol-116 Each group of 4 bytesrepresents a 32 bit signed
integervalue. The 64 bytesrepresent16long integers.
From bytes 0-3 for the value of longl01 through bytes
60-63 forthe value of longlle.

19 In 96 | floatl-24 Each group of 4 bytesrepresentsa 32 bit signed
integervalue. The 96 bytes represent 24 long integers.
From byte offsets 0-1 for the value of floatl through
byte offsets 92-95 for the value of float24.

18 | Out 96 | floatl01l-124 Each group of 4 bytesrepresentsa 32 bit signed
integervalue. The 96 bytes represent 24 long integers.
From bytes 0-3 for the value of float101 through bytes
92-95 for the value of float124.

21 In 96 stringl These 96 bytes can store a string of up to 94, 8 bit
characters, with the first 2 bytes containing the
storage length and string length values.

20 | Out 96 stringl101 These 96 bytes can store a string of upto 94, 8 bit
characters, with the first 2 bytes containing the
storage length and string length values.

23 In 96 string2- & consecutive strings, each of 32 bytescan store a
string7 string of up to 30, 8 bit characters, with the first 2
bytes of each string group containing the storage
length and string length values.

22 | Out 96 | stringl02- 6 consecutive strings, each of 32 bytes can store a
stringl07 string of up to 30, 8 bit characters, with the first 2
bytes of each string group containing the storage
length and string length values.
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Slot Data Layout Diagrams

9
. —
Slot Data Layout Diagrams W
PLC Input PLC Output L
Slot Byte Offset|Data Slot Byte Offset|Data 8
1 0 STATUS 2 0 CONTROL o
3 0 EchoIn 4 0 Echo Out 2
5 ] CMD CODE RSLT 6 ] CMD CODE )
7 ] CMD RET 8 ] CMD ARG >
9 ] STATE
11 ] VIO 145.. 160 10 ] VIO 129.. 144
] bool 1.. 16 ] bool 101.. 116
13 2 bool 17.. 32 12 2 bool 117.. 132
4 bool 33.. 48 4 bool 133.. 148
o bool 45.. 64 ] bool 149.. 164
] intl 1] int 101
2 int2 2 int 102
4 int3 4 int 103
6 intd 6 int 104
15 8 ints 14 8 int 105
10 int6 10 int 106
12 int 7 12 int 107
14 int 8 14 int 108
16 int9 16 int 109
18 int 10 18 int 110
0 long 1 0 long 101
4 long 2 4 long 102
= long 3 8 long 103
12 long4 12 long 104
16 long 5 16 long 105
20 long & 20 long 106
24 long 7 24 long 107
17 28 long 8 16 28 long 108
32 long 9 32 long 109
36 long 10 36 long 110
a0 long 11 40 long 111
a4 long 12 44 long 112
13 long 13 48 long 113
52 long 14 52 long 114
56 long 15 56 long 115
60 long 16 60 long 116

AutoVISION and Visionscape Industrial Protocol User Manual 8-5



Chapter

Using PROFINET I/O

PLC Input PLC Output
slot  |Byte Offset|Data slot  |Byte Offset|Data
0 0
4 4
8 8
12 12
16 16
20 20
24 24
19 18

CEEREINEREZERCERERNER

BNEREINBRIIRNERESRR
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Slot Data Layout Diagrams

9
|_
PLC Input PLC Output '-%
Slot Byte Offset|Data Slot Byte Offset|Data E
0 94 0 94 ©)
1 <str1len> 1 <str 101 len> &:
21 2 string 1 20 2 string 101 @)
£
95 95 8
0 30 0 30
1 <str 2 len> 1 <str 102 len>
2 string 2 2 string 102
31 31
32 30 32 30
33 <str 3 len> 33 <str 103 len>
34 string 3 34 string 103
63 63
64 30 64 30
65 <str4 len= 65 <str 104 len=
23 66 string 4 22 66 string 104
95 95
96 30 96 30
37 <str 5 len> 97 <str 105 len>
98 string 5 98 string 105
127 127
160 30 160 30
161 <str 6 len> 161 <str 106 len>
162 string 6 162 string 106
191 151
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STEP 7 PLC Slot Layout

Slat B todule Order number | address [ addrezs Diagnostic address:
£ _% Yexsonrnf ok LMY -EERE Tans| ST
e Aewania SEREE
A7 A Fhw 7 SEEE

Statuz 10..11

2 Contral 0.1

K] Echoln 540,541

4 Echo Out 264 265

4] Crmd Code Rzl 532535

G Cmd Code 260 263

7 Crnd Ret 536,539

a Crd Arg 286,259

9 State a42

10 WIO Out 11.12

11 W0 In 12.13

12 Boolean Out 3.0

13 Boolean In 2.9

14 Int Olut 362,381

15 Int I 52,371

16 Long Out 382445

17 Long In a72. 435

18 Float Ot 266, 361

15 Float In 286,351

20 Long String Ot 445 54

21 Long String In 436...531

22 Shart String Out A4 733

23 Shart String In h43...734
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STEP 7 PLC Slot Layout

Status: Camera Status Register (16-bit)

Each bit of this register represents a signal that displays the camera’s operational status.
A high value of 1 indicates that the signal is active (true).

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
[ EXE RESET
DATA | INSP | INSP | TRIGGER | | | TRIGGER | ACQ EXP
VALID | 5TAT | BUSY ACK o {CEUHTERRGR READY | BUSY | BUSY ot
ACK ACK
L Inspection 1 All Inspections

Bit Name Description

0 ONLINE Inspections are running

1 EXP BUSY The camerais busy capturing an image. The camerashould notbe
triggered or the part underinspection moved during this time if
illuminated.

2 ACOBUSY The camerais busy acquiring an image. The camera cannot be triggered
while busy.

3 TRIGGER READY The camerais ready to be triggered. This is equivalentto ONLINE==1 and
ACQBUSY==0.

4 ERROR Anerrorhas occurred. Setthe RESET ERROR control bit high to clear.

5 RESET COUNTACK  This bit mirrors the RESET COUNT control bit. The PLC can be certain the
reset command was received by the camera when this goes high. The PLC
can then bring the RESET COUNT control signal back low.

7 EXECMD ACK This bit mirrors the EXE CMD control bit.

8 TRIGGERACK This bit mirrors the TRIGGER control bit.

9 INSP BUSY This bit is high wheninspection 1 is busy processingan image.

10 INSP STAT This bit represents the inspection 1 status result. It is 1 if the inspection
passes. Itis only valid when DataValid goes high.

11 DATAVALID This bit goes high when inspection 1 is complete. The PLC should clear this
signal by setting RESET DV high once it has read results.

AutoVISION and Visionscape Industrial Protocol User Manual 8-9
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Chapter Using PROFINET I/O

CmdCodeRslt (32-bit)

The value of CmdCodeRsilt is only valid when ExeCmdAck is active (1), in response to
ExeCmd being active.

CmdCodeRslt value Meaning
(base 16 hex)

0x0000_0000 Success
0x0100_0000 Fail.

Possible reasons:
Cameraunder PC control.
Job cannotbe changed.

0x0200_0000 Fail: Mo Job in slot.

0x0300_0000 Fail: Unknown cmd.

CmdRet (32-bit)

The value of CmdRet is only valid when ExeCmdAck is active (1), in response to
ExeCmd being active, and CmdCodeRsilt is 0 (Success). The following chart shows
which CmdCodes return data in the CmdRet register.

CmdRet Associated CmdCode Meaning
value
(32 bit)
0 Ox1000_0000 MNa
to

Ox1300_0000
(Job Change type)

1—-255 0x1800_0000 Active Job Slot #
(Query Active Job Slot)
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STEP 7 PLC Slot Layout

o
=
. —
State (16-bit) W
State reflects the following operational condition of the camera: %
State Meaning Typical action required by the client [PLC), or system &:
value operator o
=
(16 bit) 4
0 Offline Perform job change or put camera online.
1 Online Mormal runtime operation: Monitor TriggerReady and Datavalid

signals. Trigger the camera.

2 Changing If camera is under pc control:
Vision Job Wait until State changes to Offline or Online.

If PLC is controlling the job change:
Use ExeCmd, CmdCode, ExeCmdAck, and CmdCodeRslt to

complete the operation.

3 Booting® Wait for camera to transition to Online or Offline.
4 Empty (no Load a new job from AutoVISION or Front Runner.
Vision Job)

*Booting (3] State: This will rarely be seen by the PLC.
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Using PROFINET I/0

The value of State determines which Control and Status signals are available:

Control/Status
Signal

Control.GO OMLINE
“.GOOFFLINE
“.RESETERROR
“.RESET COUNT
“.EXECMD
“.TRIGGER
“.RESETDATA VALID
Status.ONLINE
“.ERROR
“.RESETCOUNT ACK
“.EXECMD ACK

Y EXP BUSY
“.ACQBUSY

. TRIGGER READY
“.TRIGGER ACK
“.INSP BUSY

“INSP STAT
“.DATAVALID

Where:

1]

(Offline)

¥ = Signal is valid for this State
Empty cell = Signal is notvalid forthis State

State

1 2 3 4

(Online) (lob (Booting) (Empty)
Change)

8-12
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STEP 7 PLC Slot Layout

15

14 13 12 11

10 9 8 7 6 5 4 3 2 1 o

|\.fl-4-4 v143\v142|vi41| v140 |v139v138 wv137 | v136 | v135 | v134 | w133 | v132 |v131| vi130 \.r129|

VIO Input Register Bits
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15

14 13 12

11 10 9 8 7 6 5 4 3 2 1 o

[v160 i vi59 {visB  viS7| viS6i viS5 viS41v153 | waS2 [ visl | w150 ! vi49 | v148 | v147 | v146 | vi4s |

Control: Camera Control Register (16-bit)

Each bit of this register controls a function on the camera. Transitions from a low state of 0
to a high state of 1 initiate the associated operation. The PLC should return the state of the
control bit back to 0 after it has acknowledged the camera has processed the control.
Unused bits should remain O.

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
o] e B RESET | RESET Go | 6o
s CMD COUNT| ERR _ OFFLINE | ONLINE

Inspection 1 All Inspections

Bit MName Description

0 GO ONLINE Startall inspections running

1 GO OFFLINE Stop all inspections

4 RESETERROR  ResetERRORin the Status register

5 RESET COUNT Resetallinspection counts

7 EXECMD Execute the command specified by Control.CmdCode

8 TRIGGER Trigger Inspection 1. The inspection must be configured for a triggered

image acquisition.
11 RESET DATA Reset the DataValid signal of the Status register
VALID
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CmdCode and CmdArg (32-bit)
Specifies the process invoked in the camera when Control.ExeCmd goes active.

List of Available CmdCodes and Associated CmdArg

CmdCode CmdArg Operations performed
value

0x1000_0000 lobSlot {1-255) Go Offline, Load job from specified slot

0x1100_0000 lobSlot {1-255) Go Offline, Load job from specified slot, Go Online

0x1200_0000 lobSlot {1-255) Go Offline, Load job from specified slot, Make it the boot job

0x1300_0000 lobSlot {1-255) Go Offline, Load job from specified slot, Make it the boot job, and Go Online

0x1800_0000 na Query active job slot. CmdRet will contain the active job slot number when the

operation is done.

CmdCode and ExeCmd Operation

QUT . Control CmdCode,
CmdArg, ExeCmd

IN.Status ExeCmdAck

OUT.Control. GoOffline
OUT.Cantrol.GoOnling
OUT Control ResetCount

OUT Control. Trigger
OUT Control ResetDataValid

IN_Status . DataValid

AN Status. Error

Event key: A B C. D. E. F.
A1 DataValid or Erfor ane prasent. clear tham,
Sal the following control signals idie, and keap them idie while the command is processed by the cameara:
GoOffline, GoOnline, Trigger, ReseiDataVvalid, ResetCount, ResetError,
I the command operalion s a job change, populale the oulpul tags requined 1o configure the new job (bool, inl. long, NMoal, string).
B. Populate CmdCode and CmdArg, then activate ExeCmd.
C. Camera executes the command (may take up 1o a minuta). While processing a Job Change command, State will be 2. Camera activales
ExeCmdAck when il is done processing the command.
D. Whaen the PLC sees an active ExeCmdAck, verify CmdCodeRsit s 0, and Error is 0, Process CmdRat if needed. then chear ExeCmd,
E. Camera clears ExeCmdack when ExeCmd goes inaclive. When ExeCmdAck goes inactive, CmdCodeRsit and CmdRel are no longer valid,
and it may take a few seconds for the camera State and Online signals to settle to a final value (typically Online or Offline).
F. Camera can now be put online and triggered.

Noltes:

sl = PLC program scan time

cf = Command processing time in the camera. May take up 1o a minute for some commands.

rpi = Requested Packe! Interval. Configurad in the plc's EIP module conneclion properties. Allowed rpi is 10 ms o 3.2 s
Al signals represent the stale of plc 1ags.
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@)

=

PROFINET I/O Control/Status Signal Operation E

: : : Z

Sean_ W I0_tsae LT Conln Tﬁli.‘ﬂl_l | | LL

_ add : : : 8
Tripgerkaacy, TAcqBuay

i-:agnq-.era:- - _ 1l | o

mi-d L o

IN.518%ue TriggerReady’ | ] cC

WAcqBusy (long axposure) :' V)

wid Lo D

Soan MY 10 inbemal SUT Comenl, Trigga — —,

IN.S2atue. Triggerack

InspBusy 1 .
(CAMmera) 1 i
f—r—|

1M S553%08 InspStatus : |

M Status Dasavaid : | T =

'|.m+++__4

[ Yr— AB CDE F =] H |

& O risng edge of system Tgger, the user app acivates Scan_ MY 10 user OUT Coniral. Trigger so npger the demo oodae

B Dero cnde detects nsing edge of Scan_ b I0_user OUT. Conirol. Tigger, and i the camera is reay, senos a migger s the camera
., Camera acquisition begins (may be delayed by one rpi)

D, i the camera's exposune ime is sharter than the rpi, no changa il be seen in TrigoerRoady and AcqBusy plo N Rgs

E Camera firmamen acks $w igger. The demo cooe: may not see e ack until san npi after the: migger was sent (avent B)

F. Desno pode detects Triggeniok and dears the Trigger.

G, Do code detect falling edoge of Triggendck and desrs the user Trigger.

H. Carnaera iramral signal Cotalid will go ligh when InspBusy goss o
L Fic lagic must delay ane rpi ime befans re-asseriing Resstaks\alid

OUT.Contral. Res et Ditatalid

Isles:

1. The chart shows the vearkings of the Trigger and RessdDatsvalid Cantral sigrals, and $he Triggenbok and Detatfalid Saius sgraks

2.5t = pha program =can Sme

. rpi = Requested Packet Interval Confipuned in the ple's EIP module connectian praperties. Alloved miis 10 ms o 3.2 5.

4. Al signalks represent the stale of plc bags, except whens nobed 25 “camera)”. The cam signals shoan are visible in the EIP imearfaos, but the
stae of tha pls tags and internal firmaane sprals will be different for s et one o o regueshsd packet inbereals (rpi)

5. The phs is rurning the demo code dstributed vith the camera. The derna code and user app wse theSzan MY K0 user bag ool as the
primeary cornol, stahus, and data rtedaces far the user app, All sigroel opersiors are sl ree even if the ple demo code & ot used.

. TriggerReacol AcoBusy : Camors exposune limes can range from less than 1 ms, up o 100 mes.
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CHAPTER 9 Demo PROFINET 1I/O PLC
Code

This section describes how to use Microscan demo PLC code with a
vision job and camera target.

Important: The examples in this section show the Vision HAWK Smart
Camera, but are also applicable to the MicroHAWK Smart Camera.

The PROFINET I/O demo files can be found where AutoVISION is
installed, in the folder C:\Microscan\Vscape\Tutorials and Samples\Vision
Hawk\PROFINET demo. Open PNIO_Demo.avp and
PNIO_demo_job2.avp with AutoVISION and download them to the camera.

Notes:

e The camera communications protocol must be enabled for
PROFINET I/O before it can be used in this environment. Refer to
Chapter 1, Enabling Industrial Protocols, for information about
enabling communications protocols for the camera, and information
about switching camera communications protocols.

¢ AutoVISION and FrontRunner jobs use Microscan Link functionality
to accommodate PROFINET I/O communications between the
camera and the PLC. For information about how to connect job
parameters and outputs to Microscan Link tags, refer to the Linking
Datums to Microscan Link Tags section of Chapter 2 in the
Visionscape FrontRunner User Manual.

Important: PROFINET 1/O allows the IP address and subnet mask of
the camera to be assigned automatically by the PLC. In order to allow
this, the camera may not have an assigned IP address on reboot until
the PLC is set to Run mode. During this time, the camera will not be
visible on the network for AutoVISION or Visionscape FrontRunner.
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Chapter

Overview

Demo PROFINET I/0O PLC Code

In this demonstration, you will learn how to load a saved job into the
camera, establish connectivity via PROFINET 1/O to a Siemens S7 PLC,
and run some example programs that interface with the camera.

While evaluating PROFINET 1/O capabilities, you will:
« Begin with AutoVISION.

Open a sample PNIO demo vision job in AutoVISION and use the Try Out
feature to learn what to expect from the camera before it is connected to
the PLC.

e Prepare the PLC.

Integrate the camera into the PLC environment with STEP 7 software and
the GSD file.

*  Run the camera.

Trigger the camera while it is online with the PLC and observe changes in
the Inspection status as the PLC reconfigures the vision job’s parameters.

9-2
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AutoVISION Setup

AutoVISION Setup

Prior to starting AutoVISION, make sure the camera is either connected
to the PLC or both PLC and camera are on the same physical network.
Ensure that the PC, PLC, and camera have the same network class and
corresponding subnet addresses.

o
m
2
50
& O
o
OO_
-
D)
A

Open AutoVISION and select the camera.

& | MICROSCAN

Select a device to start editing a job

From the Image view, click the Load a Job button. Then navigate to
\Microscan\Vscape\Tutorials And Samples\Vision Hawk\PROFINET
demo. Select PNIO_demo.avp.

|1 s o 2k

= o + s T b e+ . v+ ROPRE fem = & [ e o e i

Crgarser = Furw e ol i

an e 12
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Demo PROFINET I/O PLC Code

The demo job will include three tools: Measure, Decode, and Count Blobs.

Decoded

=

4 J| Count Blobs1

J

BR|IB8 8 RLSS

Each tool has data items linked to the PROFINET I/O structure as shown here.

Tool Result PLC/PNIOIN tag
Measurement Status “USER".Demo.MeasureStatus (DB101.DBX 1001)
Measurement “USER".Demo.ReadDistance (DB101.DBD 58)

Decode Status (matchcode)

“USER".Demo.DecodeStatus (DB101.DBX 100.2)

Decode

“USER".Demo.ReadString[32] (DB101.DBB 64-96)

CountBlob Status

“USER".Demo.CountBlobStatus (DB101.DBX 100.3)

CountBlob Count

“USER".Demo.ReadBlobCount (DB101.DBW 62)

Tool Parameter

PLC/PNIO OUT tag

Measurement Tolerance Low

“USER".Demo.MinDistance (DB101.DBD 46)

Measurement Tolerance High

“USER".Demo.MaxDistance (DB101.DBD 50}

Decode Matchcode

“USER".Demo.MatchCode [32] (DB101.DBB12-44)

CountBlob Lower Tolerance

“USER".Demo.MinBlobCount {DB101.DBW 54)

CountBlob Upper Tolerance

“USER".Demo.MaxBlobCount (DB101.DBW 56)

This data is transferred cyclically between the camera and PLC.

9-4
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AutoVISION Setup

Once the job has loaded, the next step is to link the pre-saved images on
the local PC. On the Camera button, click the far left icon to select and
load an image.

fe Hep 9 dEA A @
Connect Image

I VisionHaw J
t Edit mode
| I

()
©

o
o
O
-
o

Q
l_
L
<
u_
©)
X
o
o
S
Q
o

mera

A file browser will open. Then navigate to the same folder where the
demo job was loaded — PROFINET demo. If the images are located, the
icon will change from a camera to a folder.

By clicking the Try Job Once icon, the application will cycle through the
entire job with the loaded image.

O
2'8_11 :EH::J Pixels ‘\‘:/

8 bit Grayscale
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Chapter Demo PROFINET I/O PLC Code

There are two images on file. One will pass all three inspections and one will fail all three.
S @

Now click the Run button on the top ribbon. This will download the job to the camera.

At this point the job is ready to run and can be tested. However, in order to run the job
change demo this job needs to be loaded into Slot 1. Click back to the Edit view from the
top ribbon bar.

Click the slot icon and select Slot 1 or New Slot if no slots are currently in use.

Eﬂﬁ.u toVISION™: VisionHawk32C178 = C:\Microscan\Vscape\Tutorials And Samples!\Visi

Now the job and images will be saved to the flash memory of the camera.
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STEP 7 Setup

STEP 7 Setup

This section was created using Siemens STEP 7 software version 5.5 +
SP2 and an ET200S PLC, catalog number 6ES7 151-8AB01-0AB0, CPU
Version 3.2. It was tested with a 315-2 PN/DP PLC, catalog number
6ES7-315-2EH13-0AB0, CPU Version 2.6.

o
m
2
50
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o
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First launch the SIMATIC Manager from the desktop.

Create a new project from the menu item File > New. Select the project
location on disk then enter the name and click the OK button. In the
example below, the name is Start. Once the project is first created, you
will see the dialog. This dialog is the main entry point into the PLC
program and hardware settings.

(o] x|
Der | gt & 2R ) B 2 :'__f' i i | # I ¢ Mo Fiter >
Ep Stat B MFI)
Press F1 to get Help. s
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The PC may have multiple network cards so it's imperative to map the
correct one to the SIMATIC software. From the menu, select Options >
Set PG/PC Interface. This will open the Set PG/PC Interface dialog and
list the available network cards. On the Access Path tab select the NIC
card with (TCP/IP >) in the name.
[se Pt dnterdime 0 =]

Access Path | LLD® / DCF |

Aecas Port o e Mpphaaier

EET - T =

ewdard for STEF T)

iefae Fapmae Madgreet Lied

[FCPAP > ASCUAXEETTZA USE2 0L oA Prapes
[ TR -] Tugrowa

BRTCPAP - ASDLAXBETTIA USEC [
WTCRAP -2 i) P10 T £

I TCPAP - ASIH ANBITTIAL
By Parmestinn b o MINS CPy
with FCP/WF Presocel (RFC-10088

irterdace

Ak P St
| I |

In the SIMATIC Manager dialog, right-click and select Insert New Object.
This is where you will select the base station. For example, when

configuring an ET200-s, select SIMATIC 300 Station since it's based on
the 300 series CPU.

W) SIHATIC Hanager - [Start - C\Program Files\Siemens| Step? \s7proj|Start =181x]
B Fle Edt Insert PLC Wiew Optiors Window Help =@ x|
[Dic [BR & £ e | ||0 B 8o |- 5 8] < e Fter> =%

anm

[t e
Ac 3 SIMATIC 300 Staton

SIMATIC M Seation

SIMATIC FC Stabion

Qher SERBON

SIMATIC 55

PGIPC

L

[PROFIBUS
Industrial Ethamet
FTP

Foundation Fieldbus

57 Program

Object Properties.... Alt+fletum

Irserts the cbject to be selectad at the cursor position,
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= B Sl EOE A )

After the station has been added, right-click and add Industrial Ethernet. o
Aep?|s7pro) =101 x| O
&ma&:m:ncmmmm == x| 8
D8P3 & R da[o By %0 B AR 60 |[<tores =% O

-

(Al

Q
|_
L
<
u_
©)
X
o
o
S
Q
o

SIMATIC 400 Saabion
SIMATIC 300 S2abion
SIMATIC H Station
SIMATIC PC Station
Cther Stabon
SIMATIC 55

PGIPC

PROFIBUS

Industrial Ethermet

Inzerts Incustrial EShwrnet at the oursor pasibon., P

Expand the Start tree node on the left pane and click the station. On the
right pane you will see a Hardware icon.
I/ SIMATIC Manager - {—".-..' Prog:

Ep Fle Edt Insert U W He

|0 |89 87| ¥ F" n‘l C 2- &y
Shart Hardware
] SIMATIC 300(1)
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Chapter Demo PROFINET I/O PLC Code

Double-click the Hardware icon to launch the HW Config dialog.

me_t T
b AL e e T

CE- RS - del DR W
=

s s POCE3 33
P

ssUULUEFEESES
g J!E
3

EEEEEEEEE EEEEREEEEEEERHEHE
idddddaddiddddddadAA0FFHY

o Vit e

Make sure the Catalog is selected in the ribbon bar on the top. This will
add a tree view on the right pane with all the available hardware devices.

D_—'l' HW Config - [SIMATIC 300(1) (Configuration) -- Start]|

Al station Edii Insert PLC  Wiew Options window  He

D=&-= 5’%|%||E||ﬁmm_§!

If the latest GSDML file hasn’t been imported, follow the next steps to
import.

GSDML

e Install the GSD file from the menu item Options > Install GSD File.

*  Click the Browse button to locate the GSDML file
\Microscan\Vscape\Firmware\gsd\visionhawk.

9-10
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GEDMLAE 510N 3w EASEIII 1200004 W25
GSDMLAR 3280 el IBOTETII 1200004 W23 Eragieih
GEOMLAR 3N AT enl DRI Z000AN W23

9
* The center pane will list the available GSDML files. E o
install SO Fles = =T
Inukall G50 Filea [t then ittt iony = LOL @)
|ENsa GEDHL Brwie xo
o -
Fie: | Fledeaa |'\'m-q:n | Laruquinge | (@] o
£
[}
(m)

| ShowLog Sistect 4 rapskect 0

Clopa Mg :|

* Select the file and click the Install button.
« When finished, close the dialog.

¢ The Vision HAWK camera should now be present in the PROFINET
I/0O section as shown below.

Suchans | ntim
Profle |5 1andard |

+ PROFIBLS DP
PROFIBLS-PA,
= 4 PROFINET 10
=] Auddboral Freld Devicss
=1 () Geneal
= ] Mensdcan

-

Boodean in
fradean (ut
Conbiol

Flioad I

Pl Diuk

IntIn

T

Lorsg In

Lorg Ot

Lomg Sing In
Larsg S Dt
Shot Sting Ini
Skt Sirieg Ot
Shahg

WO Inu

W0 Out
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Add the CPU from the catalog view by drag and drop or double-click.
Make sure the catalog number and version matches the PLC exactly. The
catalog number will be displayed on the bottom of the view.

IM151-3PN STWV7.0
] IM151-8 PN/DR CRU
| IM151-8 PNJOP CPU V3.2
& IM151-6F PN/DP CPU
| IM151-8F PN/DP CPU V3.2
#-] SIMATIC PC-CP
#-] SIMATIC 5T-CP =
¥-_] Metwork Components
#1-_] Preconfigured Stations
#1-1 Sensars =

)

i

Some CPUs are modules that will require a generic rack to be added
prior. If your PLC requires a rack, you will be prompted to add the rack
prior to being allowed to insert the CPU module.

After the CPU is added, a popup dialog will prompt the Properties relating
to the IP information.
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Select Ethernet(1) on the bottom list box and enter the correct IP address
of the CPU.
Properties - Ethernet interf x|

()
©

o
o
O
-
o

F & subnet is selecied,
thia nest avadable addressas ane suggesiad.

Q
l_
L
<
u_
©)
X
o
o
S
Q
o

Galeway

IP address: [192168.210 &
* Donot uss router
Subret mask: 255.255.295.0
" Use router
I™ Use dfferent method to obtain IP address addess: [

Subnaed

== it metworked — MNew.,

ok | Concd |  Hep |

Once the CPU has been added, add any additional expansion modules, if
installed. Click the CPU on the left pane and the bottom pane will list the
available ports and slots.?
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Add the camera in the location (PROFINET I/O > Additional Field
Devices > General > Microscan). The camera can be added by drag
and drop to Ethernet(1): PROFINET-I/O System (100) or by selecting the
Ethernet(1) line first and double-clicking the camera. Once the camera
has been added the icon will appear on the configuration dialog.

T SIAATICS0001) (Conberaion)—Star

Ethemet{1}. FROFINET-K0-System {100}

1 =
F] CPU 315-2 PN/DP %
Xt MALTDE _

| x PV
X2P1 Por 1
3
[
= =}

Once the camera has been added, double-click the icon to open the
properties dialog. Under the device name, enter the existing name of the
camera or a unique name.

Propertses - VissonHAWE : _ﬂ
Genesal |
Shoet dascriplion: VsorHAWK
El
Oeder Mo/ lemwrnen:  GNVGE00- boces
Famiy Mecroscan
— &
G0 fle: GEDML-V23-Miceoscan-Vison Mawk-200 30E 1 1 xmi

Changes Relsass Numtssr

Hede in PROFINET 10 System
Davice rusber: [1 ﬂ [PROFINET-10-Systerm (100)

P godeesa; 19216802 Efvarrat.

¥ Assicn |P adcress wia 10 controder

Commant
=
|
m{l Cancel =
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9

Q
If a unique name is used, the device has to be manually updated. View E o
Updating camera name section. Z 8
LL
Click the camera icon and the data slot address mapping will be displayed 8 8
below. Take note of the address values since they will be needed in the a4
demo application. Since there is an infinite combination of modules and ol
slot configurations, the addressing is unique to every setup. %
A SIMATIC 300(1) (Cc o
fem (100
1 -]
2 IM151-8 PNDP CPU~ —]
X7 PN E{'I}VISJ'OHH.‘
XIPIR Port T y
X1P2ZR Poit 2 '+
X1P3 Port 3
X2
5 hd

al I

ﬂﬂ (1] VisionHAMWE3201 7

Slot| [ Module Order number | address 3 address Diagnostic address:
X7 A dwesiace SR
KA Ao 7 SHERT
1 ] ] Status 2.4

2 [ contral 8.9

3| 4 Echoln 540,541

4 | ] EchoOut 264...265

5 | [ Crnd Code Rislt 532..535

6 | ] Crmd Code 260.. 263

7 [ Crod Ret B3E..539

8 | ] Crd &g 256259

9 | ] State B4z

10| 4 w0 Out 10..11

1 q w0 n 10,11

12 | [§ Boolean Out 0.7

13 | ] EBooleanIn 0.7

14 | q It Out 362381

15 | d Intln 352..371

16 [[§ LongOut 382,445

17| ] Longln 372,438

18 | [ Float Out 266361

19 | d Floatin 256...351

20 [ [§ Long Sting Out 446, 541

21 | ] Long StingIn 43E6..531

22 | [§ Short String Out 542733

23 | ] Short Sting In B43..734

24
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Chapter Demo PROFINET I/O PLC Code

Once the hardware configuration has been completed, it's time to compile
and download. Click the compile and save icon on the ribbon. If there are
any configuration conflicts, the application will prompt a warning at this point.

[1i3 HW Config - SIMATIC 300(1)

Stakion Edit  Insert PLC  Wiew Options ‘Window Help

0z22@)a & e d@a DD %2

Once compiled, click the download icon on the ribbon to send the
information to the PLC.

[li HW Config - STMATIC 300(1)

Station  Edit  Imsert PLC  Wiew Options  Window  Help

=2 - = R e = AT

At this point close or minimize the HW Config dialog and re-visit the
SIMATIC Manager dialog. The CPU should be added next to the
Hardware icon and in the tree view in the left pane. Expand the CPU tree
item and remaining child items below it.

I} SIMATIC Manager - Start
File Edt Insert PFLC Veew Options ‘Window Help

D 82| % e del[o %) %> =m 0[N

= [l SIMATIC 300(1)
=-[§ cPuIS2ZPN/DP

{8 57 Program{s)
(3] Sources
(f} Blocks
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Click the Blocks node to view the program objects.
E—r":..'.’ ;.'Ejﬂ

= B Gt [ Stiere dala i De
= [l SBAATIC W

= [l oPu NS PTR

=1 {Ei) 57 ProgeesiS]

B Soscer
o Bk

o
m
2
50
& O
o
OG_
-
D)
A

Updating Camera Name

From the HW Config dialog open Edit Ethernet Node from the menu item PLC >
Ethernet > Edit Ethernet Node. From the SIMATIC Manager dialog open Edit Ethernet
Node from the menu item PLC > Edit Ethernet Node.

Click the Browse button to open the node selection dialog.
e -l EI

— Ethernet node

kAT addreszs:

—Set IP configuration

' |z |P parameters

[3 ateway

P address:
I * Do not use router

AutoVISION and Visionscape Industrial Protocol User Manual 9-17



Chapter Demo PROFINET 1/0 PLC Code

Select the camera and click the OK button.

[Browse Metwork-2Hodes ]
St | | | IP addmis WAL aichett i byrse | Mo
-3 I001-P8  Miciacsn  waionhas
| (A1 F5F:] O310-18-2H48.00  ETXE U prs
= Fat semch
4| | |
Flash I MAL michess [EEGEOE
O, Corcnl Help |

Edit the Device Name, if necessary, to match the name entered previously
in the Vision HAWK properties dialog, and click the Assign Name button.

—Assign device name
N G )
e

Importing Example Program

From the SIMATIC Manager, open the example program from the menu
File > Open. Click the Browse button to locate the (AVDemo) program.
The AvDemo is located in \Microscan\Vscape\Tutorials and
Samples\Vision HAWK\PROFINET Demo.
s =]

Fired irs checiory Fizurel Selected
||:-..,..-¢1-.5159.'\';.m..3¢ Uset progeciz 1 1
Libwarms:
I Fanple promcly
™= =] Mdgoapcts
Wirioe Uhser poaects |Lhnnauj Sampla progects | Mulliprogets |
Wik
i Hame [ Steeagn po
HHHEWE ErMeonDen  CAWASTEPTWiinle
STEPT
£
3 St
g tex
viarie] ||
- VimonTe
i b VH GS0ML -4
4 "
4 | X
B S|
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Split both example and current projects in the dialog as shown.

al Il i i@ﬂ
Ok [BP | & Bl e |/o S5 %05 < Mo Fiter > % e BEMDM
T Stk AW \STEP\SIA o 0l
= E Sl |29 System data = = 5 WisiorDiatmo |4 5patem data o 081
= [l SmariC 3001) = @ SIMATIC 3000 o FB1 @ FBZ
= [ crums2 F"'?_P = @ MiSLEPNOPCRU | FB3 o FBs
= 57 ProgrendS) = (i) 57Progamlll | FBS o Fe
L) Souce @] Soweer |y pe2 oFe
T Blocks ol Blocks o Fed oFs
o FC20 @081
o 082 o 03
4 DB 3 DBS
o Da2 o DE
o 0822 o D810
i DB o De
. UDTY @ UnT2
(o UDT3 £ UDT4
WA VAT 1 &3 5FEO
g SFC20
L — L1
Priess F1 to oet Help, TOP{IP - ASIX ANSST7ZA USE2Z.0 L., 5

Select the objects minus the System data object and copy with right-click > copy or
CTRL+C. Paste into current project with right-click > past or CTRL+V. When prompted
that OB1 already exists, click the Yes button to overwrite it. Now the example program is
imported to the current project.

Select the Blocks icon on the left pane. Then click the download button on the top ribbon.
This will download the new copied functions and system data to the PLC. Now it's time to
update the new addressing from the hardware installation prior. Double-click the OB1
block to open the LAD/STL/FBD editor. OBL1 is the main routine of the PLC program.

K] SIMATIC Manager - test

File Edit Insert PLC '-.-'iew|0|:util:nns Window  Help

D |8 a| % Be(dn)o % %[

i FEB1

o FC1
o FC3
o FC5

B e e
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Chapter Demo PROFINET 1/0 PLC Code

Scroll down to Network 4. This is where the data is mapped from the camera to the local
data structure. FC3 is a function that pushes the input data from the camera to the
program structure. Click the numbers to match the address on the hardware as shown.
Click the following buttons on the popup dialogs:

Download (204:5) x|
Check the sequence of the blocks that is required far the
l 5 comect function.
Insert Function Block ]
l " IThe object FE1' already evists. Do pou want to avenwite it?

Bename... |

Yes All | Na MHone Cancel Help
e/

l Do pou want to load the system data?
Y

Yes No |

S

[0 pou want to delete the spstem data on the module
' 3 [0/220] IM151-8 PM/DP CPU completely and replace
a them with offling apstem data?

™ Do not display this message again.

‘Yes | Mo Cancel | Help

xq

The module iz in the RUM mode.
I Themodule will be set to STOF.

| akK | Cancel | Help

_

Download (13:4363)

The module [0/2/0] IM151-8 PN/DP CPU iz in the STOP

l i made
- [ro pou want to start the module now [complete restart]?

| Yeg | Mo
| —
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9

@)
=
Note: This is the address mapping view of the Vision HAWK module which is derived from W g
the hardware config view. Refer to page 9-10 for details on displaying the hardware config Z 8
view. Refer to page 9-15 for details on displaying Vision HAWK address mapping. LOL O
m: Update PROFINET Input data block from dewvice Q: O
match address assigned from Step 7 on hardware dialog % i
S
Slot| [d  Module Order number | address O address Diagnos... &
o K7 | dwsince e
"DNIQ_INDUT_DATA A7l A SR
= O —————|1 [|f Stews 10..11
- e 2 |4 Contral 0.1
STATUS | |3 [ Echoin 540541
sandzcHp —m | 4 []q EchoDut 264,265
| —||5_[[§ CmdCodeRslt 532..535
CMDCODERS s | & [| CmdCode 260...263
532 LT . — 7 || cmdRet 536..539
L e — 8 |[d Cmdag 256..259
536 —{CMDRET I 5[] st 1z
ez JsTarE — | 10 [[§ w10 Out 11..12
— T | IS 12.13
1zviomn — | 12 ||] Boolean Out 3.10
| (|13 [[] Bodleanln 2.9
z -{BOOLS ———— | 14 |[§ IntOut 362...361
N 15 |[{ Intin 352371
852 INTS 76 || LongOut 362445
272 | owes 17 |4 Longln 372..435
18 | Float Out 266...361
256 —{FLOATS 19 |4 Flaatin 256...351
20 | 4 Long Sting Dut 446,541
438 —|LSTRING 21 |4 LongShingIn 43F..531
_ 22 | [d Short Sting Dut h42 733
543 |SSTRINE 23 |[{ ShotStinaln 543 734
24

Repeat the same steps for Network 5 to update the output data mapping. Keep in mind
that all input addresses are under the (I address) column and the output addresses are
under the (Q address) column. Save to the PC and download to the PLC.

Do a master reset and set the PLC to RUN mode. Make sure all LEDs indicate good.
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Running the Demo

In the SIMATIC Manager dialog, double-click the VAT_1 icon. This will
open the variable table dialog for the data type demo. Maximize the
internal dialog to increase the viewing area.

= var - [VAT_1 -+ Skart\STMATIC 300(1)\CPU 315-2 PR/DFYS]

B Tebe Ede Insert PLC Warishle View Oplions Window Help ]
ﬂDlﬁﬂﬂi%ﬂl“l'—'ﬂ‘li ﬂl

Soler| x| |4 ol

|| Address Symiel [ Dimplay tormat | Status waiue | Modity value|
i De101.0awW 0 “USER™.Demo. Demo TrigType DEC

'?_ oa101 oaw 2 USER™ Demo. Demold ode DEC 1
[3] |oeioioex 40 USER DemoClearCounters BOOL

la | |DE101DEW &  USER DemoCounrecstons DEC

5| |oBioioew & | USER"DemnCourtPass DEC

6] oetoicew 10 | USER" Demo Counral DEC

[T | |oB101080 45 USER"DemoMrDatsce FLOATNG_PONT

8| (08101080 S0 USER DemoMaxDsbance FLOATING_PORT

|8 | |De1iDEew S4  USER DemoMnEkaCount DEC

'ﬁ IE}EII:II DEW S5  “USER" Demo. WaxBobCount DEC

[11] |oe110eD %8 USER DemoResditance FLOATING_PONT

[12] |oEi0108wW &2 USER Demo ResdlicbCount DEc

[13] |oEt010ew S8 USER DemoResdBooli_16 DEC

[18] | 08101.08x 1000 “USER" Demo BigEndian BOOL

'1__5 | DB10Z0EX 242 “PROG" ProgramJobPass BOOL

16] |oE10zZ0EW 26 | PROGT ProgramActvelob DEC

=

'I_B- IL‘E1I:I] DEwW 0 PR Program CurentStabe DEC

18] |oetozoex 200 PROGT Program Ststus_ONLINE BOOL

E .EE O BEN S0 1 | PR B Eantus EXP BUSY BOGL

To establish a live connection to the PLC, click the Monitor Variable
button on the ribbon. This will update data from the PLC to the dialog. The
top title bar will go blue and the bottom status will show run with a green

progress bar.

|£IU’H—|EAT 1 -- @VisionDe|

M2 Table Edit Insert PLC ¥
#| Dl=ld| 8] &
e Jon| 64| o

9-22
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O

There are two demo modes in this example. The modes are set in
“USER”.Demo.DemoMode (DB101.DBW 2).

0 = AutoVISION Test

()
©

o
o
O
-
o

1 =Job Change Test

The AutoVISION Test will demonstrate communications between the PLC and the current
job loaded from AutoVISION.

Q
|_
L
<
u_
©)
X
o
o
S
Q
o

If 0 doesn't appear under the Status Value column, right-click in the
"USER".Demo.DemoMode row under the Modify Value column. Select Modify or type
CTRL+F9 to change the value.

Address [ 5ymoa | Dmpiay format | Status vaise | adodity vans] :‘-
DB1GTOBN O  -USER" Dwmo DemoTrgTyps DEC [

DB1O10EW 2 “USER" Demo Demclode DEC 1 1

DB101 0B 40  “USER" Dem ClearCounters BOOL B fase o Munitos Crl+ET
DE1GIDEY &  “USER" Demo CountExecutions DEC 53 Moty Crl+F%
DB1G1OBW & | -USER" Demo CountPass pEC n .

DB1G1.0BW 10 | “USER" Demo CountFai e F Acata Mok Valim Fs
DB1010B0 48  “USER" Demo MinDistance FLOATING_PONT | 100.0

DB1G10B0 50 -USER" Dems MadDatance FLOATING_PONT | 2000 Hiocify Address to 1 Cul+l
DB1010BW %4 | “USER" Demo MinBiobCount peC 4 ogkfyy Address ko 0 Ll
DB1G1OBN 46 | “USER Demo MaxBiobCount e 4 Cut Cxl
DB101 080 S8 | -USER" Dem AeadDistance FLOATNG_PONT | 0.0 Copy cul+C

If 0 is not entered in the Status Value column of the “USER.Demo.DemaoTrigType” row,
enter O.

To start triggering the Vision HAWK program, right-click inside the Status Value column of
the “USER.Demo.DemoTrigType” (DB101.DBW 0) row.

Change the value from 0 to 1 to begin triggering and running the job on the camera.
Address Symbol Dizplay format Status value |Mndifyvalue| ;I
| - I

DB101.0BW 0 "USER".Demo.DemoTrigType
DB101.0BW 2 "USER".Demo.DemoMode
DB101.0BX 4.0 :"USER".Demo.ClearCounters

Monitor

DB101.DBW & .Demo.CountPass
DB101.0BW 10

DB101.DBD 46 i FLOATING_POINT 100.0
..................................... = e Modify Address to 1

Update Monitor Values
"USER".Demo.CountFail DEC o Activate Modify Value

DBA01.08D FLOATING_PONT.  200.0 el ag
DB101.DBW 54 DEC 1

DBA101.DBW DEC Fl cut

DB101.DBD FLOATING_POINT  173.0306 Copy

e Sl e e e M

DB101.DBX 100.1 “USER"Demo MeasureStatus BOOL e

DB101.DBX 100.2 "USER".Demo.DecodeStatus BOOL

DB101.0BX 1003 “USER"Demo.CountBlobStatus BOOL LR
e, e ModifyfForce Value As Comment

Row Mot Effective
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When the program is triggering the camera, each cycle will produce either a pass or fail all
state. Each state is counted in “USER”.Demo.CountPass:

DB10M1.DBD 58 "USER".Demo.ReadDistance FLOATING_POINT 173.0306
DB10M DBW 62 ("USER"Demo.ReadBlobCount DEC

DB101.DBX 100.1 "USER".Demo MeasureStatus BOOL

0B101.D0BX 100.2 i "USER".Demo.DecodeStatus BOOL

0B101.0BX 100.3  "USER".Demo.CountBlobStatus BOOL

DB102.DBX 242 ("PROG" Program.JobPass BOOL

and “USER”.Demo.CountFail:

DB101.0BD S8 :"USER".Demo.ReadDistance FLOATING_PQINT 59.407
DB101.0BW &2 :"USER".Demo.ReadBlobCount DEC
DB101.0BX 100.1:"USER".Demo. MeasureStatus BOOL
DB101.0BX 100.2:"USER".Demo.DecodeStatus BOOL
DB101.0BX 100.3:"USER".Demo.CountBlobStatus BOOL
DB102.0BX 242 {"PROG".Program.JobPass BOOL

These counters can be cleared by right-clicking the row “USER”.Demo.ClearCounters
and selecting Modify Address to 1.

DBE101.0BX 4.0 :"USER".Demo.ClearCounters BOOL E.false
DB1010BW &  “USER" Demo.CountExecutions DEC 04
DB101.DBW & "USER"Demo.CountPass DEC 52
DB101.0BW 10 | "USER".Demo.CountFail DEC 49

The tolerances are below the counters. The inspection values and status bits are below
the tolerances.

DB101.0BD 46 :"USER".Demo.MinDistance FLOATING_POINT 100.0
DB101.0BD 50 :"USER".Demo.MaxDistance FLOATING_POINT 200.0
DB101.0BW 54 :"USER".Demo.MinBlobCount DEC 4
DB101.0BW 56 :"USER".Demo.MaxBlobCount DEC 4

In some instances a large job could take longer to load. Increment the delay time to adjust for
job size. The image below shows Function Block 4, Network 6, where the delay is located.
A - 5= watT JoB cHaNcE

This delay is for the new job to load, 7-10 seconds based on size of job in
flash

CMP =| 5_0DT MOVE
5 Q EN ENO
3—INl v BI— 4—IN

#testState — BCD. ..

gtestState —|INZ "PROG".
Program.
CurrentSta

CUT -te
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To run the Job Change Test you first need to use AutoVISION to download another job to
slot 2 on the camera. In AutoVISION, connect to the camera and select the Connect icon
at the top of the user interface. Click the Load a Job icon. Locate PNIO_demo_job2.avp
and click the Open button. Once the job has loaded into AutoVISION, click the Edit button
at the top of the user interface. Then click Save the Job to a Slot on the camera icon in

the menu at the top of the user interface. Select New Slot, which should be 2. When switching
between tests, disable the current routine by setting the "USER".Demo.DemoTrigType to 0.

Now there should be two jobs loaded in the camera’s flash memory. Using the SIMATIC
Manager, open VAT _1. Click the Monitor Variable icon. On the row
"USER".Demo.DemoMode, right-click and modify to one. Right-click the row
"USER".Demo.DemoTrigType and Modify Address to 1 to start the demo. AutoVISION
should be closed for this demo to work.

This demo will cycle through loading jobs from slots 1, 2, and 3. Each cycle will be counted
in the variable table "USER".Demo.CountExecutions. The job load success is
determined by the camera’s status register "PNIO.Input.CmdCodeRsIt" = 0x0. If the job
load is successful the counter "USER".Demo.CountPass will increment. If the job load
fails when "PNIO".Input.CmdCodeRsilt ! = 0x0, then the counter
"USER".Demo.CountFail will increment.

OB calls FB1 to process the AutoVISION test. To view the ladder logic, select FB1, right-click, and
select Called Block > Open. Then select the main menu item Open ONLINE to view processes.

Network 2 : Process AutoVISION Demo based on USER.Demo.DemoMode = 0

[Comment - ‘
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aarero . Demo PROFINET 1/0O PLC
Code for MicroHAWK

This section describes how to use Microscan demo PLC code with a
vision job and camera target. The PROFINET I/O demo files can be found
where AutoVISION is installed, in the folder:
Samples\MicroHawk\PROFINET demo. Open PNIO_Demo.avp and
PNIO_demo_job2.avp with AutoVISION and download them to the
camera.

Notes:

e The camera communications protocol must be enabled for
PROFINET I/O before it can be used in this environment. Refer to
Chapter 1, Enabling Industrial Protocols, for information about
enabling and switching communications protocols.

¢ AutoVISION and FrontRunner jobs use Microscan Link functionality
to accommodate PROFINET I/O communications between the
camera and the PLC. For information about how to connect job
parameters and outputs to Microscan Link tags, refer to the Linking
Datums to Microscan Link Tags section of Chapter 2 in the
Visionscape FrontRunner User Manual.
Important: PROFINET I/O allows the IP address and subnet mask of
the MicroHAWK to be assigned automatically by the PLC. In order to
allow this, the MicroHAWK may not have an assigned IP address on
reboot until the PLC is set to Run mode. During this time, the
MicroHAWK will not be visible on the network for AutoVISION or
Visionscape FrontRunner.
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i8] Demo PROFINET I/O PLC Code for MicroHAWK

In this demonstration, you will learn how to load a saved job into the
camera, establish connectivity via PROFINET I/O to a Siemens ET200SP
CPU PLC, and run some example programs that interface with the
camera. While evaluating PROFINET 1/O capabilities, you will:

¢ Begin with AutoVISION.

Open a sample PNIO demo vision job in AutoVISION and use the Try Out
feature to learn what to expect from the camera before it is connected to
the PLC.

¢ Prepare the PLC.

Integrate the camera into the PLC environment with TIA Portal software
and the GSD file.

*  Run the camera.

Trigger the camera while it is online with the PLC and observe changes in
the Inspection status as the PLC reconfigures the vision job’s parameters.
Prior to starting AutoVISION, make sure the camera is either connected
to the PLC or both PLC and camera are on the same physical network.
Ensure that the PC, PLC, and camera have the same network class and
corresponding subnet addresses.

Open AutoVISION and select the camera.

=1
a B i

Coere] w

8= MICROSCAN|

@ ViskenHawh 1ICITE

Select a device to start editing a job

10-2
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From the Image view, click the Load a Job button. Then navigate to
\Microscan\Vscape\Tutorials And Samples\MicroHawk\PROFINET
demo. Select PNIO_demo.avp.

P — -

— s T * ) [ e v

S TR ¢ TR ¢ A L

g * s S - ]
—

The demo job will include three tools: Measure, Decode, and Count Blobs.

Measure1 =

—

‘ﬁ“' Decode1

Y

cmBlohi‘l

8

RERVIERR R
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Chapter

Each tool has data items linked to the PROFINET I/O structure as shown here:

i8] Demo PROFINET I/O PLC Code for MicroHAWK

Tool Result PLC/PNIOIN tag
Measurement Status “USER”.Demo.MeasureStatus (DB101.DBX1001)
Measurement “USER".Demo.ReadDistance (DB101.DBD 58)

Decode Status (matchcode)

“USER”.Demo.DecodeStatus (DB101.DBX 100.2)

Decode

“USER”.Demo.ReadString[32] (DB101.DBB 64-96)

Count Blob Status

“USER"”.Demo.CountBlobStatus (DB101.DBX 100.3)

Count Blob Count

“USER”.Demo.ReadBlobCount (DB101.DBW 62)

Tool Parameter

PLC/PNIO OUT tag

Measurement Tolerance Low

“USER”.Demo.MinDistance (DB101.DBD 46)

Measurement Tolerance High

“USER”.Demo.MaxDistance (DB101.DBD 50)

Decode Matchcode

“USER".Demo.MatchCode [32] (DB101.DBB12-44)

Count Blob Lower Tolerance
Count Blob UpperTolerance

“USER”.Demo.MinBlobCount (DB101.DBW 54)
“USER".Demo.MaxBlobCount (DB101.DBW 56)

This data is transferred cyclically between the camera and PLC.

Once the job has loaded, the next step is to link the pre-saved images on
the local PC. On the Camera button, click the far left icon to select and
load an image.

Fle Help ?JBE‘
E Image

hgm"-j v

v 2

10-4 AutoVISION and Visionscape Industrial Protocol User Manual



=
o

Overview

A file browser will open. Then navigate to the same folder where the
demo job was loaded PROFINET 1I/O Demo. If the images are located,
the icon will change from a camera to a folder.

v Py

o
l—L
wo
Z o
28
s
oo

!
ea
o
(@)

By clicking the Try Job Once icon, the application will cycle through the
entire job with the loaded image.

280 l'. Pixels V

3 bit Grayscale

There are two images on file. One will pass all three inspections and one
will fail all three.

:

L d
@
4
Decodet e
LABEL CHECK &
&
L
@

<
| E
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Chapter K81 Demo PROFINET I/O PLC Code for MicroHAWK

Now click the Run button on the top ribbon. This will download the job to
the camera. At this point the job is ready to run and can be tested.
However, in order to run the job change demo this job needs to be loaded
into Slot 1. Click back to the Edit view from the top ribbon bar.

Click the slot icon and select Slot 1 or New Slot if no slots are currently in use.

EjnutoV]SIl}N"‘": VisionHawk32C178 = C:\Microscan\Vscape\Tutorials And Samples\Visiq

Oty

Now the job and images will be saved to the flash memory of the camera.

I VisionHaw
0 Edit mode

10-6 AutoVISION and Visionscape Industrial Protocol User Manual



Overview

=
o

TIA Portal V13 Setup

This section was created using Siemens TIA Portal software version 13
and an ET200SP CPU catalog number 6ES7 510-1DJ01-0AB0O, HW
version 2, FW version 1.8.2.

|
O
Y—
Q
©
]
@)
@)
-l
o

First launch the TIA Portal from the desktop.

TIA
H13

Q
|_
L
<
u_
©)
X
o
o
S
Q
o

TIA Portal

V13

Create a new project from the menu item Project->New. The default
name is Projectl as seen below. Fill out the required information, then

click Create.
7 ens
Project  Edit View Insert Online Options Tools Window
Gf N soveproject & ¥ 5[5 X D2
Devices
EQQ

» [ Online access
} [ Card Reader/USE memory

Create a new project

Project name: | Froject]

J
Path: | CUserslsystestiDocumentslAutomation []
J

Author: |systest

Comment: ~

~

AutoVISION and Visionscape Industrial Protocol User Manual 10-7



Chapter K81 Demo PROFINET I/O PLC Code for MicroHAWK

The screen below shows the main screen you will see when a project is
opened.

e e e T Ty

3TN = s N vk e A DGREG S Focontes Jp P x| ]

L]
C
)

A Properties
Gaveral

| Dutails view

Mo ‘propertion’ avallabls.
Pt ot £ e Kb gk the mormerd Toaem o #ihae e bt deledted & ot seledied biectdeet nit have any daplayable siepertes

Double-click Add new device.

Pilinis. 4] Disgrmntcs. |

Totally Integiated Automal

Optians.

| Find and replate

Project Edit  View Insert Online Options Tools

2f hHl saveprojecr & ¥ 25 Ty X W (M2

Devices

Ci@ Q@

¥ ] systestdemo
ﬁ Add new device
iy Devices & networks
v [g§ Commaon data
» Eﬂ] Documentation settings

4 p_@ Languages & resources
¥ [z Online access
¢ [5g Card ReaderiUSE memary

Lo
PORTAL

L]

]
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Open the SIMATIC ET200 CPU arrow, then open the ET200SP CPU
arrow, then open the CPU 1510SP-1 PN, then click on 6ES7 510-1DJ01-
0ABO. You will see the screen below. Click OK.

‘Add new device . R

Device name:

|
O
Y—
Q
©
]
@)
@)
-l
o

[FLC_ 1 |

Q
l_
L
<
u_
©)
X
o
o
S
Q
o

vﬁ_[. Controllers Device:
» [ SIMATIC 57-1200
» [ SIMATIC 57-1500
» (i simaTIC 57300
» (I simaTIC 57400
~ [ SIMATIC ET 200 CPU
~ [ ET2005F CPU

- [ cPU 15105P-1 PN _
Il 6557 510-10100-0480 Article no.:  |6ES7 510-1DJ01-0ABD |

Ll [l Wersion: [vis [+]

4 Tﬂ CPFU 15125P-1 PN

Controllers

CPU 15105P-1 PN

L

— » [ CPU15105P F-1 PN Description:
» [ CFU 15125F F-1 PN CPU with work memory 100 KB code and 750 KB
v [ Unspecified ET2005F CPU data; 72 ns bitinstruction time; 4-stage
protection concept, integrated technology

» [ ET2005 CFU functions: motion, closeddoop contral,

» n_m ETZ00pro CFU counting&measuring; integrated tracing;
FROFINET IO controller, supports RTIRT, 3 ports,
MRP, transport protocal TCRIR, 57
communication, Web server, routing; firmware
V18

FCsystems

» [} Device Proxy

Drives

[+ Open device view oK | | Cancel
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Tetally integrated Autormstion
b et I b L i LE®R x PORTAL
Devices & Topology view g ewmwork view  |OF Device view || Options 1=
0 2dr [n E [%ld & g
ul Rk Eot dsddeems G sds Type It
] 1 OISR & by Wt Y
(] 1; RO T 2
o " j
] 2
] 1 -
. [
SEE a2 5
(" H
0 7 ¥
] . ¥
] v |
L) L v
] " -
] 7 T
® 1 g
] " -1
o =
o -o ¥
” = :
0 " .
o "
» o 0 .
L]
G Properties [
[ p
v Details view 2 eyce
s cycle e 150 m
' e i e e sl O
o Lbsiomiom oy e | 1 s

Click the lower green box on the PLC picture. The following will be
displayed in the lower pane.

|§ Properties H:i.‘.lnfo y"ﬂ Diagnostics

J General || 10 tags ” System constants || Texts ‘

¥ PROFINETinterface [X1]
General
Ethernet addresses Interface networked with
Time synchronization

o]

Ethemet addresses

Operating mode Subnet: | Not networked [+]

Add new subnet

» Advanced options
Web server access
Hardware identifier

IP protocol

(®) SetIP address in the project

IPaddress: | 192 . 168 . 0 -1

Subnetmask: | 255 . 255 _ 255 . 0
PLC 1

Click Add new subnet. The Subnet field will show PN/IE_1. Now go to
the IP address field, and type the IP address you wish to use for this
device. Click Save Project often to save your work.
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To the right of the screen, you will see the following: wo
Z o
o
Options x O
= o
ea
w | Catalo [}
| Catalog g
<Searchs i) |l
[ Filter

» [ijj ET2005P CPU

:] Interface modules
ZJ BusAdapter

(g D1

I e

(Al

(W AQ

ZJ Communications modules
:] Station extension
[ Technology modules
ZJ Server modules

(i ET200AL

b . . A . . . . . .

The modules in our test device are as follows:
1. DI 16x24VDC ST order number 6ES7 131-6BH00-0BAO
2. DQ 16x24VDC ST order number 6ES7 132-6BH00-0BAO

To add these modules, first click the arrow next to DI, keep clicking on
arrows until you find the order number for device 1. Click and hold down
the left mouse key. Drag it to slot 2 just to the left.
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Your display sho

uld look like this:

"
e

Y Madule
n v RC1

Tlor  [iaddress |G address | Typr Py
1 €U 15105P_. || Searchs |

1 %1 FROFINETin & Fiter

g » [ ET 20058 CPU

3 0.1 DIISRED] ® | » [ iovertace modules

+ (g Busidaprer
- mm
» [ DI ex24vnC 5T
» [ DI Ba24VDC SRCBA
» [ D1 4x120 2300AC 5T
= |l D1 16:24VDC 5T
[ 5E<7 131 sRHOGCAAD
» [l DI Ba24VDE HF
» [ D1 ExHAMUR HF
+mog
v ma
LA L]
» [ communications modules
+ [l Stanon exterion
» [l sechnalogy madules

scescoencoscoecoal@esn g

Do the same thing for device 2, looking under the DQ arrow. Your display

should now look like this:

=& - Fask  (Siot  |laudress | O address Type I=—"H
P [ o 1 CPUAS105P. | || Searchs
R 05\ -.h‘)f [ 1% FROFINETin...| | o yiner
. o i a 1z | » merzoosrou
o 1 0_1 DIVS2VD... | B, rog ineerinee madules
: 2 a.1 O 16024V | ;’uusa\dup'.u
=5 e rlmo
o 5 ~ §oo
. [ 3 ¢ [ DO 424VDCIAST
I : : » (g 00 2124 330MACT2A ST
: + [ DO 8:24VDODSA ST
f o Ll » (g D0 Su240DICH S SHK BA
| a 10 » [l P2 da24vuciza €O 51
L} n - [ DO 1624VDOI SA ST
o 12 BE57 13268HO0-00A0
o 13 » [ D 8424VDCI0 SA HF
[} 12 » [ 00 SzavDoiza v
] 15 + [l RO 421 20VDCI230VACISA NO
a 18 (3
o 17 ol

Now click on the PLC picture on slot 2. You will see the following screen:

w General
Project information
Catalog information

Potential group
- Module parameters
General
» Channel template
- DIl
General
b Inputs
10 addresses
Hardware identifier

Identification & Maintenance

B EmErS |

J General || 10 tags || System constants ” Texts |

Potential group

O Use potential group of the left module (dark BaseUnit)

@ Enable new potential group (light BaseUnit)

10-12

AutoVISION and Visionscape Industrial Protocol User Manual



Overview 1 O
@)
=
. . SN - =
Be sure the Enable new potential group (light Base Unit) is selected. wo
Do the same for Slot 3. Save the project. Z o
5%
Now click on Options->Manage general station description files (GSD). 8 O
oo
Source path: CiMicroscanlvs capelFirmwarelgsdiMicroHAWKIMa chine Vision| E o
Content of imported path 8
[ File Wersion Language Status Info
[[] GsDMLv2 32-MicroscanicroHa.. V232 English Alreadyinstalled Smart Cam...
3 in H
Cancel

Browse to the following path:
C:\Microscan\Vscape\Firmware\gsd\microhawk\Machine Vision.
Select the appropriate GSD file by clicking the box next to the name, and
click Install.

Click the tab that says Network View:

A it i e e
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Look at the right panel and click Hardware Catalog. Use the arrows to
open up the following area. Other field devices->PROFINET 10 -
>General->MICROSCAN->Smart Camera->MicroHAWK MV-40. Left-
click on MicroHAWK MV-40 and hold it. Drag it to the left into the Devices
and networks panel. Your screen will look like this:

systestdemo » Devices & networks

|E Topology view ”ﬁEh Network view  |[If Device view

=] J Network overview ” Connections | 4|
~
[ tl' Device Type
E ~ ET2005P station_1 ET 2005P station
(L MicroHAWK [ » PLC1 CPU 15105P1 PN
CPU 15105P-1 PN MicreHAWK m ~ GSD device_1 GSD device
Not assigned b MicroHAVK WicroHAWK

On the MicroHAWK picture, click the Not assigned link, then click on
PLC_1.PROFINET IO-System. This has just connected the MicroHAWK
to the PROFINET network.

1 10 system: PLC_1.PROFINET 10-System (100}

PLC 1 MicroHAWK [
CFU 15105P-1 PN MicroHAWK
PLC_1

{PLC_1.PROFINET 10-Syste... e
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Double-click the picture of the MicroHAWK. In the bottom pane you will wo

see the following: Z o

LL O

J General || 10 tags || System constants || Texts | @) 8
@

g General oo

w PROFIMETinterface [X1] o

General e o
Ethernet addresses Mame: | MicroHAWK 8

» Advanced options
F Author: |systest

Hardware identifier
Identification & Maintenance Comment:

Hardware identifier Y

Enter the name of the device in the Name: field. Then click Ethernet
addresses on the left, and type in the IP address of the camera. This will
allow the PLC to set the camera IP.
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Importing an Example Program

From TIA Portal, open the example program from the menu Project >
Open. Click the Browse button to locate the (AVDemo) program. The
AVDemo is located in \Microscan\Vscape\Tutorials and
Samples\MicroHAWK\PROFINET Demo. In the left pane in the Devices
tab, open the PLC_1[CPU 1510SP-1 PN] arrow. Open the Program
blocks arrow. Select all the blocks as shown below.

J Devices |

QO EE;

& OB1 [OB1] s
48 DBL_TO_WRD_HI [FC1]

& INIT_DEMO_DATA [FC4]
4 INIT_PROG_DATA [FC3]

48 PNIO_INPUT_DATA [FC5]
4 PNIC_OUTPUT_DATA [FC6]
48 UPDATE_MISC_DATA [FC7]
48 WORD_TO_BOOL [FC2]

& AUTOVISION_TEST [FB1]
48 GET_ACTV_SLOT[FB4]

4 JOB_CHANGE_DEMO [FE3]
4 PROCESS_BIT_DATA [FE2]
DE1 [DB1]

DE2 [DB2]

DB4 [DB4]

DBE10 [DB10]

PMIO [DBS]

PROG [DE3]

USER [DEB]

b |l System blocks

10-16
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Right click and copy. Go to your new project and open the same arrows,
right click on Program blocks, then click paste. Select Main[OB1] right
click, and hit delete. Be sure to save your work.

Now back in the left pane of the AvDemo project, click on PLC data types,
right-click, copy, and paste them into the new project PLC data types.

|
O
Y—
Q
©
]
@)
@)
-l
o

In the left pane of the AVDemo project, click on Watch and force tables.
Right click on Watch table_1, then copy. Paste into new project Watch
and force tables. Be sure to save the project.

Q
l_
L
<
u_
©)
X
o
o
S
Q
o

Your data in the new project should look like this:

= r_i PLC data types
EF Add new data type
IE| Dema

Input

Qutput

I#| Program

= [52 Watch and force tables
ﬂ“ Add new watch table
F=| Force able
== Watch table_1

In the left pane on the AVDemo project open the PLC tags arrow. Double-
click on Default tag table. You should see the following:

Default tag table
Name Data type Address Retain | Visibl.. |Acces..  Comment

4l  Tag__635939309667999050  Timer ][ %T10 =] 3]
2 40 Tag_635939309669449133  Timer %T11 = =)
= 40 Tag_635939309669679146  Timer %T12 = =)
4 g0 Tag_635939309659899159  Timer %T1 = =)
s 40 Tag_635939309670609199  Timer %3 = =)
& 40 Tag_635939309670909216  Timer %T4 =) =}
7 40 Tag_635939309671339241  Timer %TS =) =}
5 < Tsg_ 635939309671749264  Timer %TH =] ]
5 < Tsg_ 635939309689560283  Timer %720 =] ]
10 <@  Tag_ 635939309689790296  Timer %121 ¥ ]
11 < Tag_635939309690120315  Timer %22 ¥ ]
12 <@  Tag_635939309690890359  Timer %7123 ¥ ]
15 0 Tag_635939309691150374  Timer %7129 ¥ ]
- M

Type Ctrl-A to select all, and right-click copy. Open the new project PLC
tags in the same way, and paste these in.

AutoVISION and Visionscape Industrial Protocol User Manual
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Checking the Mapping of 10

Depending on the order the PLC can load things, we may need to change
the 10 addresses in our block to match the Device Overview in the Device
view screen.

Double-click on the MicroHAWK picture, and the Device overview will be
displayed to the right.

The image below is intended as an example only and may not exactly
resemble your Device Overview.

J Device overview
‘H - | Module Rack Slot | address |Q address Type
*  MicroHAWK 0 0 MicroHAWK
P Interface 0 0 X1 MicroHAWK
Status_1 0 1 2.3 Status
Cantrol_1 0 2 2.3 Cantrol
Echo In_1 0 3 256..257 EchaIn
Echo Out_1 0 4 256..257 Echo Out
Cmd Code Rslt_1 0 5 258..261 Cmd Code Rslt
Cmd Code_1 0 & 258..261 Cmd Code
Cmd Ret_1 0 7 262265 Cmd Ret
Crnd Arg_1 0 a 262..265 Cmd Arg
State_1 0 9 266 State
VIO Out_1 0 10 4.5 VIO Out
VIO In_1 0 11 4.5 VIO In
Boolean Qut_1 0 12 6.13 Boolean Out
Boolean In_1 0 13 6..13 Boolean In
Int Out_1 0 14 266285 IntOut
Intin_1 0 15 267 286 Intin
Long Out_1 0 16 286349 Long Out
Long In_1 0 17 287..350 Long In
Float Qut_1 0 18 350445 Float Out
Float In_1 0 19 351_.446 Float In
Long String Qut_1 0 20 445..541 Long String Out
Long String In_1 0 21 447..542 Long String In
Short String Out_1 0 22 542.733 Short String Out
Short String In_1 0 23 543.734 Short String In
0 24
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. o e
We need to modify the PLC program blocks to agree with this display. On wo
the left under the Devices pane, open the Program blocks arrow, and Z o
double-click on OB1 [OB1]. This will open a screen in the middle pane. LL 8
Scroll this middle pane down until you see Network 4. 8 &)
oo
Original Mapping o i
- Network 4: Update PROFINET Input data block from device g
match address assigned from Step 7 on hardware dialog a
UFCS
PMIO_INPUT_DATA"
=== FN EMNO
0 — STATUS
256 — ECHO
253 — CMDCODERSLT
262 — CMDRET
266 — STATE
2 — WIOIN
4 — BOOLS
267 — INTS
287 — LONGS
351 — FLOATS
447 — | STRING
543 — S5TRING
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Change the numbers here to match with the Device overview display, as
shown in the example below.

¥ Network 4: Update PROFINET Input data block from device

match address assigned from Step 7 on hardware dialog

%FCS
"PNIO_INPUT_DATA"

EM ENOD
STATUS
ECHO
CMDCODERSLT
CMDRET
STATE
VIOIN
=3 BOOLS
INTS
LOMGS
FLOATS
447 — LSTRING
SSTRING

kd d
[ R )
=R = VR N

[
]

)
53]
0 B

=)
3]

(SR ]
o

(%)}
i
[%1]
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: - =
Repeat this for Network 5. wo

Z
.. . =0
Original Mapping |_O|_ 8
r Network 5: Update PROFINET device with Output Block Data x O

o
match address assigned from Step 7 on hardware dialog o 3
ca

UFC6 A

"PNIO_OUTPUT DATA"
EN ENO
0 CONTROL
256 — ECHO

258 CMDCODE
262 = CMDARG

2 —vio

4 — BOOLS
266 — |NTS
286 — LONGS
350 — FLOATS
446 — | STRING

542 SSTRING
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Updated Mapping

*  Network 5: Update PROFINET device with Cutput Block Data

ratch address assigned from Step 7 on hardware dialog

WFCE
"PNIO_OUTPUT_DATA"
EN ENO
2 — CONTROL
256 — ECHO

258 — CMDCODE
282 CMDARG

4 WD

5 == BOOLS
266 IMTS
286 LOMGS
350 FLOATS
446 LSTRIMG

542 S5TRING

Be sure to save the project. Click the PLC_1 {CPU 1510SP-1 PN] top
level, then click the compile icon.

%

There should be NO compile errors. If there are no errors, click the
download icon.
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You will see the following screen: wo
Extended download to device X Z ()]
L O
Configured access nodes of "PLC_1" O o
Device Device type Slot Type Address Subnet x O
PLC_1 CPU 15105P-1 PN 1 X1 FMIIE 192.168.189.1 FNIIE_1 o O
o
F— 1 = o
Q
o
Type ofthe PGIPC interface: |9 FNIIE hd
PGIPC interface: 7] Intel (R} FRO/M 000 MT Metwork Connection <3= | ¥ @ B
Compatible devices in target subnet: [ Show all compatible devices
Device Device type Type Address Target device
= = PMIIE Access address =

Startsearch

Online status information:

[] Display enly error messages

Cancel
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Select your PC network interface, and change the Connection to
interface/subnet to PN/IE_1. Click Start Search. PLC_1 should be displayed
with the address you gave it. Click Load. If you see a screen similar to below,
do a memory reset(MRES) on the PLC, and try to load again.

Software synchronization before loading 10 3 device %

I The CPU contains changes that cannot be automatically synchronized
]

1 Software synchronization Status  Action

1~ PLCT

H ¥ 'Program blocks’

1 UFDATE_MISC_DATA [FC7] [} Manual synchroniztion required

1 AUTOVISION_TEST[FB1] (1) Manual synchronizmtion required

1 GET_ACTV_SLOT[FB4] [ 1] Manual synchronizmtion required

1 JOB_CHANGE_DEMO [FE3] [} Manual synchreniztion required

H ¥ 'System blocks’

1 * 'Program resources’

1 DB20 [DB20] [ 1] Manual synchreniztion required

1 DB21 [DB21] [ 1] Manual synchrenizmtion required

1 DB22 [DB22] [} Manual synchronizmtion required

H DB30 [DB30] [} Manual synchronizmtion required

1 DB31 [DB31] [} Manual synchronizmtion required

H ¥ 'PLCtags’ u
<] n |

Offlinelonline comparison | Synchronize | [ Continue without synchronizmtion ] | Cancel |

When downloading is working correctly you will see the following:
[TOSTTESHITs ]

9 Status and actions after downloading to device

Status |1 Target Message Action
*& & - P Downloading to device completed without error.
Finish loading
1 ]
Start PLC_1 (current mode: Startup)
[<] [T [2]

Finish 1

c
"
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All LEDS on the PLC should be GREEN.
the following:

Click Go online

Overview

. You should see

Froer tdn Vew e "
98 e @ M

Griiee  Cptiens
s L

Toch  Windem  Help

ADGED o dootiee oy N[N X

HOGHAEH OB 0

Fy
EFT

B 50 syitem: PLE1 PROFINET |0-System (100)

v
ra—
o ©

o P Y PROFINET VO 8, v A

L
e
=

~oo0o00O0OOOOOODORDODE @

~ | Details view

apology view | Network view  |[Df Device vinw

Options

| CPU operator panel

Genaeal | Cic

GO T

Ueziage

L hroparties | ainto ] 40
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Chapter K81 Demo PROFINET I/O PLC Code for MicroHAWK

Troubleshooting

If things are not green, go offline and click the Accessible devices icon.

Click Start search. The PLC and the MicroHAWK should be displayed here.

Accessible devices X

! Type of the PGIPC interface: |—LPNI'|E |'|

PGIFCinterface:  [Rl Intel(R) PROI1000 MT Netwark Connection <3= | v | €

Accessible nodes ofthe selected interface:

Device Device type Type Address MAC address
win-sn7tkOuevhg SIMATIC-PC PNIIE 19216820175  00-05-1B-B0-2F-58
ple_1 CPU 1510SP-1 PN PNIE 192.168.189.1 28-63-36-48-AD-40
[.I:l ricrohawk186c49 Smart Camera PNIIE 192.168.189.4  00-0B-43-18-6C-49
[ | Flash LED

Online status infermation:
2 Retrieving device information...

Scan and information retrieval completed.

[« [N

[ Display enly error messages

r Show 1 | Cancel |

If the name of the MicroHAWK is not correct, you will not connect. The
default name is microhawk with the last 3 of the MAC address. Ex:
microhawk186¢49. Go back to the general settings of the MicroHAWK in
the device view, and change the name if required. Re-compile, and re-load.
Try running again. This is the most common reason for not connecting.
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Running the Demo

In the left pane click the Watch and force tables arrow. Double-click Watch
table_1. The watch table will open in the center pane. Click on the monitor
variables icon.

|
O
Y—
Q
©
]
@)
@)
-l
o

Q
l_
L
<
u_
©)
X
o
o
S
Q
o

"USER" .Demo.DemoTrigType £/ | *DE6.DEWD lDEC - 0 @ H
2 "USER".Demo.Demoliode %DB6.DEWZ DEC o] @ H
3 "USER".Demo.ClearCounters %DB6.DBX4.0 Bool FALSE @ H
4 "USER" Demo.CountExecutions %DB6 DEWE DEC
5 "USER" Demo.CountPass %DB6.DEWS DEC
6 “USER".Demo.CountFail %DE6 DEWI0 DEC
7 "USER".Demo.MinDistance %DB6.DED46 Floating-point nu... 100.0 D
B "USER" Demo.MaxDistance *%DE6.DEDS0 Floating-point nu...
&l "USER".Demo.MinBlobCount %DB6.DBWS4 DEC
10 "USER".Demo.MaxBlobCount %DE6.DEWSE DEC
11 "USER".Demo.ReadDistance %DB6.DED5E Floating-point nu...
12 "USER".Demo.ReadBlobCount %DEB.DEWG2 DEC
13 “USER" .Demo.MeasureStatus %DB6.DBX100.1 Boal
14 "USER" .Demo.DecodeStatus %DB6.DEX100.2 Bool
15 "USER" .Demo.CountBlobStatus %DB6.DEX100.3 Boal
16 "PROG" ProgramJobPass %DB3.DBX24.2 DEC
17 "PROG" Frogram_ Activelob *%DB3 DEV26 DEC
18 “PROG".ProgramJobStatus %DB3.DBW28 DEC
19 "PROG" Program.CurrentState %DE3 DEWD DEC
20
21 “PMIO* Input.CmdCodeRslt %DE5.DED4 Hex
22 “PMIO* Input.CrmdRet %DB5.DBEDE Hex
23 “PMNIO* Output.CmdCode %DE5.DED464 Hex
24 “PMIO" Output.CMDArg %DB5.DBD468 Hex
25 “PMIO* Output.Control %DEB5 .DEW4E0 Bin
26 "PROG".Program.Status_ONLINE %DB3 .DEX20.0 Bool
27 "PROG".Program.Status_EXP_BUSY %DB3.DEX20.1 Boaol
28 "PROG" Program Status_ACQ_BUSY %DB3 DEX20.2 Bool
29 "PROG"_Program.Status_TRIGGER_READY %DB3 DBX20.3 Bool

There are two demo modes in this example. The modes are set in:
“USER”.Demo.DemoMode (DB101.DBW 2)

0 = AutoVISION Test

1 = Job Change Test

The AutoVISION Test will demonstrate communications between the PLC
and the current job loaded from AutoVISION.
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If 0 doesn't appear under the Status Value column, right-click in the
"USER".Demo.DemoMode row under the Modify Value column. Select
Modify or type CTRL+F9 to change the value.

Agdress

[ Symeot

[ Omplay format | Stabes vaiue
°

D811 D8W 0  “USER Demo DemoTrigType
DRI DEW 2  USER Demo Demolode
DB101DEX 40 “USER" Demo ClearCounters
DRI DEW &  USER Demo Countfxecutions
DB101DEW &  “USER" Demo CountPass
DB DEW 10  “USER" Demo Countfal
DEIS1DBD 48  “USER" Demo MinDstance
DB D80 20  USER Demo MaxDwtance
DB161 D&W &4  USER" Demo MinBiobCount
D810 DEW %  USER" Demo MaxBiobCount
DE1O1DBD 48  USER" Demo ReadDstance

DEC

DEC 1
BOOL 1] rame
DEC &
DEC n
DEC r-

FLOATNG_PONT 1000
FLOATNG_PONT 2000
DEC ]
DEC 4
FLOATNG _PONT 00

If 0 is not entered in the Status Value column of the
USER.Demo.DemoTrigType row, enter 0.To start triggering the program,
right-click inside the Status Value column of the
USER.Demo.DemoTrigType (DB101.DBW 0) row. Change the value
from 0 to 1 to begin triggering and running the job on the camera.

Address [ Symbol

[ Display format [ Status value

DB101.DBW 0
DB101.DBW 2

DB101.DBW &
DB101.DBW 8
DB101.DBW 10
DB101.DBD 46
DB101.DBD S0
DB101.DBW 5S4
DB101.DBW S6
DB101.DBD S8
DB101.DBW 62
DB101.DBX 100.1

DB102.DBX 24.2

"USER".Demo.DemoTrigType
| "USER" Demo. DemoMode
DB101DBX 4.0
- "USER".Demo.CountExecutions
"USER".Demo.CountPass
- “USER" Demo. CountFail
- "USER".Demo. MinDistance
- "USER".Demo. MaxDistance

“USER".Demo.MinBiobCount

“USER".Demo.MaxBlobCount

“USER".Demo.ReadDistance

"USER".Demo.ReadBlobCount

“USER".Demo.MeasureStatus
DB101.DBX 100.2:™
DB101.DBX 100.3:™
"PROG".Program.JobPass

USER".Demo.ClearCounters

USER".Demo.DecodeStatus
USER".Demo.CountBlobStatus

Hodify value ;‘
q 1
Monitor

Update Monitor Values

|DEC 0
|DEC )
{BOOL W raise
|DEC $H0
|DEC )
|DEC o

{FLOATING_POINT:  100.0
{FLOATING_POINT:  200.0
{DEC e
|DEC L
{FLOATING_POINT |
|DEC :
‘BOOL
‘BOOL
/BOOL
‘BOOL

Activate Modify Value

Modify Address to 1
Modify Address to 0

Cut
Copy
Paste

Delete

Insert Range of Variables...
Modify/Force Value As Comment
Row Not Effective
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When the program is triggering the camera, each cycle will produce either
a pass or fail all state. Each state is counted in

"USER".Demo.CountPass:

DB101.DBD S8
DB101.DBW 62
DB101.0BX 100.1
DB101.DBX 100.2
DB101.DBX 100.3
DB102.DBX 24.2

"USER".Demo.ReadDistance
"USER".Demo.ReadBlobCount
"USER".Demo.MeasureStatus
"USER".Demo.DecodeStatus
"USER".Demo.CountBlobStatus
“PROG".Program.JobPass

and “USER”.Demo.CountFail:

DB101.DBD 58
DB101.DBW 62
DB101.DBX 100.1
DB101.DBX 100.2:°
DB101.DBX 100.3:°
DB102.DBX 24.2

"USER".Demo.ReadDistance
"USER".Demo.ReadBlobCount
"USER".Demo.MeasureStatus

'USER".Demo.DecodeStatus
'USER".Demo.CountBlobStatus

"PROG".Program.JobPass

' FLOATING_POINT - 173.0306

' DEC 4

. BOOL I ltrue

' BOOL Tl true

. BOOL 1 true

. BOOL 1) true
FLOATING_POINT | 58.407
DEC 6
BOOL [ ralse
BOOL [ false
BOOL [ false
BOOL [ faise

These counters can be cleared by right-clicking the row
“USER”.Demo.ClearCounters and selecting Modify Address to 1.

DB101.DBX 4.0
DB101.DBW 6
DB101.DBW 8
DB101.DBW 10

"USER".Demo.ClearCounters
"USER".Demo.CountExecutions
"USER".Demo.CountPass
"USER".Demo.CountFail

BOOL [ raise
DEC 104
DEC 52
DEC 49

The tolerances are below the counters. The inspection values and status

bits are below the tolerances.

DB101.DBD
DB101.DBD
DB101.DBW
DB101.DBW 56

8 8

on
o

"USER".Demo.MinDistance
"USER".Demo.MaxDistance
"USER".Demo.MinBlobCount
"USER".Demo.MaxBlobCount

FLOATING_POINT 100.0
FLOATING_POINT 200.0
DEC <
DEC <
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Chapter K81 Demo PROFINET I/O PLC Code for MicroHAWK

In some instances a large job could take longer to load. Increment the
delay time to adjust for job size. The image below shows Function Block

3, Network 6, where the delay is located.
3=WAIT JOB CHANGE

This delayis for the new job to load, 3-7 minutes based on siz ofjob in flash

%22
"Tag__
63593930969012
0315°
3
I 5_0DT MOVE
|I_n; | 3 Q EM END ———
#teststate S5TR125 ™ Bl N4 IN
“WDB3.DBWO
.—R BCD — - "PROG" Program.
3 OUT CurrentState

To run the Job Change Test you first need to use AutoVISION to
download another job to slot 2 on the camera. In AutoVISION, connect to
the camera and select the Connect icon at the top of the user interface.
Click the Load a Job icon. Locate PNIO_demo_job2.avp and click the
Open button. Once the job has loaded into AutoVISION, click the Edit
button at the top of the user interface. Then click Save the Job to a Slot
on the camera icon in the menu at the top of the user interface. Select
New Slot, which should be 2. When switching between tests, disable the
current routine by setting the "USER".Demo.DemoTrigType to 0. Now
there should be two jobs loaded in the camera’s flash memory.

In the left pane of TIA Portal, click on the Watch and force tables arrow.
Double-click on Watch table_1. The watch table will open in the center
pane. Click on the monitor variables icon.

AutoVISION must be closed for this demo to work.

On the row "USER".Demo.DemoMode, right-click and modify to one.
Right-click the row "USER".Demo.DemoTrigType and Modify Address
to 1 to start the demo.

This demo will cycle through loading jobs from slots 1 and 2. Each cycle
will be counted in the variable table "USER".Demo.CountExecutions.
The job load success is determined by the camera’s status register
"PNIO.Input.CmdCodeRsiIt" = 0x0. If the job load is successful the
counter "USER".Demo.CountPass will increment. If the job load fails

10-30 AutoVISION and Visionscape Industrial Protocol User Manual



=
o

Troubleshooting

when "PNIO".Input.CmdCodeRslt ! = 0x0, then the counter
"USER".Demo.CountFail will increment. OB1 calls FB1 to process the
AutoVISION test. To view the ladder logic, double-click
AUTOVISION_TEST[ FB1]. This will open the block in the center pane.

|
O
Y—
Q
©
]
@)
@)
-l
o

OB1 Network 2, showing 0 to run AUTOVISION_TEST.

o Network 2: Process AutoVISION Demo based on USER.Demo.Demolode =0

Q
l_
L
<
u_
©)
X
o
o
S
Q
o

%UDB1
"DB1"
%FB1
o "AUTOVISION_TEST

Ilm I EM ENO

“DB6.DBW2
"USER".Demo.
DemohMode
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